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Introduction

Safety precautions
The following precautions ensure the correct use of the printer and prevent printer damage. Use these
precautions at all times.
●

Use the power supply voltage that is specified on the nameplate. To avoid overloading the
printer's electrical outlet, do not use the outlet for multiple devices.

●

Make sure that the printer is well-grounded. Failure to ground the printer can result in electrical
shock, fire, and susceptibility to electromagnetic interference.

●

Do not disassemble or repair the printer yourself, unless authorized by HP (see Customer Self
Repair on page 179). Contact your local HP Service Representative for service. See HP Customer
Care on page 180.

●

Use only the electrical cord that HP supplied with the printer. Do not damage, cut, or repair the
power cord. A damaged power cord creates a risk of fire and electric shock. Replace a damaged
power cord with an HP-approved power cord.

●

Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of
the printer. Doing so can cause fire, electric shock, or other serious hazards.

●

Turn off the printer and unplug the power cable from the power outlet in any of the following
cases:
◦

When you place your hands inside the printer

◦

If smoke or an unusual smell emanates from the printer

◦

If the printer is making an unusual noise that does not occur during normal operation

◦

If a piece of metal or a liquid (not part of cleaning and maintenance routines) touches
internal parts of the printer

◦

During an electrical (thunder or lightning) storm

◦

During a power failure

Product models
This guide covers the following product models, normally referring to them by their short names for
brevity.
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Full name

Short name

Part numbers

HP Designjet T7100

T7100

CQ105A, CQ106A

HP Designjet T7100 with PostScript upgrade

T7100ps

CQ105A, CQ106A + CQ745A

HP Designjet T7100 Monochrome

T7100 Mono

CQ101A, CQ102A

HP Designjet T7100 Monochrome with PostScript
upgrade

T7100ps Mono

CQ101A, CQ102A + CQ745A

Chapter 1 Introduction
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Using this guide
The HP Start-up Kit DVD includes this guide, which is the most complete source of information about this
product, and is organized into the following chapters.

Introduction
This chapter provides a brief introduction to the printer and its documentation for new users.

Use and maintenance
These chapters help you carry out normal printer procedures and include the following topics:
●

Connectivity and software instructions on page 12

●

Personalize the printer on page 20

●

Handle the paper on page 26

●

Handle the ink system on page 44

●

Print options on page 77

●

Color management on page 93

●

Practical printing examples on page 113

●

Maintain the printer on page 139

Troubleshooting
These chapters help you solve problems that might occur while printing and include the following
topics:
●

Troubleshoot print-quality issues on page 147

●

Troubleshoot ink-system issues on page 164

●

Troubleshoot paper issues on page 162

●

Troubleshoot other issues on page 169

Support
This chapter describes the various sources of information and help you can consult.
●

Get help on page 177

Appendices
The appendices contain reference information on various aspects of your printer.
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●

Front-panel menus on page 185

●

Front-panel error messages on page 196

●

Printer specifications on page 200

Using this guide
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Glossary
This chapter contains definitions of printing and HP terms that are used in this documentation.

Index
In addition to the table of contents, an alphabetical index is included to help you to find topics quickly.

Warnings and Cautions
Symbols are used in this manual to ensure the proper use of the printer and to prevent printer damage.
Follow the instructions that are marked with these symbols.
WARNING! Failure to follow the guidelines that are marked with this symbol could result in serious
personal injury or death.
CAUTION: Failure to follow the guidelines that are marked with this symbol could result in minor
personal injury or damage to the product.

The printer’s main features
Your printer is a color inkjet printer designed for printing high-quality images on paper up to 1067 mm
(42 in) wide. Some major features of the printer are shown below:
●

Print resolution of up to 2400 × 1200 optimized dots per inch (dpi) from a 1200 × 1200 dpi
input, when using photo paper, the Best print-quality option, and the Maximum resolution
for the photo paper option

●

Two rolls (three rolls in some configurations) loaded at once provide automatic, fast and easy
switching between different rolls, or long runs of unattended printing

●

A six-ink system in the 7100 and a two-ink system in the 7100 Mono printer

●

Accurate and consistent color reproduction with automatic color calibration in the 7100 printer

●

Two black printheads enable the printer to print grayscale jobs fast with unusually good quality.

●

Paper flexibility and automatic easy load, including information and presets that are available at
the front panel or remotely

●

High productivity features such as job previewing, nesting and autorotate

●

EconoMode for printing economically

●

Ink and paper usage accounting for different types of print

●

Manage your printer remotely using the Embedded Web Server (see The Embedded Web Server’s
main components on page 9) or the HP Utility (see The HP Utility’s main features
on page 10)

The printer’s main components
The following views illustrate the main components of the HP Designjet T7100 printer.
WARNING! Do not try to disassemble, repair or manipulate the roll door or the rear door. Your
fingers or hand may become trapped.
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1.

Ink cartridge

2.

Platen

3.

Printhead

4.

Printhead carriage

5.

Front panel

6.

Maintenance cartridge

7.

Right hub

8.

Roll support

9.

HP Smart Roll-Loading System

Introduction

Front view

10. Paper feed brake
11. Bin/Basket
12. Roll door
13. Left hub

ENWW
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Rear view

1.

Rear door handle

2.

Power switch and socket

3.

Sockets for communication cables and optional accessories

The bin/basket
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●

To stack A0 or E paper sizes only, supported by wire loops. For this purpose, the top handles
should be up and the bottom handles should be down.

●

To stack A1 or D paper sizes only, supported by wire loops. For this purpose, the top handles
should be down; the bottom handles are irrelevant.

●

To hold mixed paper sizes in the basket at the bottom. For this purpose, the top and bottom
handles should be up.

Introduction

The bin/basket is provided to store finished prints. It can be used in several different ways.

Before stacking A0/E or A1/D paper sizes, ensure that the bin/basket is correctly positioned below the
paper output: push it up against the printer until it comes to a definite stop.
The bin/basket has wheels and can easily be moved around when detached from the printer.
The front pockets may be used to store core adaptors and printer documentation.

The front panel
Your printer's front panel is located on the front of the printer, on the right-hand side. It has the
following important functions:
●

It is used to perform certain operations, such as loading and unloading paper

●

It displays up-to-date information about the status of the printer, the ink cartridges, the printheads,
the maintenance cartridge, the paper, the print jobs, and other parts and processes

●

It gives guidance on using the printer

●

It displays warning and error messages, when appropriate, with audible alerts to call attention

●

It can be used to change the values of printer settings and the operation of the printer
NOTE: Settings in the Embedded Web Server or in the printer driver override front panel
settings.

The front panel has the following components, starting with the four direct-access keys:

ENWW

1.

Paper loading key starts the paper loading process: see Load a roll into the printer on page 30.

2.

View information key. By pressing this key repeatedly, you can see information about the loaded
papers, the ink levels, the printer's connection to the computer and the printhead status. See
Printing paper info on page 38.

3.

Pause printing key pauses printing after finishing the current page. Press the key again to restart
printing. This can be useful, for instance, when you want to change or load a roll of a different
paper type.
The printer’s main components
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4.

Form feed and cut key: see Feed and cut the paper on page 38.

5.

Front-panel display displays errors, warnings and information on using your printer.

6.

Back key: To go to the previous step in a procedure or interaction. To go to the upper level, or
leave the option in the menu, or when given an option.

7.

Menu key: Press to return to the main menu of the front-panel display. If you are already on the
main menu it will display the status screen.

8.

Down key: To go down in a menu or option, or to decrease a value, for example when
configuring the front-panel display contrast or the IP address.

9.

Power key: To turn the printer off or on, it also has a light to indicate the printer's status. If the
power key light is off the printer is off. If the power key light is blinking green, the printer is
starting up. If the power key light is green on, the printer is on. If the power key light is amber on,
the printer is in standby. If the power key light is blinking amber, the printer needs attention.

10. Cancel key: To abort a procedure or interaction.
11. Up key: To go up in a menu or option, or to increase a value, for example when configuring the
front-panel display contrast or the IP address.
12. OK key: To confirm an action while in a procedure or interaction. To enter in a submenu in the
menu. To select a value when given an option. If the status screen is displayed, this key takes you
to the main menu.
13. Status light: Indicates the printer's status. If the Status light is solid green, the printer is ready. If it is
flashing green, the printer is busy. If it is solid amber, there is a system error. If it is flashing
amber, the printer needs attention.
To highlight an item in the front-panel display, press the Up or Down key until the item is highlighted.
To select an item in the front-panel display, first highlight it and then press the OK key.
When this guide shows a series of front-panel display items like this: Item1 > Item2 > Item3, it
means that you should select Item1, then select Item2, then select Item3.
For detailed information on the front-panel menus, see Front-panel menus on page 185.
For an annotated list of front-panel error messages, see Front-panel error messages on page 196.
Information about specific uses of the front panel can be found throughout this guide.

Printer software
The following software is provided with your printer:
●

HP-GL/2 printer driver for Windows operating systems

●

PostScript printer driver for Windows, Linux and Mac OS operating systems (with the PostScript
upgrade)

●

HP Utility (see The HP Utility’s main features on page 10)

●

The Embedded Web Server, which runs in the printer and enables you to use a Web browser on
any computer to check the ink levels and the printer status (see The Embedded Web Server’s main
components on page 9)

TIP: See http://hplipopensource.com/hplip-web/index.html if you are using Linux.
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The Embedded Web Server’s main components
The Embedded Web Server is a Web server running inside the printer. Users can obtain printer
information, manage settings and presets, and troubleshoot problems through the Embedded Web
Server. It also allows service engineers to retrieve internal information that helps diagnose printer
problems.
Access the Embedded Web Server remotely by using an ordinary Web browser running on any
computer. Its features and functionality are organized within three tabs. Buttons near the top of each
tabs page provide access to online help and supplies reordering.

Main tab
The Main tab provides information about the following items:
●

Print jobs and managing the print queue

●

Supplies status

●

Paper and ink usage and accounting

●

PANTONE©* emulation

Setup tab
The Setup tab includes options to complete these tasks:
●

Define printer, network and security settings

●

Send accounting reports and notifications of warnings and errors through email

●

Update firmware

●

Upload paper presets

●

Set the date and time

Support tab
The Support tab contains options to complete these funtions:

ENWW

●

Use the Embedded Web Server Print Quality Troubleshooting wizard to help resolve some of the
most common print quality issues

●

Browse helpful information from a variety of sources

●

Access HP Designjet links for technical support with your printer, driver and accessories

●

Access service support pages that show current and historical data on the usage of your printer

●

Troubleshoot image-quality

The Embedded Web Server’s main components
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The HP Utility’s main features
The HP Utility provides an easy-to-use interface that allows the user to manage and access various
printer features and functionality.
●

Manage the printer, including single-point color control with the HP Color Center.

●

Gain access to the online HP Knowledge Center.

●

View the status of the ink cartridges, the printheads and the paper.

●

Manage, install, and create International Color Consortium (ICC) profiles (with the PostScript
upgrade only).

●

Access and use embedded profiles (with the PostScript upgrade only).

●

Update the printer's firmware. See Update the printer firmware on page 144.

●

Calibrate the printer and display.

●

Change various printer settings (on the Settings tab).

●

Configure network settings

The printer’s internal prints
The internal prints provide various kinds of information about your printer. You can request these prints
from the front panel without using a computer.
Before requesting any internal print, make sure that paper is loaded and that the Ready message
appears on the front-panel display.
To print an internal print, select the

icon, Internal prints, and then select the type of internal

print that you want.
The following internal prints are available:

10

●

Demo: shows some of the capabilities of the printer

●

Menu map: shows details of all the front-panel menus

●

Configuration: shows all the current front-panel settings

●

Usage report: shows estimates of the total number of prints, number of prints by paper type,
number of prints by print-quality option, and total amount of ink used per color. The accuracy of
these estimates is not guaranteed.

●

HP-GL/2 palette: shows the color or grayscale definitions in the currently-selected color palette

●

PostScript font list: lists the PostScript fonts that are installed in the printer (with the PostScript
upgrade only)

●

Service information: provides information that service engineers require

Chapter 1 Introduction
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TIP: The printer can be left powered on without wasting energy. Leaving it on improves response time
and overall system reliability. When the printer has not been used for a certain period of time (the
default time is determined by Energy Star), it saves power by going into sleep mode. However, any
interaction with the printer's front-panel display, or sending a new job to print, returns it to active mode,
and it can resume printing immediately. To change the sleep mode time, see Change the sleep mode
setting on page 22.
NOTE: In sleep mode, the printer performs maintenance service to the printheads from time-to-time.
This avoids long preparation times after long idle periods. Therefore, it is strongly recommended to
leave the printer powered on or in sleep mode to avoid wasting ink and time.
The printer has three levels of power consumption.
●

Plugged in: the power cord is plugged into the back of the printer

●

Switched on: the switch at the back of the printer is in the on position

●

Powered on: the Power key on the front panel shows a green light

If you wish to turn the printer on or off or reset the printer, the normal and recommended method is to
use the Power key on the front panel.

However, if you plan to store the printer indefinitely or the Power key does not seem to work, you are
recommended to power it off using the Power key, and then also switch off the power switch at the
rear.

To turn it back on, use the power switch at the rear.
When the printer is powered back on, it takes about three minutes to initialize and check and prepare
the printheads. Preparing the printheads takes about one minute and 15 seconds. However, if the
printer has been off for six weeks or more, preparing the printheads could take up to 45 minutes.

ENWW
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Connectivity and software
instructions

●

Choose which connection method to use

●

Connect to a network (Windows)

●

Connect directly to a computer (Windows)

●

Uninstall the printer driver (Windows)

●

Connect to a network (Mac OS)

●

Connect directly to a computer (Mac OS)

●

Uninstall the printer software (Mac OS)

Chapter 2 Connectivity and software instructions
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Choose which connection method to use
The following methods can be used to connect your printer.
Connection type

Speed

Cable length

Other factors

Gigabit Ethernet

Very fast; varies according to
network traffic

Long: 100 m (328 ft)

Requires extra equipment
(switches).

Jetdirect print server (optional
accessory)

Moderate; varies according
to network traffic

Long: 100 m (328 ft)

Requires extra equipment
(switches).

USB 2.0 (optional accessory)

Very fast

Connectivity

Useful for wireless or
AppleTalk connection, and
for Novell printing.
Short: 5 m (16 ft)

NOTE: The speed of any network connection depends on all components used in the network, which
may include network interface cards, hubs, routers, switches and cables. If any one of these
components is not capable of high-speed operation, you will find that you have a low-speed
connection. The speed of your network connection can also be affected by the total amount of traffic
from other devices on the network.
NOTE: There are various possible ways of connecting the printer to a network, but only one of them
can be active at a time; with the exception of the Jetdirect print server, which can be active at the same
time as one other network connection.

Connect to a network (Windows)
Once the network cable is connected and the printer is powered up, it automatically obtains an IP
address. You need to perform the following steps to configure the printer in the network:
1.

Go to your printer's front panel and select the Connectivity menu icon

, then Gigabit

Ethernet or Jetdirect EIO, then View configuration.
2.

Note the IP address of your printer.

3.

Insert the HP Start-Up Kit DVD into your computer. If the DVD does not autorun, run the
setup.exe program in the root folder of the DVD.

4.

Press the Software Installation button.

5.

Press the Express Network Install button.

6.

The configuration program will look for printers connected to your network. When the search has
finished, a list of printers will be displayed. Identify your printer by its IP address and select it from
the list.
If your printer does not appear in the list, select Help me find my network printer and click
Next. In the next screen, give the IP address of your printer.
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Connect directly to a computer (Windows)
You can connect your printer directly to a computer without going through a network, by using the
printer's USB 2.0 socket.

Connectivity

1.

Do not connect the computer to the printer yet. You must first install the printer driver
software on the computer, as follows.

2.

Insert the HP Start-Up Kit DVD into your DVD drive. If the DVD does not autorun, run the
setup.exe program in the root folder of the DVD.

3.

Press the Software Installation button.

4.

Press the Custom Install button.

5.

Follow the instructions on your screen to set up the printer. The following notes will help you to
understand the screens and make appropriate choices.
●

You may see a message warning that the installer will have to communicate through the
Windows Firewall to search for printers on the network. As you intend to set up a direct
connection, select Continue installation without searching the network and click
Next.

●

When asked how the printer is connected, choose USB cable.

●

When prompted to do so, connect your computer to the printer, using a USB cable. Ensure
that the printer is switched on.

Uninstall the printer driver (Windows)
1.

Insert the HP Start-Up Kit DVD into your DVD drive. If the DVD does not autorun, run the
setup.exe program in the root folder of the DVD.

2.

Press the Software Installation button.

3.

Press the Modify Installation button, and follow the instructions on your screen to uninstall the
printer driver.

Connect to a network (Mac OS)
You can connect your printer to a network under Mac OS by using the following methods:
●

Bonjour

●

TCP/IP

NOTE: The printer does not support AppleTalk.
Before you begin, check your equipment:
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●

The printer should be set up and on.

●

The Ethernet hub or router should be on and functioning correctly.

●

All computers on the network should be on and connected to the network.

●

The printer should be connected to the network.

Chapter 2 Connectivity and software instructions
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Now you can proceed to install the printer software and connect your printer.

Bonjour connection
1.

Go to your printer's front panel and select the Connectivity menu icon

, then Gigabit

Ethernet or Jetdirect EIO, then View configuration. Note the mDNS service name of your
printer.
Insert the HP Start-up Kit DVD into your DVD drive.

3.

Open the DVD icon on your desktop.

4.

Open the Mac OS X HP Designjet Installer icon.

5.

Follow the instructions on your screen. You are recommended to use the Easy Install option.

6.

The printer software is installed, including the printer driver and the HP Utility.

7.

When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up
a connection to your printer. Follow the instructions on your screen.

8.

When you reach the Select Printer screen, look for your printer's mDNS service name (which you
noted in step 1) in the Printer Name column.

Connectivity

2.

ENWW

Connect to a network (Mac OS)

15

Connectivity

●

If you find the right printer name, scroll sideways to see the Connection Type column, and
check that it shows Bonjour. Then highlight that line. Otherwise, continue searching further
down the list.

●

If you cannot find your printer name with a Bonjour connection type, check the box My
printer is not in the list.

Click Continue.
9.

Continue following the instructions on the screen. When you reach the Printer Queue Created
screen, click Quit to exit, or Create New Queue if you want to connect another printer to the
network.

10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.
If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the
DVD.

TCP/IP connection
1.

Go to your printer's front panel and select the Connectivity menu icon

, then Gigabit

Ethernet or Jetdirect EIO, then View configuration.
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2.

Note the URL of your printer.

3.

Insert the HP Start-up Kit DVD into your DVD drive.

4.

Open the DVD icon on your desktop.

Chapter 2 Connectivity and software instructions
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Open the Mac OS X HP Designjet Installer icon.

6.

Follow the instructions on your screen. You are recommended to use the Easy Install option.

7.

The printer software is installed, including the printer driver and the HP Utility.

8.

When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up
a connection to your printer. Follow the instructions on your screen.

9.

When you reach the Select Printer screen, look for your printer's URL (which you noted in step 1)
in the Printer Name column.
●

If you find the right printer name, scroll sideways to see the Connection Type column, and
check that it shows IP Printing. Then highlight that line. Otherwise, continue searching
further down the list.

●

If you cannot find your printer name with an IP Printing connection type, check the box My
printer is not in the list.

Click Continue.
10. Continue following the instructions on the screen. When you reach the Printer Queue Created
screen, click Quit to exit, or Create New Queue if you want to connect another printer to the
network.
11. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.
If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the
DVD.

Connect directly to a computer (Mac OS)
You can connect your printer directly to a computer without going through a network, by using the
printer's built-in USB 2.0 socket.

ENWW

1.

Make sure the printer is either turned off or disconnected from the computer.

2.

Insert the HP Start-up Kit DVD into your DVD drive.

3.

Open the DVD icon on your desktop.

4.

Open the Mac OS X HP Designjet Installer icon.

5.

Follow the instructions on your screen. You are recommended to use the Easy Install option.

Connect directly to a computer (Mac OS)
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Connectivity

5.

6.

The printer software is installed, including the printer driver and the HP Utility.

7.

When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up
a connection to your printer.

8.

Make sure that the printer is turned on and connected to the computer with a certified USB cable.
NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables
certified by the USB Implementor's Forum (http://www.usb.org/) should be used with this printer.

9.

In the HP Printer Setup Assistant, click Continue.

Connectivity

10. In the list of printers that appears, select the entry that uses the connection type USB, and click
Continue.
11. The following screen displays information about your printer's installation, where the name of the
printer can be modified. Make any changes you wish to make, and click Continue.
12. Your printer is now connected. In the Printer Queue Created screen, click Quit to exit, or Create
New Queue if you want to connect another printer.
13. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.
If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the
DVD.

Sharing the printer
If your computer is connected to a network, you can make your directly connected printer available to
other computers on the same network.
1.

Double-click the System Preferences icon on the Dock menu bar on your desktop.

2.

Go to Sharing, select Printer Sharing, and then check the printer(s) that you want to share.

3.

Your printer now automatically appears in the list of shared printers displayed by any other
computer running Mac OS and connected to your local network.

Any other people wishing to share your printer must install the printer software on their own computers.
Anyone sharing your printer will be able to send print jobs, but will not be able to receive information
from the printer—which affects printer alerts, printer status reports, paper management, printer
administration and troubleshooting.
You may find that sharing your directly connected printer with other users will slow down your
computer unacceptably.
TIP: The best way to share the printer over a network is to connect the printer not to any computer,
but to the network. See Connect to a network (Mac OS) on page 14.

Uninstall the printer software (Mac OS)
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1.

Insert the HP Start-up Kit DVD into your DVD drive.

2.

Open the DVD icon on your desktop.

3.

Open the Mac OS X HP Designjet Uninstaller, and follow the instructions on your screen to
uninstall the printer software.

Chapter 2 Connectivity and software instructions
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To delete the print queue:
From the system preferences, select the Print & Fax dialog.

2.

Select the name of the printer and click the – button.

Connectivity

1.
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Personalize the printer

●

Change the language of the front-panel display

●

Access the HP Utility

●

Access the Embedded Web Server

●

Change the language of the HP Utility

●

Change the language of the Embedded Web Server

●

Change the sleep mode setting

●

Turn the buzzer on and off

●

Change the front-panel display contrast

●

Change the units of measurement

●

Configure network settings

●

Change the graphic language setting

●

Paper suitability options
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Change the language of the front-panel display
There are two possible ways to change the language of the front-panel menus and messages.
●

If you can understand the current front-panel display language, select the Setup menu icon

,

then Front panel options > Select language.
●

If you cannot understand the current front-panel display language, start with the printer powered
off. At the front panel, press the OK key and hold it down. While holding the OK key down, press
the Power key and hold it down. Continue to hold down both keys until the green light on the right
side of the front-panel display starts flashing, and then release both keys. You can expect a delay
of about one second. If the green light starts flashing without any delay, you may need to start
again.

Whichever method you used, the language selection menu should now appear on the front-panel
display. Highlight your preferred language with the Up and Down keys, then press the OK key.
When you have selected your preferred language, turn off the printer with the Power key and then turn
it on again. The front panel will appear in the selected language.

The HP Utility enables you to manage your printer from a computer with a USB, TCP/IP or Jetdirect
connection.
●

Under Windows, start the HP Utility from your desktop shortcut or from Start > All Programs
> Hewlett-Packard > HP Utility > HP Utility. This launches the HP Utility, showing the
printers installed on your computer.

●

Under Mac OS, launch the HP Utility from your dock shortcut or by selecting STARTUP_DISK >
Library > Printers > hp > Utilities > HP Utility. This launches the HP Utility, showing the
printers installed on your computer.
When you select your printer in the left pane, everything that appears in the right pane is specific
to that printer.

If you have followed these instructions but failed to get through to the HP Utility, see Cannot access the
HP Utility on page 175.

Access the Embedded Web Server
The Embedded Web Server enables you to manage your printer remotely using an ordinary Web
browser running on any computer.
To access the Embedded Web Server directly, you must have a TCP/IP connection to your printer.
However, you can access the Embedded Web Server indirectly through the HP Utility, if you connect to
your printer with a USB connection.
The following browsers are known to be compatible with the Embedded Web Server:

ENWW

●

Internet Explorer 6 and later, for Windows

●

Safari 2 and later, for Mac OS X

●

Firefox 1.5 and later

Change the language of the front-panel display
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Access the HP Utility

To access the Embedded Web Server on any computer, open your Web browser and give the IP
address of your printer.
You can find your printer's IP address by selecting the Connectivity menu icon

, then Gigabit

Ethernet or Jetdirect EIO, then View configuration.
If you have followed these instructions but failed to get through to the Embedded Web Server, see
Cannot access the Embedded Web Server on page 172.

Change the language of the HP Utility
The HP Utility can work in the following languages: English, Portuguese, Spanish, Catalan (Windows
only), French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese.
●

Under Windows, select Tools > Set Language and select a language from the list.

●

Under Mac OS, the language is changed as for any other application. In System
Preferences, select International and re-launch the application.

Change the language of the Embedded Web Server
Personal settings

The Embedded Web Server can work in the following languages: English, Portuguese, Spanish,
Catalan, French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and
Japanese. It uses whichever language you have specified in your Web browser's options. If you have
specified a language that it cannot support, it works in English.
To change the language, you must change your Web browser's language setting. For example, in
Internet Explorer version 6, go to the Tools menu and select Internet Options, Languages. Then
ensure that the language you want is at the top of the list in the dialog box.

Change the sleep mode setting
If the printer is left switched on but unused for a certain period of time, it goes automatically into sleep
mode to save power. To change the time the printer waits before it goes into sleep mode, go to the
front panel and select the Setup menu icon

, then Front panel options > Sleep mode wait

time. Highlight the wait time you want and then press the OK key. You can set the time from 1 to 240
minutes. The default time is 30 minutes.

Turn the buzzer on and off
To turn the printer's buzzer on or off, go to the front panel and select the Setup menu icon

, then

Front panel options > Enable buzzer, and highlight on or off and press the OK key. By default,
the buzzer is set to on.

Change the front-panel display contrast
To change the contrast of the front-panel display, select the Setup menu icon

, then Front panel

options > Select display contrast, and enter a value using the Up or Down key. Press the OK key
to set the value. The default contrast is set to 50.
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Change the units of measurement
To change the units of measurement in the front-panel display, select the Setup menu icon

, then

Front panel options > Select units, and select English or Metric. By default the units are set to
metric.

Configure network settings

●

IP Configuration method: specify the way to set an IP address, selecting BOOTP, DHCP,
Auto IP or Manual.

●

Host name: specify an IP name for the network device. The name may contain up to 32 ASCII
characters.

●

IP address: specify the IP address on the print server. Duplicate IP addresses on a TCP/IP
network are not allowed.
NOTE: If you change the current IP address and click Apply, the browser loses the current
connection to the print server because it is pointing to the old address. To reconnect, browse to the
new IP address.

●

Subnet mask: specify a subnet mask, which is a 32-bit number applied to an IP address to
determine which bits specify the network and subnet and which bits uniquely specify the node.

●

Default gateway: specify the IP address of a router or computer that is used to connect to other
networks or sub-networks. If none exist, use the IP address of the computer or the IP address of the
print server.

●

Domain name: specify the name of the DNS domain in which the print server resides (for
example, support.hp.com).
NOTE: The domain name does not include the host name: it is not the fully qualified domain
name, such as printer1.support.hp.com.

●

Idle timeout: specify the number of seconds that an idle connection is allowed to remain open;
30 is the default value. If set to zero, the timeout is disabled and TCP/IP connections remain open
until closed by the other node (such as a workstation) on the network

●

Default IP: specify the IP address to use when the print server is unable to obtain an IP address
from the network when powered on or when reconfigured to use BOOTP or DHCP.

●

Send DHCP requests: specify whether DHCP requests are transmitted when a legacy default IP
address or a default Auto IP is assigned.

To configure the same network settings from the front panel, select the Connectivity menu icon

,

then Gigabit Ethernet or Jetdirect EIO > Modify configuration.
You have various other options available from the Connectivity menu icon.
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●

USB: view information about the USB connection

●

Jetdirect EIO: view information, configure and reset the Jetdirect connection

Change the units of measurement
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You can view and configure the network settings from the HP Utility. Under Windows, select the
Settings tab, then Network Settings. Under Mac OS, select Configuration > Network
Settings. The following settings are available.

●

Advanced > Select I/O timeout: specify the number of seconds that an idle connection is
allowed to remain open, 270 is the default value, if set to zero, the timeout is disabled

●

Advanced > Allow SNMP: specify whether SNMP is permitted

●

Advanced > Embedded Web Server > Allow EWS: specify whether the Embedded Web
Server is enabled

●

Advanced > Web Services > HP Utility software: view the HP Utility software settings

●

Advanced > Web Services > Color and paper management: view the color and paper
management settings

Change the graphic language setting
You can change the graphic language setting from the HP Utility with the following steps.
1.

Under Windows, select the Settings tab then Printer settings > Printing preferences.
Under Mac OS, select Configuration then Printer settings > Configure printer
settings > Printing preferences.

2.

Select one of the following options.

Personal settings

●

Select Automatic to let the printer determine which type of file it is receiving. This is the
default setting; it works for most software applications. You should not normally need to
change it.

●

Select HP-GL/2 only if you are sending a file of that type directly to the printer, without
going through a printer driver.

●

Select PDF only if you are sending a file of that type directly to the printer, without going
through a printer driver (with the PostScript upgrade only).

●

Select PostScript only if you are sending a file of that type directly to the printer, without
going through a printer driver (with the PostScript upgrade only).

●

Select TIFF only if you are sending a file of that type directly to the printer, without going
through a printer driver (with the PostScript upgrade only).

●

Select JPEG only if you are sending a file of that type directly to the printer, without going
through a printer driver (with the PostScript upgrade only).

You can change the graphic language setting from the front panel. Select the Setup menu icon

,

then Printing preferences > Select graphic language. Select the desired option and press the
OK key to set the value.
NOTE: If the graphic language is set from the HP Utility, it overrides the front panel setting.
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Paper suitability options
Paper mismatch action
If the paper currently loaded in the printer is not suitable for a particular job, the printer can either put
the job on hold until some suitable paper is loaded, or it can ignore the problem and print the job on
the unsuitable paper. There are several ways in which the loaded paper may be considered unsuitable:
●

The paper type is not as specified for the job

●

The paper source (roll 1, roll 2 or roll 3) specified for the job has no paper loaded

●

The paper size is smaller than specified for the job

You can set the printer's behavior in such cases from the front panel.
●

Select the Setup menu icon

, then Job management options > Paper mismatch

action > Print anyway if you want such jobs to print on whatever paper is loaded. This is the
default option.

●

Select the Setup menu icon

, then Job management options > Paper mismatch

action > Put job on hold if you want such jobs to be put on hold. The printer will send an alert
whenever a job is put on hold.
When a job is put on hold for paper, it is kept in the printer queue until some suitable paper is loaded
and you select it to be printed again. Meanwhile, other jobs with different requirements can continue
printing.

Roll switching options
If two rolls are loaded, both of which are suitable for the job, the roll will be chosen according to your
preferences. These can be set from the front panel: select the Setup menu icon

, then Printing

preferences > Paper options > Roll switching options. The following options are available:
●

Minimize paper waste. If this option is chosen, the printer will choose the narrowest roll that
meets all the criteria, to avoid wasting paper due to trimming. This is the default option.

●

Minimize roll changes. If this option is chosen, the printer will choose the roll that is currently
active, to avoid wasting time with a roll switch. To change the active roll, select the Paper menu
icon

●

, then Select active roll.

Use roll with less paper. If this option is chosen, the printer will choose the roll that has the
least paper.
NOTE: This option is effective only if you have enabled Printing paper info (see Printing
paper info on page 38). Otherwise, it has the same effect as Minimize paper waste.

●

Match exact size. If this option is chosen, a roll will be chosen only if its width matches the
job's width exactly.

NOTE: If nesting is on (see Nest jobs to save paper on page 89), the roll switching options are
ignored and the printer behaves as though Minimize paper waste has been chosen.
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NOTE: The printer will print the job on the selected roll regardless of the size and type of the
roll: if the roll is too narrow for the job, the job will be clipped.
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Handle the paper

●

Overview

●

Load a roll into the printer

●

Unload a roll from the printer

●

View information about the paper

●

Perform paper advance calibration

●

Download paper presets

●

Cancel the drying time

●

Change the drying time

●

Printing paper info

●

Feed and cut the paper

●

Store the paper

●

Order paper
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Overview
Paper is only a subset of the portfolio of printing materials that the printer can handle. You can also
print on a wide variety of films, textiles and fabrics, self-adhesive materials, and banner and sign
materials. Throughout this guide, however, these materials are generally referred to as paper.
NOTE: Because the front panel has limited space, the names of the HP paper might be abbreviated
and might not appear in the front panel exactly as they are shown on the packaging label.
NOTE: Because the complete list of supported paper is very long, only the most common paper types
appear in the front panel. If you want to see an HP paper type that does not appear on the front panel,
download the preset to the printer from http://www.hp.com/go/designjet. See Download paper
presets on page 37.

Use paper
Choosing the correct paper type for your needs is an essential step in ensuring good print quality. For
best printing results, use only recommended HP paper (see Supported paper types on page 28), HP
papers have been developed and thoroughly tested to ensure reliable performance. All printing
components (printer, ink system, and paper) have been designed to work together to offer trouble-free
operation and ensure optimal print quality.

●

Allow all paper types to adapt to room conditions, out of the packaging, for 24 hours before
using them for printing.

●

Handle film and photo paper by the edges, or wear cotton gloves. Skin oils can be transferred to
the paper, leaving fingerprint marks.

●

Keep the paper tightly wound on the roll throughout the loading and unloading procedures. To
make sure that the roll stays tightly wound, consider using tape to adhere the lead edge of the roll
to the core just before removing the roll from the printer. You can keep the roll taped during
storage. If the roll starts to unwind, it can become difficult to handle.

Handle the paper

Here are some additional tips about paper usage:

NOTE: The use of tape to adhere the lead edge of the roll is especially important for 76.2-mm
(3-in) cores, in which the inherent stiffness of the printing material can cause the material to loosen
and unwind from its core.
●

Whenever you load a roll, the front panel prompts you to specify the paper type that you are
loading. For good print quality, it is essential to specify this correctly. Make sure that the paper
name that is printed on the packaging label matches the description on the front panel.
If you cannot find a specific paper on the front-panel display, go to http://www.hp.com/go/
designjet/supplies to download the latest paper preset to your printer, or select the paper
description that best matches the paper name printed on the packaging label.
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●

The quality of some images might be reduced if you use a paper type that is unsuitable for your
image. This is especially important to consider when printing on fiber-based papers such as HP
Universal Coated Paper, HP Coated Paper, HP Heavyweight Coated Paper and HP Universal
Heavyweight Coated Paper. Printing images that contain high-saturation area fills on fiber-based
papers can create unwanted wavy patterns as a result of paper expansion. This can ultimately
contribute to more severe problems. Consider using Super Heavyweight Coated Paper and other
cockle-free papers when printing high-saturation area fills.

●

Make sure that the appropriate print-quality setting (Best, Normal, or Fast) is selected. You can set
the print quality in the driver, in the Embedded Web Server, or on the front panel. Driver or

Overview
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Embedded Web Server settings override front panel settings. The combination of paper type and
print-quality settings tells the printer how to place the ink on the paper—for example, the ink
density and halftoning method. See Select print quality on page 79.
●

Although the ink systems that are supplied with this printer have good light-fastness, colors will
eventually fade or change if exposed to sunlight over a long period of time

●

If the paper type shown on the front panel does not correspond to the paper that you intend to
use, take one of the following actions:
◦

Reload the roll into the printer and select the correct paper type. See Unload a roll from the
printer on page 34 and Load a roll into the printer on page 30.

◦

Use the Embedded Web Server or the HP Utility to reconfigure the paper type for the roll.

◦

At the printer's front panel, select the

icon, and then select View loaded paper >

Change paper type.
NOTE: The paper advance calibration is not performed when the paper type is changed
from the frnt panel.

Drying time
With some paper types and under certain environmental conditions, the ink needs some time to dry
before the paper is unloaded. The following settings are available for each paper type:

Handle the paper

●

Automatic: the printer automatically determines the appropriate drying time, based on the paper
you have selected and the current temperature. If any drying time is required, a “drying time to
go” countdown appears on the front panel.

●

Extended: the default drying time is extended. This can be used if you find that the default
drying time is sufficient to dry the ink.

●

Reduced: the default drying time is reduced. This can be used if you want to get prints as fast as
possible, and you find that the reduced drying time causes no significant problem in your
environment.

●

None: no drying time is provided. This can be used, for example, if you are manually removing
the prints as quickly as the printer is producing them.

●

Manual: this allows you to specify the drying time (in seconds).

To change the drying time, see Change the drying time on page 37.

Supported paper types
The following table lists the most common HP paper types that are suitable for use with your printer,
and shows the name that you should select on the front panel when loading each paper type. If you
want to use an HP paper that does not appear on the front panel, go to http://www.hp.com/go/
designjet/supplies and download the appropriate paper preset. You only need to download a preset
once; the printer stores it for future use and it subsequently appears in the front panel .
For the part numbers, widths, and weights of these papers, see Order paper on page 39.
NOTE: This list is likely to change over the course of time. For the latest information, visit
http://www.hp.com/go/designjet/supplies/.
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Paper type

Product name

Front-panel name

Bond and Coated Paper

HP Coated Paper

HP Coated Paper

HP Universal Bond Paper

HP Universal Bond Paper

HP Bright White Inkjet Bond Paper

HP Bright White Inkjet Bond Paper

HP Recycled Bond Paper

HP Recycled Bond Paper

Plain paper (inkjet or LED) from 60 to 80 g/m²

Plain paper

Bright white bond paper

Bright White Bond Paper

Coated or plain paper (inkjet or LED) from 90 to 110
g/m²

Coated Paper

Heavyweight coated or plain paper (inkjet or LED)
above 110 g/m²

Heavyweight Coated Paper

Recycled bond paper

Recycled Bond Paper

Natural tracing paper

Natural Tracing Paper

Translucent bond

Translucent Bond

Vellum

Vellum

HP Universal High-Gloss Photo Paper

HP Universal High-Gloss Photo Paper

Photo glossy paper for dye-based inks

Photo Gloss Paper

Photo semi-glossy or satin paper for dye-based inks

Photo Semi-Gloss/Satin Paper

Photo matte paper

Photo Matte Paper

Transparent or clear film

Transparent/Clear Film

Matte film

Matte Film

Backlit Material

Backlit material

Backlit Material

Self-Adhesive Material

Adhesive paper

Adhesive Paper

Adhesive polypropylene satin

Adhesive Polypropylene Satin

Technical Paper

Photo Paper

Film

ENWW
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Table 4-1 Supported paper types
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1.

At the printer's front panel, select the

2.

Select the roll that you intend to load using the Up and Down keys. The printer puts all rolls on
standby.

3.

If the selected roll is currently loaded, the printer automatically unloads it, printing the barcode if
Printing paper info is enabled (see Printing paper info on page 38). Remove the unloaded
roll.

4.

If Printing paper info is not enabled, the front panel asks you to select the paper type (see
Supported paper types on page 28).

5.

Open the roll door with its blue handle when prompted by the front panel.

6.

Check that the hubs are the correct size for the roll you want to load. If necessary, change them.

7.

Move the left hub to the left by pressing the blue lever.

8.

Put the roll into the cavity with the paper edge on the near side facing downwards.

Chapter 4 Handle the paper

icon, and then select Paper load > Load roll.
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9.

Insert the right side of the roll onto the right hub. Check that the roll is in contact with the disc.

Handle the paper

10. Push the left hub onto the left end of the roll. Check that the hub disc is aligned with the green
mark.

11. Check that there is no gap between the roll and either of the hubs.
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12. Pull some paper from the roll.
13. If you need to trim the leading edge of the paper, you can use a sharp knife (not supplied with the
printer) to cut along the slot in the paper feed brake.

14. Open the paper feed brake.

15. Advance the paper to the blue zone.

Handle the paper
32

Chapter 4 Handle the paper

ENWW

16. Close the paper feed brake. Check that the paper edge is still in the blue zone.

Handle the paper

17. Close the roll door.
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18. If the paper that you are using has a barcode printed on the leading edge of the roll, and
Printing paper info is enabled, the printer automatically reads the information.

If Printing paper info is enabled and no barcode is detected on the roll that is being loaded,
the front panel asks you to enter the paper type and the length of the roll you are loading. Select
the paper category and paper type of the roll. If it is not clear which paper category or paper
type to select, see Supported paper types on page 28.

Select the length of the roll.

19. The printer performs some paper calibrations, after which the roll is ready for use.
NOTE: During initial printer setup, printhead alignment and color calibration are performed
automatically after the roll is loaded into the printer.

Handle the paper

If you experience a problem while loading the paper, follow the instructions on the front panel to load
successfully. If you cancel the load, the paper will be unloaded. Here are some problems that can
occur:
●

Paper not found. Check that the paper type is supported (perhaps it's transparent).

●

Right edge of roll too far from blue line. Check that the paper is correctly aligned with the right
hub.

●

Back door unexpectedly opened. Do not open the back door during a roll load.

●

End of roll reached. In this case, the paper is ejected at the front of the printer.

Unload a roll from the printer
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1.

At the printer's front panel, select the

2.

All rolls are put on standby, and the paper is unloaded. If Printing paper info is enabled, the
barcode is printed on the paper edge (see Printing paper info on page 38).

3.

Wait until the front panel asks you to open the roll door, then open it.

Chapter 4 Handle the paper

icon, and then select Unload paper.
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4.

Wind any trailing paper manually onto the roll.

5.

Move the left hub to the left by pressing the blue lever.

6.

Remove the roll.

7.

Close the roll door.

View information about the paper
On the printer's front panel, select the

icon, and then select View paper source.

The following information appears on the front panel:
●

The roll status

●

The paper type that you have selected

●

The width of the paper in millimeters (estimated by the printer)

●

The length of the paper in millimeters (estimated by the printer)

●

The color calibration status

●

The paper advance calibration status

If no paper is loaded, the message Out of paper appears.
The same information appears on the Embedded Web Server's Supplies page.

Perform paper advance calibration
Handle the paper

The printer is calibrated to advance correctly when printing all the papers that appear on the front
panel. When you select the type of loaded paper, the printer adjusts the rate at which it advances the
paper while printing. However, to fine-tune the image quality of your print, you may need to calibrate
the rate at which the paper advances. See Troubleshoot print-quality issues on page 147 to determine
whether paper-advance calibration is the solution for your issue.
Accurate paper advance controls proper placement of dots on the paper. If the paper is not advanced
correctly, light or dark bands appear in the printed image and the grain in the image might increase.
The printer starts paper advance calibration automatically if accurate paper advance is particularly
important for the loaded paper type. This can happen after the paper is loaded or after printhead
replacement.
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To check the paper advance calibration status of the paper, select the

icon, and then select View

loaded paper > View paper details. The status appears:
●

DEFAULT: The default calibration set in the factory is used. Unless you experience print-quality
problems such as banding or graininess, HP recommends that you do not recalibrate the paper
advance.

●

RECOMMENDED: The paper supports automatic advance calibration, but has not yet been
calibrated, or its calibration has become obsolete. HP recommends that you perform paper
advance calibration to optimize the values.

●

OK: The paper has already been calibrated. However, you may need to repeat the calibration if
you experience print-quality problems such as banding or graininess.
NOTE: Whenever you update the printer firmware, the paper-advance calibration values are
reset to the factory default. See Update the printer firmware on page 144.
NOTE: Colored papers, glossy canvas, and transparent materials such as translucent bond,
clear film, natural tracing paper, and vellum are not suitable for paper-advance calibration.

Overview of the paper advance procedure
1.

On the front panel, select the

icon, and then select Image quality maintenance >

Paper advance calibration > Calibrate paper advance. The printer automatically
calibrates the paper-advance and prints a paper advance calibration image.
2.

Wait until the front panel shows the status screen, and then reprint your image.
NOTE: The calibration procedure takes approximately six minutes. The front-panel display
shows any errors in the process.

Handle the paper

If you are satisfied with your image, continue using this calibration for your paper type. If you see
improvement in your image, continue with the next step. If you are dissatisfied with the calibration,
return to the default calibration. See Return to the default calibration on page 37.
3.

To fine-tune the calibration, select the

icon, and then select Image quality maintenance

> Paper advance calibration > Adjust paper advance.
4.

Select the percentage of change from –5‰ to +5‰. To correct light banding, decrease the
percentage. To correct dark banding, increase the percentage.
TIP: This can also be useful for fine-tuning the total length of the print. Bear in mind that 1‰
means a change of 1 mm per meter, or 1 mil per inch.
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5.

Press the OK button on the front panel to save the value.

6.

Wait until the front panel shows the status screen, and then reprint your image.
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Return to the default calibration
Returning to the default calibration sets all the paper-advance calibration to zero. To return to the
default paper advance-calibration value, you must reset the calibration.
1.

On the front panel, select the

icon, and then select Image quality maintenance >

Paper advance calibration > Reset paper advance.
2.

Wait until the front panel shows that the operation has been successfully completed before you
press the Back button to return to the Ready screen.

Download paper presets
Each supported paper type has its own characteristics. The printer changes the way it prints on each
different paper type. For example, some might need more ink and some might require a longer drying
time. The printer requires a description of the requirements of each paper type. This description is
called the “paper preset”.
The paper preset contains the ICC profile, which describes the color characteristics of the paper. It also
contains information about other characteristics and requirements of the paper that are not directly
related to color. Existing paper presets for your printer are installed in the printer's software.
Your printer contains paper presets for only the most commonly used paper types. If you buy a paper
type for which your printer has no preset, you cannot select that paper type in the front panel.
You can assign a preset for a new paper type in three ways:
●

Use an HP factory paper preset by selecting the closest category and type on the front panel or in
the HP Utility
NOTE: Because colors might not be accurate, this method is not recommended for high-quality
prints.
Go to http://www.hp.com/go/designjet/downloads and click the HP Designjet ICC/Paper
presets and PANTONE tables link. Select from the HP Designjet paper presets dropdown menu.

Handle the paper

●

NOTE: HP provides presets for HP paper types only. If you do not find the paper preset that you
want on the Web, it might have been added to the latest firmware for your printer. Check the
firmware release notes for information. See Update the printer firmware on page 144.

Cancel the drying time
Press the Form Feed and Cut button

on the front panel.

CAUTION: A print that has not dried sufficiently can suffer from quality problems.

Change the drying time
You can use the HP Utility to change the drying time for a particular paper type, to accommodate
special printing conditions.
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1.

Open the HP Color Center.

2.

Select Paper preset management.

Download paper presets
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3.

Select Change printing properties.

4.

Select the paper category.

5.

Select the paper type.

6.

Choose a drying time from the Dry Time drop-down menu.
NOTE: The text box to the right of the drop-down menu will not display the time in seconds
when the Automatic option is selected (it is selected by default for all paper types). This is
because the Automatic option means that the printer will calculate the optimal drying time for
you depending on the temperature at printing time, and therefore it cannot be known in advance.

You can turn off all drying time for all paper types by selecting the

icon, then Print retrieval >

Select drying time > Off.
For more information about drying time, see Drying time on page 28.

Printing paper info
The Printing paper info option is enabled by default; it allows the printer to estimate the remaining
roll length by reading a barcode that is printed on the leading edge of the roll whenever the paper is
unloaded.

When you load a new, unused roll, there is no barcode already printed on it, so the front panel will
ask you for the length. The length printed on the barcode at unloading time is calculated from the
length you declare at the start, minus the length that has been printed.
NOTE: If you declare at loading time that the length of the roll is unknown, then Printing paper
info is disabled and no barcode is printed.

Handle the paper

To disable the Printing paper info option, select the

icon in the printer's front panel, and then

select Printing preferences > Paper options > Disable printing paper info. In this case, the
length will not be requested, and the barcode will be neither printed nor read.

Feed and cut the paper
If you press the Form feed and cut key
on the front panel, the printer advances the paper and makes
a straight cut across the front edge. There are at least two possible reasons why you may want to do
this.
●

To trim the leading edge of the paper if it is damaged or not straight.

●

To cancel the waiting time and print the available pages immediately, if the printer is waiting to
nest more pages.

NOTE: The printheads are serviced after each print, and the paper cannot be cut until the process
completes, so you may notice a delay.
CAUTION: Remove the cut piece from the output tray. If strips or short prints are left in the output
tray, the printer could jam.
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Store the paper
The following are tips for storing paper:
●

Always keep unused rolls wrapped in the plastic wrap to prevent discoloration. Rewrap partially
used rolls if they are not being used.

●

Do not stack rolls.

●

Allow all paper types to adapt to room conditions out of the packaging for 24 hours before
printing.

●

Handle film and glossy paper by the edges or wear cotton gloves. Skin oils can be transferred to
the paper, leaving fingerprint marks.

●

Keep the paper tightly wound on the roll throughout the loading and unloading procedures. If the
roll starts to unwind, it can become difficult to handle.

Order paper
The following paper types are currently provided for use with your printer.
NOTE: This list is likely to change over the course of time. For the latest information, see
http://www.hp.com/go/designjet/supplies/.

●

(A) indicates papers that are available in Asia (excluding Japan)

●

(J) indicates papers that are available in Japan

●

(C) indicates papers that are available in China only

●

(E) indicates papers that are available in Europe, the Middle East, and Africa

●

(L) indicates papers that are available in Latin America

●

(N) indicates papers that are available in North America

Handle the paper

Key to geographic availability:

If the part number is not followed by parentheses, the paper is available in all regions.
All papers listed are compatible with the T7100, but only the papers marked with * in the first column
are compatible with the T7100 Mono.
Table 4-2 Paper
Paper type

g/m²

Length

Width

Part numbers

210

30.5 m (100 ft)

610 mm (24 in)

Q6626A

914 mm (36 in)

Q6627A

1067 mm (42 in)

Q6628A

HP Bond and Coated Paper
HP Super Heavyweight Plus Matte
Paper

ENWW
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Table 4-2 Paper (continued)
Paper type

g/m²

Length

Width

Part numbers

HP Heavyweight Coated Paper

131

30.5 m (100 ft)

610 mm (24 in)

C6029C (AEJN)

914 mm (36 in)

C6030C

1067 mm (42 in)

C6569C

67.5 m (225 ft)

1067 mm (42 in)

Q1956A (EN)

30.5 m (100 ft)

610 mm (24 in)

Q1412A (AEJN)

914 mm (36 in)

Q1413A

1067 mm (42 in)

Q1414A (AEJN)

420 mm (16.54 in)

Q1443A (J)

594 mm (23.39 in)

Q1442A (EJ)

610 mm (24 in)

C6019B

841 mm (33.11 in)

Q1441A (EJ)

914 mm (36 in)

C6020B

1067 mm (42 in)

C6567B

91.4 m (300 ft)

914 mm (36 in)

C6980A

45.7 m (150 ft)

610 mm (24 in)

Q1404A (AEJN)

914 mm (36 in)

Q1405A (AEJN)

1067 mm (42 in)

Q1406A

420 mm (16.54 in)

Q1446A (J)

594 mm (23.39 in)

Q1445A (EJ)

610 mm (24 in)

C1860A (LN),
C6035A (AEJ)

841 mm (33.11 in)

Q1444A (EJ)

914 mm (36 in)

C1861A (LN),
C6036A (AEJ)

91.4 m (300 ft)

914 mm (36 in)

C6810A

45.7 m (150 ft)

594 mm (23.39 in)

Q8003A (AJ)

610 mm (24 in)

Q1396A

914 mm (36 in)

Q1397A

1067 mm (42 in)

Q1398A

594 mm (23.39 in)

Q8004A (AEJ)

841 mm (33.11 in)

Q8005A (AEJ)

914 mm (36 in)

Q8751A (ELN)

HP Universal Heavyweight Coated
Paper

HP Coated Paper *

HP Universal Coated Paper *

HP Bright White Inkjet Bond Paper *

Handle the paper

HP Universal Bond Paper *

120

90

95

90

80

45.7 m (150 ft)

45.7 m (150 ft)

175 m (574 ft)
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Table 4-2 Paper (continued)
Paper type

g/m²

Length

Width

Part numbers

HP Recycled Bond Paper *

80

45.7 m (150 ft)

420 mm (16.54 in)

CG892A (E)

610 mm (24 in)

CG889A (EN)

914 mm (36 in)

CG890A (EN)

1067 mm (42 in)

CG891A (EN)

610 mm (24 in)

51631D (ELN)

914 mm (36 in)

51631E

594 mm (23.39 in)

Q1439A (J)

610 mm (24 in)

C3869A (AE)

914 mm (36 in)

C3868A (AE)

610 mm (24 in)

C3860A (AJN)

914 mm (36 in)

C3859A (LN)

610 mm (24 in)

C3862A (N)

914 mm (36 in)

C3861A (LN)

610 mm (24 in)

C3876A (AEJN)

914 mm (36 in)

C3875A

610 mm (24 in)

51642A (AEJN)

914 mm (36 in)

51642B

610 mm (24 in)

CG459A

914 mm (36 in)

CG460A

610 mm (24 in)

Q8916A

914 mm (36 in)

Q8917A

1067 mm (42 in)

Q8918A

610 mm (24 in)

Q8920A

914 mm (36 in)

Q8921A

1067 mm (42 in)

Q8922A

HP Technical Paper
HP Special Inkjet Paper *

HP Natural Tracing Paper *

HP Translucent Bond Paper *

HP Vellum Paper *

90

90

67

75

45.7 m (150 ft)

45.7 m (150 ft)

45.7 m (150 ft)

45.7 m (150 ft)

HP Film (technical and graphic)
HP Clear Film *

HP Matte Film *

174

160

22.9 m (75 ft)

38.1 m (125 ft)

HP Premium Matte Photo Paper

HP Everyday Pigment Ink Gloss
Photo Paper

HP Everyday Pigment Ink Satin
Photo Paper
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210

235

235

30.5 m (100 ft)

30.5 m (100 ft)

30.5 m (100 ft)

HP Professional Satin Photo Paper

300

15.2 m (50 ft)

610 mm (24 in)

Q8759A

HP Premium Plus Gloss Photo Paper

280

15.2 m (50 ft)

610 mm (24 in)

Q5488A (EN)

HP Premium Plus Satin Photo Paper

280

15.2 m (50 ft)

458 mm (18 in)

Q7920A (N)

610 mm (24 in)

Q5491A (EN)

Order paper
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Table 4-2 Paper (continued)
Paper type

g/m²

Length

Width

Part numbers

HP Premium Instant-dry Gloss Photo
Paper

260

30.5 m (100 ft)

914 mm (36 in)

Q7993A

1067 mm (42 in)

Q7995A

22.9 m (75 ft)

610 mm (24 in)

Q7991A

30.5 m (100 ft)

914 mm (36 in)

Q7994A

1067 mm (42 in)

Q7996A

22.9 m (75 ft)

610 mm (24 in)

Q7992A

30.5 m (100 ft)

610 mm (24 in)

Q6574A

914 mm (36 in)

Q6575A

1067 mm (42 in)

Q6576A

61 m (200 ft)

1067 mm (42 in)

Q8754A (LN)

30.5 m (100 ft)

610 mm (24 in)

Q6579A

914 mm (36 in)

Q6580A

1067 mm (42 in)

Q6581A

61 m (200 ft)

1067 mm (42 in)

Q8755A

30.5 m (100 ft)

610 mm (24 in)

Q1426A (AEJN)

914 mm (36 in)

Q1427A (AEJN)

1067 mm (42 in)

Q1428A (AEJN)

610 mm (24 in)

Q1420A (AEJN)

914 mm (36 in)

Q1421A (AEJN)

1067 mm (42 in)

Q1422A (AEJN)

914 mm (36 in)

Q8747A

1067 mm (42 in)

Q8748A

914 mm (36 in)

Q8676A (EN)

1067 mm (42 in)

Q8677A (EN)

HP Premium Instant-dry Satin Photo
Paper

HP Universal Instant-dry Gloss Photo
Paper

HP Universal Instant-dry Semi-gloss
Photo Paper

HP Universal High-gloss Photo Paper

HP Universal Semi-gloss Photo Paper

260

190

190

190

190

30.5 m (100 ft)
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HP Backlit Material
HP Premium Vivid Color Backlit Film

285

30.5 m (100 ft)

HP Self-Adhesive Material
HP Universal Adhesive Vinyl

42

290

20.1 m (66 ft)

HP Colorfast Adhesive Vinyl

328

12.2 m (40 ft)

914 mm (36 in)

C6775A

HP Adhesive-backed Polypropylene

128

50 m (164 ft)

914 mm (36 in)

Q8044A (C)

1067 mm (42 in)

Q8884A (C)

914 mm (36 in)

Q8834A

1067 mm (42 in)

Q8835A

610 mm (24 in)

CG843A

914 mm (36 in)

CG824A

1067 mm (42 in)

CG825A

HP Self-adhesive Gloss
Polypropylene

120

HP Everyday Adhesive Matte
Polypropylene

180
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22.9 m (75 ft)
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Table 4-2 Paper (continued)
Paper type

g/m²

Length

Width

Part numbers

HP Durable Semi-gloss Display Film

255

15.2 m (50 ft)

914 mm (36 in)

Q6620B (EN)

HP Opaque Scrim

486

15.2 m (50 ft)

610 mm (24 in)

Q8675A (N)

914 mm (36 in)

Q1898B (AEN)

1067 mm (42 in)

Q1899B (AEN)

914 mm (36 in)

Q1903A (AEN)

1067 mm (42 in)

Q1904A (AEN)

610 mm (24 in)

CH022A (EN)

914 mm (36 in)

CH023A (EN)

1067 mm (42 in)

CH025A (EN)

61 m (200 ft)

914 mm (36 in)

CH024A (N)

22.9 m (75 ft)

914 mm (36 in)

CG821A

1067 mm (42 in)

CG822A

HP Banner and Sign Material

HP Matte Polypropylene

HP Everyday Matte Polypropylene

HP Durable Banner with Du Pont
Tyvek

130

120

140

22.9 m (75 ft)

30.5 m (100 ft)

Non-recommended paper types
In many cases, paper types that HP does not support might be compatible with your printer. However,
the following paper types are unlikely to give satisfactory results:
Photo paper that swells

●

Brochure paper

Handle the paper

●
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Ink system components
Ink cartridges
The T7100 printer's six ink cartridges provide black, yellow, magenta, cyan, gray and dark gray ink to
the printheads. The T7100 Mono printer has two ink cartridges, black and dark gray.

Ink cartridges require no maintenance or cleaning. When each ink cartridge is shaken vigorously
before installation, and inserted correctly into its slot, the ink will flow to the printheads. Because the
printheads control the amount of ink that is transferred to the page, high-quality printing results continue
even when the ink levels are getting low.
CAUTION: Avoid touching pins, leads, and circuitry when handling ink cartridges because these
elements are sensitive to electrostatic discharge. Such devices are called ESD-sensitive devices. See
Glossary on page 204. Electrostatic discharges are one of the main hazards to electronics products.
This type of damage can reduce the life expectancy of the device.

Replace ink cartridges
To check the ink levels in the ink cartridges:
Press the

●

Select the

key repeatedly until you see the ink levels, or
icon, then Ink cartridge information.

Handle the ink system

●

The front panel warns you when cartridge ink level is low. When a cartridge is empty, the printer stops
printing and the front panel provides an explanation.
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HP recommends that you replace the empty cartridge with a new HP cartridge. See Order ink supplies
on page 67, Remove an ink cartridge on page 48, and Insert an ink cartridge on page 50.
Although it is possible to use refilled or non-HP ink cartridges, either choice has several serious
disadvantages:
●

There is some risk of damaging the printer. In this case the printer warranty will not be valid for
any printer repairs that are related to the cartridge, nor for any problems due to ink
contamination.

●

You will invalidate the warranty of all printheads of the same color used in the printer
subsequently, unless and until the whole ink system (including ink tubes) is replaced.

●

Print quality may be impaired.

●

The printer will be unable to estimate the ink level in the cartridge, and will report it as empty.

If you decide to use refilled or non-HP ink cartridges, you will need to follow these instructions to make
the printer use a cartridge that it believes to be empty.
1.

Install the cartridge in the printer (see Insert an ink cartridge on page 50).

2.

The front panel will complain that the cartridge is empty, and the cartridge removal process will
start. Press the Cancel key to stop this automatic process.

3.

At the front panel, select the

4.

Press the Cancel key and the Up key at the same time, and hold them down for at least two
seconds.

5.

The front panel will display a series of warning messages. In response to each message, press the
Cancel key to cancel the process, or the OK key to confirm that you wish to continue.

icon; highlight Replace ink cartridges, but do not select it.

When you have pressed OK in response to all warning messages, the front panel will give the usual ink
cartridge status display, but the refilled or non-HP cartridge will be shown as empty with a warning
sign.

Printheads
The printheads are connected to the ink cartridges. They use jet action to put ink on the paper. Each
printhead has two ink-cartridge connection points and two sets of nozzles, which means that each
printhead can print in two different colors. For example, the printhead below prints in magenta and
yellow.

Handle the ink system

The printheads are extremely durable and do not need to be replaced every time an ink cartridge is
replaced. They provide excellent results even when the ink cartridges contain a low level of ink.
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To maintain optimum print quality, the printheads are automatically tested at regular intervals, and
automatically serviced when necessary. This takes a little time and can occasionally delay printing.
When a printhead eventually needs to be replaced, the front panel will display a message.
To check the status of the printheads:
●

Press the

●

Select the

key repeatedly until you see the printheads' status, or
icon, then Printhead information.

CAUTION: Avoid touching pins, leads, and circuitry when handling ink cartridges because these
elements are sensitive to electrostatic discharge. Such devices are called ESD-sensitive devices. See
Glossary on page 204. Electrostatic discharges are one of the main hazards to electronics products.
This type of damage can reduce the life expectancy of the device.

Maintenance cartridge
Use the maintenance cartridge to clean and maintain the printheads, ensure the best possible print
quality, and seal the printheads when they are not in use to prevent them from drying out.
NOTE: The maintenance cartridge contains liquid. Therefore, store any maintenance cartridges
upright and on a flat surface.

Ink system tips
●

Install the ink cartridges, printheads, and maintenance cartridge before the install-by date, which
is printed on the packaging. The expiration for the ink cartridges is the manufacturing date
marked on the cartridge plus 30 months.

●

Follow the instructions on the front panel during installation.

●

Allow the printer and the maintenance cartridge to clean the printheads automatically.

●

Avoid unnecessary removal of the ink cartridges and printheads.

●

The ink cartridges should never be removed while the printer is printing. They should be removed
only when the printer is ready for you to replace them. The front panel guides you through the
removal and installation procedures (or see Remove an ink cartridge on page 48 and Insert an
ink cartridge on page 50.

●

Make sure that you comply with all applicable laws and regulations when disposing of ink system
consumables.

Handle the ink system

For best results, always follow these guidelines:

NOTE: Shake the ink cartridges vigorously before installing them. See Insert an ink cartridge
on page 50.

ENWW

Ink system tips

47

Work with ink system components
Remove an ink cartridge
Ink cartridges should be removed for the following two reasons:
●

The ink cartridge is very low and you want to replace it with a full cartridge for unattended
printing. You can use the remaining ink in the first cartridge at a more convenient time.

●

The ink cartridge is empty or faulty, and you must replace it to continue printing.

CAUTION: The procedure to remove an ink cartridge must be initiated from the front panel. Do not
remove an ink cartridge until the front panel prompts you.
CAUTION: Remove an ink cartridge only if you are ready to insert another one.
WARNING! Make sure that the printer wheels are locked (the brake lever is pressed down) to
prevent the printer from moving.
1.

At the front panel, select the

2.

Grip the blue tab in front of the cartridge that you want to remove.

icon, then select Replace ink cartridges.

Handle the ink system
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Pull the blue tab down and then pull it outwards, towards you.

4.

The cartridge comes out, in its drawer.

5.

Lift the cartridge out of its drawer.

NOTE: Avoid touching the end of the cartridge that is inserted into the printer, because the
connection might be coated with ink.
NOTE: If necessary, store a partially-used ink cartridge in the same position as if it were inserted
in the printer. Avoid using a partially-used cartridge that has been stored on its end.
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3.

6.

The front-panel display identifies the missing ink cartridge.

Insert an ink cartridge
1.

Pick up the new ink cartridge and find the label that identifies the ink color. Hold the ink cartridge
so that you can see the label at the top of the side that is facing you.

2.

Check that the colored label above the empty slot in the printer matches the color of the label on
the cartridge.

3.

Shake the cartridge vigorously for about 15 seconds.

4.

Insert the ink cartridge into the cartridge drawer.

5.

Slide the drawer and cartridge into the slot until they lock into position.

Handle the ink system

If you have difficulty, see Cannot insert an ink cartridge on page 165.
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6.

The front-panel display confirms that all cartridges have been correctly inserted.

Remove a printhead
WARNING! Make sure that the printer wheels are locked (the brake lever is pressed down) to
prevent the printer from moving.
Printhead replacement must be performed after the printer has been turned on with the hard power
switch at the back of the printer.
1.

At the front panel, select the

2.

The printer moves the carriage into the correct position.

icon, then select Replace printheads.

CAUTION: If the carriage remains in the removal position for more than 3 minutes without
inserting or removing any printheads, it will attempt to return back to its home position to the right.
When the carriage has stopped moving, the front panel prompts you to open the printer window.

Handle the ink system

3.

ENWW

Work with ink system components

51

4.

Locate the carriage on the right side of the printer.

5.

Pull up and release the latch on top of the carriage.

6.

Lift up the cover. This provides access to the printheads.

7.

To remove a printhead, lift up the blue handle.

Handle the ink system
52

Chapter 5 Handle the ink system

ENWW

8.

Using the blue handle, gently disengage the printhead.

9.

Gently pull the blue handle upward until the printhead is released from the carriage.
CAUTION:

Do not pull abruptly. That action can damage the printhead.

Handle the ink system

10. The front-panel display identifies the missing printhead.

ENWW

Work with ink system components

53

Insert a printhead
1.

Remove the orange protective caps by pulling them down.

2.

The printhead is designed to prevent you from accidentally inserting it into the wrong slot. Check
that the colored label on the printhead matches the colored label of the carriage slot into which
the printhead is to be inserted.

3.

Insert the new printhead into its correct slot in the carriage.
CAUTION: Insert the printhead slowly and vertically, straight down. It can be damaged if you
insert it too quickly, or at an angle, or if you rotate it as you insert it.

4.

Push down as indicated by the arrow.

Handle the ink system

CAUTION: You might feel some resistance when installing the new printhead, so you need to
press it down firmly but smoothly. You should hear a beep and see confirmation on the front-panel
display that the printhead has been inserted. If you have difficulty, see Cannot insert a printhead
on page 165.
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5.

Insert all of the other printheads that need to be installed, and close the carriage cover.

6.

Make sure that the end of the blue handle catches the wire loop on the near side of the carriage.

7.

Lower the handle to rest on the carriage cover.

When all of the printheads have been inserted correctly and the printer has accepted them, the
printer beeps.
NOTE: If the printer does not beep when you insert the printhead and the Replace message
appears on the front-panel display, you might need to reinsert the printhead.
Close the printer window.

Handle the ink system

8.
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9.

The front-panel display confirms that all of the printheads are correctly inserted, and the printer
starts checking and preparing the printheads. The default routine process, when all printheads are
changed, takes about 18 minutes. If the printer identifies a problem when preparing the
printheads, the process takes longer, up to 30 minutes. For a single printhead insertion, the time
varies between 10 and 20 minutes.

10. After all printheads are checked and prepared, the printhead realignment procedure runs
automatically if paper is loaded. See Align the printheads on page 59.
11. Depending on the paper type, the paper advance calibration procedure may run automatically if
paper is loaded. See Perform paper advance calibration on page 35.

Clean (recover) the printheads
Periodic printhead cleaning is performed automatically, as long as the printer is kept turned on.
However, you should clean the printheads if you are experiencing poor image quality and cannot
resolve the issues by other methods. This ensures that there is fresh ink in the nozzles and helps to
prevents nozzle clogs.
If you have printed the printhead status plot, you know which colors are failing. Clean the pair of
printheads that are not performing adequately. If you are not sure which printheads to clean, clean all
of the printheads.
To clean the printheads, go to the printer's front panel and select the Image Quality Maintenance menu
icon

, select Clean printheads, and then select which printheads you want to clean. You can

clean all of the printheads or only some of them.
Cleaning all printheads takes about 5 minutes. Cleaning any two printheads takes about 3 minutes.
NOTE: Cleaning all printheads uses more ink than cleaning a single pair.
NOTE: HP recommends that you purge the ink from the printheads before printing a job if the printer
has been turned off for more than six weeks or if you are experiencing inconsistent colors from print to
print after long storage periods. Purging the ink from the printheads helps to ensure maximum color
consistency; it is not a remedy for poor printhead health.

Clean the electrical connections on a printhead
It is possible that the printer will not recognize a printhead after it has been installed. This can happen
when ink builds up on the electrical connections between the printhead and the printhead carriage.
Under these circumstances, HP recommends that you clean the electrical connections on the printhead.
However, routine cleaning of the connections when no problems are apparent is not recommended.

Handle the ink system

Use an absorbent lint-free cloth, slightly dampened with isopropyl alcohol, to clean the electrical
interconnects on both the printhead carriage and the printhead if the Reseat or Replace message
persists next to the printhead on the front-panel display.
1.
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Open the printhead carriage latch and extract the printhead that is causing the problem, as
indicated on the front panel. See Remove a printhead on page 51.
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2.

Cover your finger with the cloth and insert it into the printhead slot at the back.

3.

Rub the cloth against the electrical contacts with a light force along the entire depth of the flex
connector. Try to avoid picking up any ink deposit that may have accumulated on the bottom
surface of the slot.

4.

Take special care to clean all contacts thoroughly, including the ones at the lowest point of the
connector.

5.

Using the same cloth, clean the strip of electrical contacts on the printhead (unless the printhead is
new). Avoid touching the printhead nozzles.

Handle the ink system

CAUTION: If the carriage remains in the central part of the printer for more than 7 minutes, it
attempts to return to its home position to the right.

CAUTION: Do not touch the surface of the printhead that contains the nozzles, because the
nozzles are easily damaged.
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6.

After waiting a few moments to allow both connectors to dry, replace the printhead into the
printhead carriage. See Insert a printhead on page 54.

7.

Wash or dispose of the cloth. Take care to prevent the transfer of ink onto hands and clothing.

If the front panel continues to show the Reseat or Replace message, replace the printhead or contact
your HP customer service representative.

Clean the printhead drop detector
The printhead drop detector is a sensor that detects which nozzles on the printheads are not printing,
so that other nozzles can substitute for them. If particles block the sensor (such as fibers, hair or small
pieces of paper), print quality is affected.
When the front panel displays a warning message that the drop detector needs cleaning, you are
recommended to clean it. If you do not clean it immediately, the printer continues working normally, but
the front panel display continues to show the warning.
CAUTION: Wear gloves to avoid getting ink on your hands.

1.

On the printer's front panel, select the

2.

Turn off the printer at the front panel.

3.

To avoid an electric shock, switch the printer off and unplug it.

4.

Open the printer window.

icon, then select Replace printheads.

Handle the ink system
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Find the printhead drop detector to the right of the printhead carriage.

6.

Remove any debris blocking the printhead drop detector.

7.

With a dry, lint-free cloth, wipe the surface of the drop detector to remove any non-visible debris.

8.

Close the printer window.

9.

Plug in and switch on the printer.

10. Power the printer on at the front panel.

Align the printheads
Precise alignment between printheads is essential for accurate colors, smooth color transitions and
sharp edges in graphical elements. Your printer has an automatic printhead alignment process which
runs whenever a printhead has been accessed or replaced.
If the paper has jammed or you are experiencing problems with color accuracy, you may need to align
the printheads.
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5.

NOTE: If the paper has jammed, it is recommended that you reinsert the printheads and initiate the
realignment procedure with the Image Quality Maintenance menu

.

CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

Reinsert printheads procedure
1.

If the realignment process is running and the wrong paper is loaded, press the Cancel key on the
front panel.
CAUTION: Do not print if the realignment process has been canceled. You can restart the
alignment with the Image Quality Maintenance menu procedure.

2.

Load the paper you wish to use, see Handle the paper on page 26. It should be at least 420 mm
(16.54 in) wide.
CAUTION:

Do not use transparent or semi-transparent paper to align the printheads.

3.

Remove and re-insert all the printheads, see Remove a printhead on page 51 and Insert a
printhead on page 54. This starts the printhead alignment procedure.

4.

Ensure the window is closed, as a strong light source near the printer during printhead
realignment can affect alignment.

5.

The process takes about six minutes. Wait until the front-panel display shows the process complete
before using the printer.
NOTE: The printer prints a calibration image. Do not worry about the image. The front-panel
display shows any errors in the process.

Image Quality Maintenance menu procedure
1.

Load the paper you wish to use, see Handle the paper on page 26. It should be at least 420 mm
(16.54 in) wide.
CAUTION:

2.

Do not use transparent or semi-transparent paper to align the printheads.

From the front panel, select the Image Quality Maintenance menu icon

, then Align

printheads. The printer checks to see if it has enough paper to run the realignment.

Handle the ink system

3.

If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment
pattern. Ensure the window is closed, as a strong light source near the printer during printhead
realignment can affect alignment.

4.

The process takes about five minutes. Wait until the front-panel display shows the process
complete before using the printer.

Scanning errors during alignment
If the alignment process fails, a Scanning problems message appears on the front panel. This means
that the alignment has not completed successfully. Therefore the printer is not aligned and the alignment
should be repeated before printing with good image quality. Possible reasons for failure:
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●

The paper used was not acceptable; repeat the alignment with a different paper type.

●

The printheads are not clean; see Clean (recover) the printheads on page 56.

●

The window was open; repeat the alignment with the window closed.
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If the problem persists after correcting these potential problems, there may be a failure in the scanning
system requiring repair, or the printheads may need to be replaced.

The Image Diagnostics Print
The Image Diagnostics Print consists of patterns designed to highlight printhead reliability problems. It
helps you to check the performance of the printheads that are currently installed in your printer, and
whether any printhead suffers from clogging or other problems.
To print the Image Diagnostics Print:
1.

Use the same paper type that you were using when you detected a problem.

2.

Use the View information key

on the front panel to check that the selected paper type is the

same as the paper type loaded into the printer.
3.

At the printer's front panel, select the Image Quality Maintenance menu icon

, then Print

diagnostic image.
It takes about two minutes to print the Image Diagnostics Print.
The print is divided into two parts, both of which test printhead performance.
●

Part 1 (top) consists of rectangles of pure colors, one for each printhead. This part represents the
print quality that you will get from each color.

●

Part 2 (bottom) consists of small dashes, one for each nozzle on each printhead. This part
complements the first, and aims more specifically to detect how many faulty nozzles each
printhead has.

First look at the upper part of the print (part 1). Each colored rectangle should be a uniform color
without any horizontal lines across it.
Then look at the bottom part of the print (part 2). For each individual colored pattern, check that most of
the dashes are present.
If you see horizontal lines in part 1 and also missing dashes in part 2 for the same color, the printhead
responsible needs cleaning. However, if the rectangles look solid, do not worry about just a few
missing dashes in part 2; these are acceptable because the printer can compensate for a few clogged
nozzles.
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Please look carefully at the print. The names of the colors are shown above the rectangles and in the
center of the patterns of dashes.

Here is an example of a gray printhead in a good state:

And here is an example of the same printhead in a bad state:

Corrective action

Handle the ink system

1.

Clean any faulty printheads (see Clean (recover) the printheads on page 56). Then reprint the
Image Diagnostics Print to see whether the problem has been solved.

2.

If the problem remains, clean the printheads again, and reprint the Image Diagnostics Print to see
whether the problem has been solved.

3.

If the problem remains, consider cleaning your printheads manually (see Clean (recover) the
printheads on page 56). You could also try reprinting your current print job, in case it now prints
satisfactorily.

4.

If the problem remains, try cleaning the printhead drop detector. The printer normally notifies you
when this is necessary, but it may be worth trying even if the printer has not suggested it. See
Clean the printhead drop detector on page 58.

5.

If the problem still remains, replace any persistently faulty printheads (see Handle the ink system
on page 44), or contact HP Support (see HP Customer Care on page 180).

Remove the maintenance cartridge
A message appears on the front panel when you must change the maintenance cartridge. Follow these
precautions when removing a maintenance cartridge:
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●

Be careful not to get ink on your hands. Ink might be on, around, and inside the replaced
maintenance cartridge.

●

Always handle and store the replaced maintenance cartridge upright to avoid spilling any ink.
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CAUTION: A message appears on the front panel when the maintenance cartridge is almost full and
again when it is completely full and must be changed. You can ignore the alert and continue printing
by pressing the OK button on the front panel. However, HP strongly recommends that you change the
maintenance cartridge when prompted. Ignoring the alert can result in serious damage to the printer.
WARNING! Make sure that the printer wheels are locked (the brake lever is pressed down) to
prevent the printer from moving.
1.

At the front panel, select the

2.

The maintenance cartridge is located in a slot underneath the front panel, at the front of the
printer. Open the door.

3.

The maintenance cartridge has a handle on the front. To remove the cartridge, press inward and
upward as indicated by the arrow, until the cartridge is released.

Handle the ink system

icon, then select Replace maintenance ctg.
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4.

Lift up the maintenance cartridge to remove it from the slot, and slide it out.

See also Insert the maintenance cartridge on page 64.

Insert the maintenance cartridge
The plastic bag in which the new maintenance cartridge comes can be used to dispose of the old
maintenance cartridge.
1.

Insert the maintenance cartridge into the slot, in the direction indicated by the arrow.

2.

When the maintenance cartridge has been pushed all the way in, press inwards and downwards
as indicated, until it clicks into place.

Handle the ink system

If you have difficulty, see Cannot insert the maintenance cartridge on page 165.
NOTE: The front panel will not show the new maintenance cartridge until the door is closed.
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3.

When you have inserted the maintenance cartridge into the printer, close the door.

NOTE: The printer needs all the ink cartridges, printheads and maintenance cartridge to be
installed before it can continue.
4.

If no paper is loaded, the front panel will instruct you to load some.

NOTE: Make sure that the printer window and the door to the right are closed after you replace the
supplies. The printer will not print while these are open.

Check the status of the ink system
1.

Access the Embedded Web Server. See Access the Embedded Web Server on page 21.

2.

Go to the Supplies page on the Main tab.

Handle the ink system

The Supplies page shows you the status of the ink cartridges (including the ink levels), the printheads,
the maintenance cartridge, and the loaded paper.

Check the status of the ink cartridges
You can view information about your ink cartridges using the front panel or the HP Utility.
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Front-panel procedure
1.

At the front panel:
●

Press the

●

Select the

key twice, or
icon, then Ink cartridge information.

2.

Select the cartridge about which you want information.

3.

The front panel shows the following information:
●

Color

●

Product name

●

Product number

●

Serial number

●

Status

●

Ink level, if known

●

Total ink capacity in milliliters

●

Expiration date

●

Warranty status

●

Manufacturer

HP Utility procedures
●

In the HP Utility for Windows, go to the Overview tab. The status of each cartridge appears
when you select Supply Status > Cartridges.

●

In the HP Utility for Mac OS, select Information > Printer Status.

Check the status of a printhead
The printer automatically checks and services the printheads after each print. Follow these steps to get
more information on your printheads.
1.

Handle the ink system
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At the front panel:
●

Press the

●

Select the

key three times, or
icon, then Printhead information.

2.

Select the printhead for which you want to see information.

3.

The front panel shows the following information:
●

Colors

●

Product name

●

Product number
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●

Serial number

●

Status (See Front-panel error messages on page 196.)

●

Volume of ink it has used

You can also get most of this information without leaving your computer by using the HP Utility.
NOTE: If the status is See warranty note, this indicates that non-HP ink is being used. Printer
service or repairs required as a result of using non-HP ink are not covered under warranty. See the
Legal Information document for detailed warranty implications.

Order ink supplies
You can order the following ink supplies for your printer.
Table 5-1 Ink cartridges (T7100)
Cartridge

Part number

HP 762 Matte Black 400 ml Ink Cartridge

CM991A

HP 762 Yellow 400 ml Ink Cartridge

CM992A

HP 762 Magenta 400 ml Ink Cartridge

CM993A

HP 762 Cyan 400 ml Ink Cartridge

CM994A

HP 762 Gray 400 ml Ink Cartridge

CM995A

HP 762 Dark Gray 400 ml Ink Cartridge

CM996A

HP 762 Matte Black 775 ml Ink Cartridge

CM997A

Table 5-2 Ink cartridges (T7100 Mono)
Part number

HP 762 Matte Black 400 ml Ink Cartridge

CM991S

HP 762 Dark Gray 400 ml Ink Cartridge

CM996S

HP 762 Matte Black 775 ml Ink Cartridge

CM997S or CN072A

HP 762 Dark Gray 775 ml Ink Cartridge

CN073A

Handle the ink system
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Table 5-3 Printheads (T7100)
Printhead

Part number

HP 762 Yellow Printhead

CH645A

HP 762 Magenta & Cyan Printhead

CH646A

HP 762 Gray and Dark Gray Printhead

CH647A

HP 762 Matte Black & Matte Black Printhead

CH648A

Table 5-4 Printheads (T7100 Mono)
Printhead

Part number

HP 762 Matte Black & Matte Black Printhead

CH648A

HP 762 Dark Gray Printhead

CN074A

Table 5-5 Maintenance cartridge
Maintenance cartridge

Part number

HP 761 Maintenance Cartridge (for 7100)

CH649A

HP 762 Maintenance Cartridge (for 7100 Mono)

CM998A

Handle the ink system
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Use of multiple rolls

●

The uses of a multiroll printer

●

How the printer allocates jobs to paper rolls
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Multiroll printing

The uses of a multiroll printer
A multiroll printer can be useful in several different ways:
●

The printer can automatically switch between different paper types according to your needs.

●

The printer can automatically switch between different paper widths according to your needs. This
enables you to save paper by printing smaller images on narrower paper.

●

If you load two or more identical rolls into the printer, you can leave it printing unattended for a
long time, because it can switch from one roll to another automatically when the first is exhausted.
See Unattended printing/overnight printing on page 91.

There are two concepts to help you when working with multiple rolls.
●

The active roll is the roll that is currently loaded and will be printed on by default unless the printer
has some reason to switch rolls. To change the active roll, select the Paper menu icon

, then

Select active roll.
●

A protected roll is protected from use unless the roll number or its paper type are specifically
requested. See Roll protection on page 91.

The current status of all rolls is shown on the front panel's status screen.

How the printer allocates jobs to paper rolls
When you submit a print job from the Embedded Web Server or the printer driver, you can specify
(using the Paper type or Type is option) that you want it to be printed on a particular paper type;
you can even specify (using the Paper source, Source is or Paper Feed option) that you want it to
be printed on a particular roll (1 or 2). The printer will try to satisfy these requirements, and it will also
look for a paper roll large enough to print the image without clipping.
●

If both rolls are suitable for the job, the roll will be chosen according to the roll switching policy.
See Roll switching options on page 25.

●

If just one of the rolls is suitable for the job, it will be printed on that roll.

●

If neither roll is suitable for the job, it will be held in the job queue with the status “On hold for
paper”, or printed on an unsuitable roll, depending on the paper mismatch action. See Paper
mismatch action on page 25.

The printer driver for Windows will tell you which paper types and widths are currently loaded in the
printer, and on which rolls.

70

Chapter 6 Use of multiple rolls

ENWW

Multiroll printing

Here are some settings that might be used in typical situations:
●

●

With different paper types loaded:
◦

Type is: select the paper type you require

◦

Source is: Automatically select / Predetermined

◦

Roll switching policy: doesn't matter

With different paper widths loaded:
◦

Type is: Any

◦

Source is: Automatically select / Predetermined

◦

Roll switching policy: Minimize paper waste

TIP: You can also save paper in some cases by rotating or nesting your images. See Use paper
economically on page 88.
●

With identical rolls loaded:
◦

Type is: Any

◦

Source is: Automatically select / Predetermined

◦

Roll switching policy: Minimize roll changes

Job allocation with nesting
If nesting is on (see Nest jobs to save paper on page 89), the printer assumes that your main aim is
to save paper. Therefore, the roll switching options are ignored and the printer behaves as though
Minimize paper waste has been chosen. See Roll switching options on page 25.
If the paper mismatch action is set to Print anyway, jobs can be nested together on any roll, even if
the roll does not match the paper source or paper type specified in the job settings. To respect these
job settings, set the paper mismatch action to Put job on hold. See Paper mismatch action
on page 25.
TIP: If you have a roll intended for special purposes only, or with particularly expensive paper, you
can use roll protection to prevent jobs from using that roll by accident. See Roll protection
on page 91.
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7

Use of the stacker

The stacker is an optional accessory. It stacks prints flat, on top of one another, instead of letting them
fall into the bin.

Stacker
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●

Install the stacker

●

Uninstall the stacker

●

Using paper with the stacker

●

Stacker messages

●

Change the temperature

●

Change paper rolls while using the stacker

●

Clean the exterior of the stacker

●

Clean the stacker rollers

●

Move or store the stacker
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Install the stacker
Connect the cables between the stacker and the printer.

2.

Switch on the stacker.

3.

Select the

Stacker

1.

icon on the printer's front panel, then Accessories > Stacker > Install

stacker. The front panel will prompt you to attach the stacker to the printer.
4.

There are two latches on the stacker that engage with the printer deflectors. To attach the stacker
to the printer, attach first one side and then the other (because less force is required that way).

NOTE: The stacker operates on cut sheets of paper. When it is switched on, the cutter is
automatically enabled. It cannot work if the cutter is turned off or if the printing material cannot be cut
(canvas, for example).

Uninstall the stacker
1.

To uninstall the stacker, select the

icon on the printer's front panel, then Accessories >

Stacker > Uninstall stacker.
2.

The front panel will then prompt you to detach the stacker from the printer. Pull the stacker from
one side to detach it on that side, then detach the other side.

3.

Disconnect the stacker cables.

Using paper with the stacker
The stacker can handle cut sheets of paper between 420 mm (A3 portrait) (16.5 in) and 1189 mm (A0
portrait) (46.8 in) in length. Shorter prints will be enlarged to the minimum length with extra white
space; longer prints risk falling off the stacker.
Some printing materials are not compatible with the stacker, including:

ENWW

●

Matte and clear film

●

Glossy paper (except instant-dry glossy paper, which may be used)

●

Heavyweight coated paper

●

Canvas

Install the stacker
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When printing in Fast mode on Translucent Bond, Vellum or Natural Tracing Paper, there could be
some ink transfer marks in highly inked areas. Select Normal or Best mode to avoid this problem. See
Select print quality on page 79.
NOTE: You will have to remove the accumulated pile of cut sheets from the stacker every now and
then.
NOTE: If you retrieve just one job from the stack, try to leave the stack in a tidy condition, otherwise
you may experience stacking problems and paper jams.

Stacker messages
Stacker

You may see the following messages when using the stacker.
●

Remove the stacker: You must uninstall the stacker before printing, because there is no paper
loaded that is compatible with it.

●

Hold for stacker removal: You must uninstall the stacker before printing the current job,
because the paper type specified for the job is not compatible with the stacker, and the paper
mismatch action is Hold for paper.

●

Hold for paper: The paper mismatch action is Hold for paper, and the paper type specified
for the job is not loaded.

●

Load paper for next job: No paper is loaded.

Change the temperature
NOTE: This option is only available if the stacker is installed on the printer.
The stacker contains a heated roller to remove the curl from the paper. To change the temperature of
the roller, select the

icon on the printer's front panel, then Accessories > Stacker > Select

temperature. There are three options:
●

Normal is the default and recommended setting.

●

High sets the roller to a higher temperature, which may be useful for particularly stiff paper.

●

Low sets the roller to a lower temperature, which may be useful for paper with a particularly
sensitive coating.

Change paper rolls while using the stacker
1.

Remove the stack of cut paper from the stacker in order to make the stacker easier to handle.

2.

Detach the stacker from the printer: first one side, then the other.

3.

Change the rolls in the normal way: see Unload a roll from the printer on page 34 and Load a roll
into the printer on page 30.

Clean the exterior of the stacker
See Clean the exterior of the printer on page 140.
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Clean the stacker rollers
WARNING!
cool.

The stacker becomes hot during use. Before cleaning, switch it off and give it time to

Ink tends to stick to the main stacker roller and the small output rollers, which should therefore be
cleaned regularly using a fabric cloth dampened with water.

●

For plain, coated or heavyweight coated paper, once a month may be sufficient.

●

For translucent, vellum, glossy or natural tracing paper, cleaning may be required once a week
even with the slowest print modes.

Stacker

The frequency with which cleaning is needed depends to some extent on the paper type in use.

Move or store the stacker
Before moving or storing the stacker, take a couple of steps to reduce the amount of space it occupies.
1.

ENWW

Undo the screws at either side of the stacker tray, and let the tray hang vertically.

Clean the stacker rollers
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2.

Remove the pin from each leg extension, and rotate the leg extension upwards.

Stacker
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Create a print job
In order to print something, you must send it to the printer. This constitutes a print job, which is entered
into the printer's print queue. There are two main ways of sending a print job to the printer:
●

To print directly from a program, use the program's Print command as usual. When you select
your HP Designjet printer, the printer driver is invoked to send your job to the printer.

●

If you have a file that is already in a supported graphical format, you can use the Embedded Web
Server to send it directly to the printer without going through a printer driver (see below).

Using the Embedded Web Server to print files
From the HP Utility or the Embedded Web Server, select Submit Job in the Job Center group. You will
see the window below.

Print options
Press the Add files button to choose the files from your computer that you want to print. The files must
be in one of the following formats:
●

HP-GL/2

●

RTL

●

CALS/G4

●

PDF (with the PostScript upgrade only)

●

PostScript (with the PostScript upgrade only)

●

TIFF (with the PostScript upgrade only)

●

JPEG (with the PostScript upgrade only)

NOTE: When you print to a file, the file should be in one of the above formats, but its name may
have an extension such as .plt or .prn.
If the files are not in one of these formats, they will not be printed successfully.
If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and
number of copies), you can just press the Print button and they will be sent to the printer.
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If you need to specify printing settings, go to the Job settings section and select the options you need.
Each option has explanatory text on the right, so that you can understand the behavior of each setting.
Remember that, if you leave the setting as Default, the setting saved in the job will be used. If the job
contains no setting, the setting in the printer will be used.

Printing stored jobs
When you print a file with the Embedded Web Server, you can mark the job to be stored permanently
in the printer.
If you select Stored jobs in printer in the Main tab of the Embedded Web Server, you will see a
list of the stored jobs. The information displayed for each job includes:
●

The name of the job

●

The size of the job

●

The date and time when the job was received by the printer

●

The name given by the person who submitted the job

You can click on the title of any column to sort the list by the information in that column.

●

Print: The selected jobs are printed with the original settings. You will be able to see the progress
of your jobs on the Job queue page.

●

Advanced print: The settings of the selected jobs are displayed, and you can modify them. You
can save the new settings by pressing the Save button, and print the jobs by pressing the Print
button.

Print options

You can select one or more jobs in the list and perform the following operations on them by using the
buttons at the top of the list.

The value of a setting is shown only if it has the same value in all of the selected jobs. Otherwise,
a hyphen is shown.
●

Delete: The selected jobs are permanently deleted from the printer.

Select print quality
The printer has various print-quality options because best-quality printing requires some loss of speed,
while fast printing implies some reduction in print quality.
Therefore, the standard print-quality selector is a slider that allows you to choose between quality and
speed.
Alternatively, you can select from the custom options: Best, Normal and Fast. If you select Fast, you
can also select EconoMode, which uses a lower rendering resolution and consumes less ink. It
therefore increases printing speed even further, but reduces print quality. EconoMode can be selected
only from the custom options (not from the slider).
There are also two supplementary custom options that may have an effect on print quality: Maximum
detail and More passes. See High-quality printing on page 81.
NOTE: In the Windows driver dialog, the rendering and printing resolutions for your job are
displayed in the Paper/Quality tab. In the Mac OS Print dialog, they are displayed in the
Summary panel.
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You can select print-quality options in the following ways:
●

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality
section. If you select Standard Options, you will see a simple slider with which you can select
speed or quality. If you select Custom Options, you will see the more specific options described
above.

●

In the Mac OS X 10.4 Print dialog: go to the Image Quality panel and look at the
Quality Options section. If you select Standard quality options, you will see a simple slider with
which you can select speed or quality. If you select Custom quality options, you will see the more
specific options described above.

●

In the Mac OS X 10.5 Print dialog: go to the Paper/Quality panel and look at the
Quality Options section. If you select Standard quality options, you will see a simple slider with
which you can select speed or quality. If you select Custom quality options, you will see the more
specific options described above.

●

On the Embedded Web Server's Submit Job page: select Basic settings > Print
quality. If you then select Standard options, you can choose between Speed and Quality.
If you select Custom options, you will see the more specific options described above.

●

Using the front panel: select the Setup menu icon

, then Printing preferences > Print

quality.

Print options

NOTE: If you have set the print quality from your computer, that overrides the print-quality setting
in the front panel.
NOTE: You cannot change the print quality of pages that the printer is already receiving or has
already received (even if they have not started to print yet).

Print a draft
You can specify fast draft-quality printing in the following ways:
●

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality
section. Move the print-quality slider to the extreme left ('Speed').

●

In the Mac OS X 10.4 Print dialog: go to the Image Quality panel and move the printquality slider to the extreme left ('Speed').

●

In the Mac OS X 10.5 Print dialog: go to the Paper/Quality panel and move the printquality slider to the extreme left ('Speed').

●

On the Embedded Web Server's Submit Job page: select Basic settings > Print
quality > Standard options > Speed.

●

Using the front panel: select the Setup menu icon

, then Printing preferences > Print

quality > Select quality level > Fast.
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You can specify even faster draft-quality printing by using EconoMode, as follows. This is intended
mainly for documents containing only text and line drawings.
●

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality
section. Select Custom Options, then set the quality level to Fast and check the EconoMode
box.

●

In the Mac OS X 10.4 Print dialog: go to the Image Quality panel and set the quality
options to Custom, then set quality to Fast and check the EconoMode box.

●

In the Mac OS X 10.5 Print dialog: go to the Paper/Quality panel and set the quality
options to Custom, then set quality to Fast and check the EconoMode box.

●

On the Embedded Web Server's Submit Job page: select Basic settings > Print
quality > Custom. Set Quality level to Fast, and EconoMode to On.

High-quality printing
●

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality
section. Move the print-quality slider to the extreme right ('Quality').

●

In the Mac OS X 10.4 Print dialog: go to the Image Quality panel and move the printquality slider to the extreme right ('Quality').

●

In the Mac OS X 10.5 Print dialog: go to the Paper/Quality panel and move the printquality slider to the extreme right ('Quality').

●

On the Embedded Web Server's Submit Job page: select Basic settings > Print
quality > Standard options > Quality.

●

Using the front panel: select the Setup menu icon

Print options

You can specify high-quality printing in the following ways:

, then Printing preferences > Print

quality > Select quality level > Best.
Printing is bidirectional by default (the printheads print when travelling in both directions across the
paper), but you can choose Unidirectional printing for a further small improvement in quality at the
expense of speed. This option is not available if you have chosen Fast print quality.

If you have a high-resolution image
If your image has a resolution greater than the rendering resolution (which you can see in the driver's
Paper/Quality tab under Windows), print sharpness may be improved by selecting the Maximum
Detail option. This option is available only if you are printing on glossy paper and you have selected
Best print quality.
●

In the driver dialog (Mac OS Print dialog): select custom instead of standard print-quality
options, then check the Maximum Detail box.

●

On the Embedded Web Server's Submit Job page: select Basic settings > Print
quality > Custom. Set Quality level to Best, and Maximum detail to Yes.

NOTE: The Maximum Detail option results in slower printing with photo papers, but it does not
increase the amount of ink used.
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If you have printhead problems
If your printheads have an excessive number of clogged nozzles (which may cause banding or white
streaks on your prints), print quality can be improved by selecting the More Passes option.
●

In the driver dialog (Mac OS Print dialog): select custom instead of standard print-quality
options, then check the More Passes box.

●

On the Embedded Web Server's Submit Job page: select Basic settings > Print
quality > Custom. Set Quality level to Best, and More passes to Yes.

NOTE: The More Passes option results in slower printing, but it does not increase the amount of ink
used.
TIP: Instead of using this option, consider using the Image Diagnostics Print to identify the printhead
or printheads that are causing the problem, and then clean or replace them. See The Image Diagnostics
Print on page 61.

Select paper size
The paper size can be specified in the following ways.

Print options

NOTE: The paper size specified here should be the paper size in which the document was created. It
is possible to rescale the document to a different size for printing. See Rescale a print on page 84.
●

In the Windows driver dialog: select the Paper/Quality tab, then select your paper size
from the Document Size list.

●

In the Mac OS Page Setup dialog: select your printer in the Format for popup menu, then
Paper Size.
NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

●

On the Embedded Web Server's Submit Job page: select Advanced settings >
Paper > Page size > Standard.

●

Using the front panel: select the Setup menu icon

, then Printing preferences >

Paper options > Select paper size.
NOTE: If you have set the paper size from your computer, that overrides the paper size setting
in the front panel.
NOTE: If you have disabled skew checking, the paper length is estimated as four times the
width.
TIP: If your document is 330 × 483 mm (13 × 19 in), designed to fit on sheet paper of the same
size, select the document size Super B/A3.
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Custom paper sizes
To choose a non-standard paper size not shown in the list of paper sizes:
●

Under Windows, there are three different ways:
◦

In the driver dialog, press the Custom button in the Paper/Quality tab, then specify the
name and the dimensions of your new paper size, then click Save to save your new paper
size. In the PostScript driver, to see your new custom size in the list of custom sizes, you need
to exit the printer properties, then reenter them (and use the More button if necessary).
NOTE: The driver will not allow you to create a paper size whose width exceeds its length.

◦

From the Start menu, select Printers, then from the File menu select Server Properties.
In the Forms tab, check the Create a new form box, specify the name and dimensions of
the new form, then click Save Form.
NOTE: Such forms are not available when using a shared printer that is connected to a
different computer.

●

In the Mac OS Page Setup dialog: select Paper Size > Manage Custom Sizes.

●

On the Embedded Web Server's Submit Job page: select Advanced settings >
Paper > Page size > Custom.

Select margins options
By default, the printer leaves a 5 mm (0.02 in) margin between the edges of your image and the edges
of the paper, although the top margin is set to 11.5 mm (0.45 in) when printing on glossy paper. You
can change this behavior in several ways.
●

In the Windows driver dialog: select the Paper/Quality tab and then the Margins/
Layout button.
TIP: In the Windows PostScript driver, make sure you have made the right choice from the
Document size list. You should select a 'no margins' document size if you intend to use the
Oversize or Clip contents by margins options.

●

In the Mac OS X Print dialog: select the Margins/Layout panel.

●

On the Embedded Web Server's Submit Job page: select Advanced settings >
Paper > Layout/Margins.

●

Using the front panel: select the Setup menu icon

, then Printing preferences >

Margins > Select margins.
NOTE: If you have set the margins from your computer, that overrides any margin setting in the
front panel.
You will then see at least some of the following options.
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NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

NOTE: Under Mac OS, the available margins options depend on the paper size selected in the Page
Setup dialog. For instance, for oversize printing you must select a paper size name that includes the
word “oversize”.
●

Standard. Your image will be printed on a page of the size you have selected, with a 5 mm
(0.02 in) margin between the edges of the image and the edges of the paper. The image should
be small enough to fit between the margins.

●

Oversize. Your image will be printed on a page slightly larger than the size you have selected. If
you cut off the margins, you will be left with a page of the size you selected, with no margins
remaining between your image and the edges of the paper.

●

Clip contents by margins. Use this option when your image has white borders and a size
equal to that of the paper you have selected. The printer will use the white borders for its 5 mm
(0.02 in) margins and you will get a page of size equal to that which is selected in the driver.

Print on loaded paper
To print a job on whichever paper is loaded in the printer, select Any in the Paper Type option of your
printer driver.

Print options

●

In the Windows driver dialog: select the Paper/Quality tab, then select Any in the Paper
Type drop-down list.

●

In the Mac OS X 10.4 Print dialog: select the Image Quality panel, then select Any in
the Paper Type drop-down list.

●

In the Mac OS X 10.5 Print dialog: select the Paper/Quality panel, then select Any in
the Paper Type drop-down list.

NOTE: Any is the default Paper Type selection.

Rescale a print
You can send an image to the printer at a certain size but tell the printer to rescale it to a different size
(normally larger). This may be useful if your software does not support large formats.
You can rescale an image in the following ways:
●

●
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In the Windows driver dialog: go to the Features tab and look at the Resizing Options
section.
◦

The Print document on option adjusts the image size to the paper size you have selected.
For example, if you have selected ISO A2 as the paper size and you print an A3-sized
image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer
reduces a larger image to fit the A4 size.

◦

The % of actual size option enlarges the printable area of the original paper size (the
page minus the margins) by the percentage indicated, then adds the margins to create the
output paper size.

In the Mac OS Print dialog: select the Finishing panel, then Print document on to adjust
the image size to the paper size you have selected. For example, if you have selected ISO A2 as
the paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4
paper size is selected, the printer reduces a larger image to fit the A4 size.
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●

●

On the Embedded Web Server's Submit Job page: select Advanced settings >
Resizing.
◦

The Standard and Custom options adjust the image size to the standard or custom paper
size you have selected. For example, if you have selected ISO A2 as the paper size and you
print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is
selected, the printer reduces a larger image to fit the A4 size.

◦

The % of actual size option enlarges the printable area of the original paper size (the
page minus the margins) by the percentage indicated, then adds the margins to create the
output paper size.

Using the front panel: select the Setup menu icon

, then Printing preferences >

Paper options > Resize.

Preview a print
Previewing a print on the screen allows you to check the layout of the print before printing, which may
help you to avoid wasting paper and ink on a bad print.

●

●

To preview a print under Windows, you have the following options:
◦

Use your application's print preview option.

◦

Check the Show preview before printing option, which you can find in the driver's
Paper/Quality tab and Features tab. The preview may be provided in different ways,
depending on your printer and printer driver.

Print options

●

To preview a print under Mac OS, you have the following options:
◦

Use your application's print preview option.

◦

Click the Preview button at the bottom of the Print dialog box. This is the basic print
preview provided by Mac OS.

◦

Check the Show print preview option, which you can find in the driver's Printing
dialog, in the Finishing panel.

To preview a print using the Embedded Web Server, select Basic settings > Hold for
preview.

Print 16-bit color images
In a 16-bit image, each of the three primary colors is encoded by a 16-bit value, so that each pixel
takes up 48 bits.
If you print your 16-bit color images through a printer driver, they will be reduced to 8-bit colors before
they reach the printer.
In order to send a 16-bit color image to the printer, you must save it as a 16-bit color TIFF or JPEG file,
then send the file directly to the printer without using a printer driver (see Using the Embedded Web
Server to print files on page 78). In this case, color management is done on the 16-bit color image,
and is therefore done more accurately. The image is still reduced to 8-bit colors for final printing.
TIP: Some applications refuse to save a 16-bit color image in JPEG format; others automatically
reduce it to 8-bit colors. A TIFF file generally gives a higher-quality result, and is recommended.
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Change the treatment of overlapping lines
NOTE: This topic applies only when printing an HP-GL/2 job.
The merge option controls the overlapping lines in an image. There are two settings:
●

Off: where the lines cross, only the color of the top line is printed. This is the default setting.

●

On: where the lines cross, the colors of the two lines merge.

To turn merge on, go to the front panel and select the Setup menu icon

, then Printing

preferences > HP-GL/2 options > Enable merge. You can set the merge option from your
software in some applications. Settings in your software override the front-panel settings.

Print crop lines
Crop lines indicate where the paper should be cut to reduce it to your selected page size. You can print
crop lines automatically with individual jobs in the following ways:

Print options

●

In the Windows driver dialog: select the Features tab, then Enable crop lines.

●

In the Mac OS Print dialog: go to the Finishing panel and select Enable crop lines.

●

On the Embedded Web Server's Submit Job page: select Advanced settings > Roll
options > Enable crop lines.

●

Using the front panel: select the Setup menu icon

, then Printing preferences >

Paper options > Enable crop lines > On.
To print crop lines with nested jobs (see Nest jobs to save paper on page 89), you must select a
different option:
●

In the Embedded Web Server: select Job management > Use crop lines when nest
is enabled > On.

●

Using the front panel: select the Setup menu icon

, then Job management > Nest

options > Enable crop lines > On.

Rotate an image
By default, images are printed with their shorter sides parallel to the leading edge of the paper, like
this:

86

Chapter 8 Print options

ENWW

Print options

You may wish to rotate your images by 90 degrees in order to save paper, like this:

You can do this in the following ways:
●

In the Windows driver dialog: select the Features tab, then Rotate by 90 degrees.

●

In the Mac OS Print dialog: go to the Finishing panel and select Rotate by 90 degrees.

●

On the Embedded Web Server's Submit Job page: select Advanced settings > Roll
options > Rotate.

●

In the front panel: select the Setup menu icon

, then Printing preferences > Paper

options > Rotate.
NOTE: If rotation is set from your computer, it overrides the setting in the front panel.
NOTE: When you rotate a job, the page length may be increased to avoid clipping, because the top
and bottom margins are usually larger than the side margins.
NOTE: If you rotate an image to landscape whose original orientation was portrait, the paper may
not be wide enough for the image. For example, rotating a portrait D/A1-size image on D/A1-size
paper by 90 degrees will probably exceed the width of the paper. If you are using the Embedded
Web Server, the preview screen will confirm this with a warning triangle.

Autorotate
The Autorotate option automatically rotates jobs by 90 degrees if doing so will save paper.
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Autorotation allows you to defer the decision of rotating a page until printing time. This may be useful if
you routinely work with different roll sizes and want to ensure that jobs will not be clipped or waste
unnecessary paper width if and when roll conditions change.
TIP: Autorotation is particularly useful when combined with the Minimize paper waste roll
switching option (see Roll switching options on page 25).
To enable autorotation:
●

In the Windows driver dialog: select the Features tab, then Autorotate.

●

In the Mac OS Print dialog: go to the Finishing panel and select Autorotate.

●

On the Embedded Web Server's Submit Job page: select Advanced settings > Roll
options > Autorotate.

●

In the front panel: select the Setup menu icon

, then Job management > Autorotate.

NOTE: If autorotation is set from your computer, it overrides the setting in the front panel.
NOTE: The autorotate decision requires known job dimensions. Therefore, printing does not start until
the job has been completely processed, regardless of the When to Start Printing setting (see Select
when to print a job in the queue on page 107); and, if you request Autorotate and Remove
blank areas, only the latter will be done.

Print options

TIP: Once the job is rendered and ready for reprints, autorotation may take a few minutes,
depending on job dimensions and resolution. To speed up autorotated reprints, send the job to render
when the roll configuration meets your planned scenario, and leave last-minute autorotation only to
correct unexpected changes in roll conditions. This applies to TIFF/JPEG/PS/PDF jobs only.

Print in gray shades
You can convert all colors in your image to shades of gray in the following ways:
●

In your application program: many programs provide this option.

●

In the Windows driver dialog: go to the Color tab and look at the Color Options section.
Select Print in Grayscale.

●

In the Mac OS X Print dialog: go to the Color Options panel and select Grayscale from
the Mode drop-down list.

●

On the Embedded Web Server's Submit Job page: select Color > Color/Grayscale >
Print in grayscale.

Use paper economically
Here are some recommendations for making economical use of paper:

88

●

If you are printing relatively small images or document pages, you can use nesting to print them
side by side instead of one after another. See Nest jobs to save paper on page 89.

●

If you are printing multipage documents with relatively small pages, you can print up to 16 of
them on one sheet of paper. Use the Pages per sheet option in the Features tab (Windows
driver) or the Layout panel (Mac OS driver).
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●

●

You may be able to save some paper by using the following options:
◦

In the Windows driver dialog: select the Features tab and then Remove Blank
Areas and/or Rotate by 90 degrees or Autorotate.

◦

In the Mac OS Print dialog: select the Finishing panel, then Remove Blank Areas
and/or Rotate by 90 degrees or Autorotate.

◦

On the Embedded Web Server's Submit Job page: select Advanced settings >
Roll options > Remove blank areas and/or Rotate.

If you check the print preview on your computer before printing, you can sometimes avoid wasting
paper on prints containing obvious mistakes. See Preview a print on page 85.

The Remove Blank Areas option removes blank areas from the top and bottom of the print, so that
less paper is used in printing. If you are using HP-GL/2, this option also removes blank areas from the
sides of the print.

Nest jobs to save paper

Print options

Nesting means automatically printing images or document pages side by side on the paper, rather than
one after the other. This is done to avoid wasting paper.

1.

Direction of paper flow

2.

Nesting off

3.

Nesting on

4.

Paper saved by nesting

How to use nesting
Here are some general guidelines for using nesting:
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●

To enable nesting, use the front panel (Job Management menu) or the Embedded Web Server
(Setup tab).

●

If you are working with batches of jobs with the same format, choose nesting In order. This will
close the nest as the first file with a new format arrives.

Nest jobs to save paper
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●

If you are working with mixed file formats, choose nesting Optimized. This option will nest
compatible pages in the queue, allowing for a gap of up to 3 incompatible pages before closing
the nest (See nesting compatibility below).

●

For the jobs you want nested together, choose common values you will be using and create
presets. You can use the Embedded Web Server's Manage Presets tab to save your presets.

NOTE: If you have a multiroll printer with nesting enabled, your printer will do its best to save paper.
This means that the roll on which less paper is wasted will be chosen regardless of the roll switching
option you have selected (see Roll switching options on page 25).
NOTE: The printer will nest up to eight compatible jobs in a row.
TIP: Use the paper mismatch action Print anyway to minimize paper waste by skipping paper
source or paper type restrictions. For a more fine-grained nesting of jobs based on desired paper
source or type, use the Put job on hold paper mismatch action.
TIP: If you have a roll that is expensive or for special purposes only, use roll protection so that jobs
with unspecified paper type and source will not be able to use your special roll (see Roll protection
on page 91).

Nesting wait time
Print options

When a job is ready to print, if Nesting is enabled, the printer will wait for more jobs to arrive in
order to nest them together. You can change this waiting time from the front panel: select the Setup
menu icon

, then Job management options > Nest options > Select wait time.

You can also cancel nest waiting by pressing the Form feed and cut key on the front panel.

Nesting compatibility
Because nested pages must be printed all at the same time, they are required to share a common
printing format before they can be nested together. If you routinely work with one or two file formats,
and print most of your jobs with the same settings, you don't need to take any extra action to ensure
nesting compatibility. Otherwise, if you want to minimize paper waste using nesting:
●

●

Save your settings in presets, using the Embedded Web Server's Manage presets tab. You can
save:
◦

Print-quality settings (Print quality, Max detail, More passes)

◦

Color and color adjustment settings (see Color adjustment options on page 97)

◦

Layout and mechanical settings (Margins, Mirror, Cutter)

All pages must be in one or other of the following three groups (a single nest must contain
members of only one group):
◦

TIFF and JPEG, which can nest together even with different input profiles

◦

PostScript and PDF

◦

HP-GL/2 using the same color space (sRGB/aRGB/dRGB)

NOTE: CALS/G4 pages do not nest.
NOTE: JPEG and TIFF pages with resolutions greater than 300 dpi may not nest with other pages in
some cases.
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Use ink economically
Here are some recommendations for making economical use of ink.
●

For draft prints, use plain paper and move the print-quality slider to the left end of the scale
('Speed'). For further economy, select custom print quality options, then select Fast and
EconoMode.

●

Clean the printheads only when needed, and clean only those printheads that need cleaning.
Cleaning the printheads can be useful, but it uses ink.

●

Leave the printer permanently turned on so that it can maintain the printheads in good condition
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not
done, the printer may need to use much more ink later to restore the health of the printheads.

●

Wide prints make more efficient use of ink than narrow prints, because printhead maintenance
uses some ink, and its frequency is related to the number of passes made by the printheads.
Therefore, nesting jobs can save ink as well as saving paper (see Nest jobs to save paper
on page 89).

Roll protection
●

To stop people from accidentally printing unimportant jobs on expensive paper.

●

To avoid printing on a particular roll when printing from AutoCAD without interacting with the HP
printer driver.

To protect a roll, go to the front panel and select the Setup menu icon

Print options

If you choose to protect a roll, jobs will be printed on it only if the job explicitly specifies the roll
number or the paper type loaded on the roll. This may be useful, for example, in the following cases.

, then Printing

preferences > Paper options > Roll protection.
NOTE: If you protect a roll, then later unload the current roll and load a new one, the new roll
remains protected. You are protecting the roll number, not one specific roll of paper. That roll number
will remain protected until you cancel the protection.
TIP: If you print without specifying a roll number or paper type, you will not be able to print on any
protected roll.

Unattended printing/overnight printing
Here are some recommendations to help you to deal with a long queue of printing jobs.
●

If feasible, use brand-new long rolls of paper.

●

If you want to print on partly-used rolls, you can check the paper type and the remaining length in
the Embedded Web Server or in the front panel, to confirm that you have enough paper to print
all your jobs.
NOTE: Information on the remaining length is available only if you told the printer the length of
the roll when you loaded it, or if the printer read the length of the roll from the barcode printed on
it.

●
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Load two rolls of paper suitable for your jobs. If the printer finishes one roll, it will automatically
switch to the other.

Use ink economically
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●

Check that you have paper wide enough to print all of your jobs. Any jobs that are too wide may
be put “on hold for paper” if the paper mismatch action is set to Put job on hold (see Paper
mismatch action on page 25).

●

Check the ink levels remaining in your ink cartridges.

●

When you have submitted your print jobs, you can use the Embedded Web Server from a remote
location to monitor their status.

●

Drying time should be set to Automatic.

●

For high throughput, select the Setup menu icon

, then Printing preferences > Paper

options > Roll switching options > Minimize roll changes or Use roll with less
paper.
●

For economical use of paper, select the Setup menu icon

, then Printing preferences >

Paper options > Roll switching options > Minimize paper waste and Autorotate
On.

Print options
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Introduction
Your printer has been engineered with advanced hardware and software features to ensure predictable
and dependable results.
●

Gray, dark gray, and matte black inks provide neutral grays on all paper types

Color printers only
●

Color calibration for consistent colors

●

Color emulation of other HP Designjet printers

If you have a T7100 Mono printer, you should read the sections below on color management and
color adjustment options; you can probably ignore the other sections of this chapter.

How colors are represented
All devices that display color use a color model to represent color in numerical terms. Most monitors
use the RGB (Red-Green-Blue) color model, while most printers use the CMYK (Cyan-Magenta-YellowblacK) color model.
An image can be converted from one color model to another, but in general the conversion is not
perfect. Your printer uses the RGB color model: the same color model that is used by your monitor.
This simplifies but does not completely solve the problem of matching colors. Each device represents
colors a little differently from another device, even if they use the same color model. However, software
can adjust the colors in an image according to the characteristics of the particular device, using a color
profile of the device, in order to achieve correct colors.

A summary of the color management process
Color management

To get the accurate and consistent colors that you want, you should follow these steps for each paper
type that you use.
1.

Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now
and then (see Color calibration on page 94). In addition, you may wish to calibrate
immediately before a particularly important print job for which color consistency is vital.

2.

When printing, select the correct color preset for the paper type you are using.

Color calibration
Color calibration enables your printer to produce consistent colors with the particular printheads, inks
and paper type that you are using, and under your particular environmental conditions. After color
calibration, you can expect to get similar prints from any two different printers situated in different
geographical locations.
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Some paper types cannot be calibrated. For all other paper types, calibration should be done in any of
the following circumstances:
●

Whenever a printhead is replaced

●

Whenever a new paper type is introduced that has not yet been calibrated with the current set of
printheads

●

Whenever the environmental conditions (temperature and humidity) change significantly

You can check the color calibration status of the currently loaded paper at any time by pressing the
View information key on the front panel. The status may be one of the following:
●

PENDING: the paper has not been calibrated.
NOTE: Whenever you update the printer's firmware, the color calibration status of all papers is
reset to PENDING.

●

OBSOLETE: the paper has been calibrated, but the calibration is now out of date because a
printhead has been replaced, and should be repeated.

●

DONE: the paper has been calibrated, and the calibration is up to date.

●

DISABLED: this paper cannot be calibrated.
NOTE: Color calibration cannot be performed on plain paper, nor on any kind of transparent
material.

You can also check the color calibration status by using the HP Utility.

●

From the HP Utility for Windows: select Color Center > Calibrate paper, and choose the
paper to be calibrated.

●

From the HP Utility for Mac OS: select Paper Preset Management from the HP Color Center
button and select Calibrate Paper.
group, choose the paper to be calibrated, press the

●

From the front panel: select the Image Quality Maintenance menu icon

Color management

You can start color calibration in the following ways:

, then Calibrate

color.
The calibration process is fully automatic and can be performed unattended after you have loaded
paper of the type you wish to calibrate—which should be A4 or any larger size. The paper on the
active roll will be calibrated; you should ensure that the roll you want to calibrate is active. To change
the active roll, select the Paper menu icon

, then Select active roll.

The process takes about 3–5 minutes and consists of the following steps.
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1.

A calibration chart is printed, which contains patches of each ink used in your printer.

2.

The chart is allowed to dry for a period of time that depends on the paper type, so that the colors
have time to stabilize.

Color calibration
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3.

The chart is scanned and measured.

4.

From the measurements, the printer calculates the necessary correction factors to apply for
consistent color printing on that paper type. It also calculates the maximum amount of each ink
that can be applied to the paper.

Color management from printer drivers
Color management options
The aim of color management is to reproduce colors as accurately as possible on all devices: so that,
when you print an image, you see very similar colors as when you view the same image on your
monitor.
There are two basic approaches to color management for your printer:
●

Application-Managed Colors: in this case your application program must convert the colors
of your image to the color space of your printer and paper type, using the ICC profile embedded
in the image and the ICC profile of your printer and paper type.

●

Printer-Managed Colors: in this case your application program sends your image to the
printer without any color conversion, and the printer converts the colors to its own color space. The
details of this process depend on the graphics language that you are using.

Color management

◦

PostScript (with the PostScript upgrade): the PostScript interpreter module inside the
printer performs the color conversion using the profiles stored in the printer and any
additional profiles sent with the PostScript job. This kind of color management is done when
you are using the PostScript driver and you specify printer color management or when you
send a PostScript, PDF, TIFF or JPEG file directly to the printer through the Embedded Web
Server. In either case you have to select the profiles to use as default (in case the job doesn't
specify any) and the rendering intent to apply.

◦

Non-PostScript (HP-GL/2, RTL): the color management is done using a set of stored
color tables. ICC profiles are not used. This method is somewhat less versatile than the
alternatives, but is a little simpler and faster, and can produce good results with standard HP
paper types. This kind of color management is done when you are using a non-PostScript
driver and you specify printer color management, or when you send an HP-GL/2 or RTL file
directly to the printer through the Embedded Web Server.
NOTE: There are only two color spaces that the printer can convert to its own color space
using the stored color tables: Adobe RGB and sRGB if you are using Windows, Adobe RGB
if you are using Mac OS.

You are recommended to consult the Knowledge Center (see Knowledge Center on page 178) to see
how to use the color management options of your particular application.
To choose between Application-Managed Colors and Printer-Managed Colors:

96

●

In the Windows driver dialog: select the Color tab.

●

In the Mac OS Print dialog: select the Color Options panel.

●

In some applications: you can make this choice in the application.

Chapter 9 Color management

ENWW

Printer emulation
If you want to print a particular job and to see approximately the same colors that you would get from
printing the same job on a different HP Designjet printer, you can use the emulation mode provided by
your printer.
NOTE: This option is available only when printing an HP-GL/2, PostScript or PDF job. It will work
correctly only when printing on plain, coated or heavyweight coated paper.
●

In the Windows driver dialog: select the Color tab, then Printer Managed Colors, then
select Printer Emulation from the Source Profile list. You can then select from the Emulated
Printer list.

●

In the Mac OS Print dialog: select the Color Options panel, then select from the Printer
Emulation list.

Color adjustment options
The aim of color management is to print accurate colors. If you perform color management correctly,
then you should be able to print accurate colors with no need of any manual color adjustments.
However, manual adjustments may be useful in the following situations:
●

If your color management is not working correctly for some reason

●

If you want colors that are subjectively pleasing rather than accurate

The printer driver provides different adjustment facilities depending on whether you are printing in color
or in grayscale. If you are printing in pure black and white, there are no color adjustment options.

Printing in color
●

In the Windows driver dialog: select the Color tab, ensure that the Advanced color
adjustments box is checked, then press the Settings button beside it.

●

In the Mac OS X 10.5 or 10.6 Print dialog: select the Color Options panel, select Color
from the Mode list, then press the Adjust button.

●

In the Mac OS X 10.4 Print dialog: select the Color Options panel, then Lightness and
Hue.

Under either operating system, you will then be able to make adjustments using a lightness slider and
three color sliders.
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Color management

You can adjust the colors of your print in similar ways under Windows and Mac OS:

●

The lightness slider simply makes the whole print lighter or darker.

●

The color sliders can be used to fade or emphasize each of the primary colors in the print. The
primary colors may be red, green and blue; or cyan, magenta and yellow; depending on the
color model used in the image.

The Reset button restores each slider to its default central position.

Printing in grayscale
You can adjust the gray balance of your print in similar ways under Windows and Mac OS:
●

In the Windows driver dialog: select the Color tab, ensure that the Advanced color
adjustments box is checked, then press the Settings button beside it.

●

In the Mac OS X 10.5 and 10.6 Print dialog: select the Color Options panel, select
Grayscale from the Mode list, then press the Adjust button.

●

In the Mac OS X 10.4 Print dialog: select the Color Options panel, then Print in
Grayscale, then the Gray balance tab.

Color management

Under either operating system, you will then be able to make adjustments using separate controls for
highlights, midtones and shadows.
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●

The lightness slider simply makes the whole print lighter or darker. This slider is available in the
same window as the other grayscale controls, except under Mac OS X 10.4, where it is available
by selecting Lightness and Hue.

●

The zone definition sliders can be used to define what you mean by highlight, midtone and
shadow.

●

The other controls for highlight, midtone and shadow can be used to adjust the gray balance of
highlights, midtones and shadows respectively.

The Reset button restores each control to its default setting.

Color management from printer drivers (PostScript)
Color management

This facility is available when printing with the PostScript driver.

HP Professional PANTONE Emulation
When you use a named PANTONE color in an image, your application will normally send to the
printer a CMYK or RGB approximation to that color. But the application does not take the printer or the
paper type into account, it merely produces a generic approximation of the PANTONE color, which
will look different on different printers and on different papers.
HP Professional PANTONE Emulation can do a much better job by taking into account the
characteristics of the printer and the paper type. The results look as similar to the original PANTONE
colors as is possible on a given printer using a given paper type. This technology is designed to
produce emulations similar to those set up manually by prepress professionals.
To use HP Professional PANTONE Emulation, all you have to do is to turn it on. In fact, it is normally on
by default.
●

In the Windows PostScript driver dialog: go to the Color tab and select HP
Professional PANTONE Emulation.

●

In the Mac OS Print dialog: go to the Color Options panel and select HP Professional
PANTONE Emulation.

You can also use the Embedded Web Server to print a swatch book showing emulations of PANTONE
colors as made by your printer, together with a measure of the color difference (ΔE) between each
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emulation and the original PANTONE spot color. So HP Professional PANTONE Emulation not only
provides the closest match that can be achieved on your printer; it also gives clear information on how
close the emulation is to the original spot color. See Printing PANTONE swatch books on page 103.

Color emulation
Your printer can emulate the color behavior of other devices: RGB devices such as monitors, and
CMYK devices such as presses and printers.
You can set color emulation in the following ways:
●

In the Windows PostScript driver dialog: select the Color tab, and Printer Managed
Colors.

●

In the Mac OS Print dialog: select the Color Options panel, then select Printer from the
Color Management list.

For a good emulation, the printer needs a specification of the colors these devices can reproduce. The
standard way of encapsulating such information is in ICC profiles. As part of the solution, we provide
the most common standards for the different devices.
The options are as follows.

CMYK color emulation
A traditional workflow defines color in the CMYK space. For best results, the colors must be adjusted to
the printer, because different printers will produce different colors from the same CMYK data. If the
image file you are printing was not created specifically for your printer, it will require some
readjustment, which can be done using one of the following options provided with your printer.

Color management
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●

None (Native): no emulation. The printer will use its default internal conversion from CMYK to
RGB, without following any color standard. This does not imply that results will be bad

●

U.S. Web Coated (SWOP) 2 uses specifications designed to produce quality separations
using U.S. inks under the following printing conditions: 300% total area of ink coverage, negative
plate, coated publication-grade stock.

●

U.S. Web Uncoated 2 uses specifications designed to produce quality separations using U.S.
inks under the following printing conditions: 260% total area of ink coverage, negative plate,
uncoated white offset stock.

●

U.S. Sheetfed Coated 2 uses specifications designed to produce quality separations using U.S.
inks under the following printing conditions: 350% total area of ink coverage, negative plate,
bright white offset stock.

●

U.S. Sheetfed Uncoated 2 uses specifications designed to produce quality separations using
U.S. inks under the following printing conditions: 260% total area of ink coverage, negative plate,
uncoated white offset stock.

●

Europe ISO Coated FOGRA27 is designed to produce quality separations for standard ISO
12647 printing under the following printing conditions: 350% total ink coverage, positive film,
coated paper.

●

Euroscale Uncoated 2 uses specifications designed to produce quality separations using
Euroscale inks under the following printing conditions: 260% total area of ink coverage, positive
plate, uncoated white offset stock.

Chapter 9 Color management

ENWW

●

Japan Web Coated (Ad) uses specifications developed by the Japan Magazine Publisher
Association for digital proofing of images in the Japanese magazine/advertising market.

●

Japan Color 2001 Coated uses the Japan Color 2001 specification for type 3 (coated) paper.
It is designed to produce quality separations using 350% total ink coverage, positive film and
coated paper.

●

Japan Color 2001 Uncoated uses the Japan Color 2001 specification for type 4 (uncoated)
paper. It is designed to produce quality separations using 310% total ink coverage, positive film
and uncoated paper.

●

Japan Color 2002 Newspaper uses the Japan Color 2002 for Newspapers specification. It
is designed to produce quality separations using 240% total ink coverage, positive film and
standard newsprint paper.

●

JMPA: Japanese standard for offset press.

●

Toyo is designed to produce quality separations for Toyo printing presses.

●

DIC is designed to produce quality separations for Dainippon Ink Company printing presses.

NOTE: These options have no effect if the application is defining its own CMYK space, known as
calibrated CMYK or CIEBasedDEFG in PostScript terminology.

RGB color emulation
●

None (Native): no emulation, for use when the color conversion is done by the application or
operating system, and therefore the data arrive at the printer already color-managed.

●

sRGB IEC61966-2.1 emulates the characteristics of the average PC monitor. This standard
space is endorsed by many hardware and software manufacturers, and is becoming the default
color space for many scanners, printers and software applications.

●

ColorMatch RGB emulates the native color space of Radius Pressview monitors. This space
provides a smaller gamut alternative to Adobe RGB (1998) for print production work.

●

Apple RGB emulates the characteristics of the average Apple monitor, and is used by a variety
of desktop publishing applications. Use this space for files that you plan to display on Apple
monitors, or for working with old desktop publishing files.

●

Adobe RGB (1998) provides a fairly large gamut of RGB colors. Use this space if you need to
do print production work with a broad range of colors.

Color management from the Embedded Web Server
Submit Job options
When you send jobs to the printer using the Embedded Web Server's Submit Job page, you have
the following color management options.
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Color management

Your printer is provided with the following color profiles:

If you leave an option set to Default, the setting saved in the job will be used. If the job contains no
setting, the front-panel setting in the printer will be used.
●

Color/Grayscale: you can choose to print in color, in shades of gray or in pure black and
white.

●

Default RGB source profile: you can choose from a selection of RGB source profiles
recognized by the printer.

●

Printer emulation: you can choose to emulate a different HP Designjet printer. Default: Off (no
printer emulation).

PostScript or PDF jobs only
●

Default CMYK source profile: you can choose from a selection of CMYK source profiles
recognized by the printer. Default: Europe ISO Coated FOGRA27.

●

Rendering intent: you can select the rendering intent.

●

Black point compensation: you can turn black point compensation on or off.

●

HP Professional PANTONE Emulation: you can turn HP Professional PANTONE Emulation
on or off.

Rendering intent
Rendering intent is one of the settings used when doing a color transformation. As you probably know,
some of the colors you want to print may not be reproducible by the printer. The rendering intent allows
you to select one of four different ways of handling these so-called out-of-gamut colors.

Color management

●

Saturation (graphics): best used for presentation graphics, charts or images made up of
bright, saturated colors.

●

Perceptual (images): best used for photographs or images in which colors blend together. It
tries to preserve the overall color appearance.

●

Relative colorimetric (proofing): best used when you want to match a particular color. This
method is mainly used for proofing. It guarantees that, if a color can be printed accurately, it will
be printed accurately. The other methods will probably provide a more pleasing range of colors
but do not guarantee that any particular color will be printed accurately. It maps the white of the
input space to the white of the paper on which you are printing.

●

Absolute colorimetric (proofing): the same as relative colorimetric, but without mapping the
white. This rendering is also used mainly for proofing, where the goal is to simulate the output of
one printer (including its white point).

Perform black point compensation
The black point compensation option controls whether to adjust for differences in black points when
converting colors between color spaces. When this option is selected, the full dynamic range of the
source space is mapped into the full dynamic range of the destination space. It can be very useful in
preserving shadows when the black point of the source space is darker than that of the destination
space. This option is allowed only when the Relative colorimetric rendering intent is selected (see
Rendering intent on page 102).
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Printing PANTONE swatch books
You can use the Embedded Web Server to print a swatch book showing emulations of PANTONE
colors as made by your printer, together with a measure of the color difference (ΔE) between each
emulation and the original PANTONE spot color.

Color management

To print a swatch book, select the Embedded Web Server's Main tab, then HP Professional
PANTONE Emulation. Select the PANTONE stock to emulate, and one or more strips of PANTONE
colors that you want to print. You can select color strips from more than one PANTONE stock. When
you have selected all the colors you want, press the Next button. The next window displays your
selection; you can press Print to print that selection, or Back to change the selection.

Color management from the front panel
You can color-calibrate the loaded paper type from the front panel by selecting the Image Quality
Maintenance menu icon

, then Calibrate color. See Color calibration on page 94.

The other color options in the front panel can all be found by selecting the Setup menu icon

, then

Printing preferences > Color options.
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NOTE: These front panel settings can all be overridden by the printer driver or Embedded Web
Server job submission settings.
●

Color/Grayscale: you can choose to print in color or in shades of gray. Default: Print in
color.

●

Select RGB source profile: you can choose from a selection of RGB source profiles recognized
by the printer. Default: sRGB (HP).

●

Emulate printer: you can choose to emulate a different HP Designjet printer. Default: Off (no
printer emulation).
TIP: If you have old HP-GL/2 or PostScript files made for a different HP Designjet printer, you
can send them to the printer and use the front panel to turn on the appropriate emulation mode.

PostScript or PDF jobs only
●

Select CMYK source profile: you can choose from a selection of CMYK source profiles
recognized by the printer. Default: Europe ISO Coated FOGRA27.

●

Select rendering intent: you can select the rendering intent. Default: Perceptual.

●

Black point compensation: you can turn black point compensation on or off. Default: On.

●

HP Professional PANTONE Emulation: you can turn HP Professional PANTONE Emulation
on or off. Default: On.

Color management
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10 Job queue management

Embedded Web Server job queue page

●

Job preview

●

Turn off the job queue

●

Select when to print a job in the queue

●

Identify a job in the queue

●

Prioritize a job in the queue

●

Delete a job from the queue

●

Reprint or copy a job in the queue

●

Job status messages

Job queue

●

ENWW

105

Embedded Web Server job queue page
You can manage your printer's job queue from the HP Utility, see Access the HP Utility on page 21, or
the printer's Embedded Web Server, see Access the Embedded Web Server on page 21.
The job queue page shows all jobs that are available in the printer job queue. It includes jobs that are
being received, parsed, rendered, printed and already printed.
The following information is displayed for each job:
●

Preview: Click the icon to see the job preview. The job preview is available once the job is
processed.

●

File name: Click the file name to see the properties of the job.

●

Status: Gives the current job status.

●

Pages: Number of pages in the job.

●

Copies: Number of copies printed.

●

Date: Date and time the printer received the job.

●

User: The user's name.

Jobs in the queue can be sorted by any of the information items (except Preview) by clicking on the title
of the corresponding column. You can perform the following operations on one or all jobs in the queue:
●

Cancel: Cancels the selected jobs. You are asked to confirm before the job is canceled. The job
remains stored in the printer, but it is not printed unless you click Reprint.

●

Hold: Holds the selected jobs until you click Continue to print.

●

Continue: All selected jobs, which are on hold, continue printing.

●

Reprint: Prints more copies of a job. Type the number of copies (default 1, maximum 99) and
click Print.

●

Move to front: Sends all selected jobs to the top of the job queue.

●

Delete: Deletes selected jobs from the job queue. You are asked to confirm before the job is
deleted.

●

Refresh: Refreshes the page, ensuring the information is updated.
NOTE: The job queue page does not automatically update.

Job preview
Job queue

The printer samples all incoming jobs and generates a JPEG file that can be served as a preview of the
job. This preview is available for all kinds of jobs supported by the printer.
TIP: Do not send a job for preview with more than 64 pages.
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Job preview is available once the job is processed. To access the preview page, click the magnifying
glass icon, which appears in the Preview column on the job queue page. The preview page shows the
following job details along with a thumbnail preview of the job:
●

File name: The file name of the job.

●

Loaded paper: The type of paper loaded in the printer.

●

Job dimensions: The dimensions of the job.

To see a larger preview of the job, click either the job thumbnail or the magnifying glass icon, which
appears on the right hand side of the printer image.
NOTE: Browsers without the Macromedia plug-in show the job image as yellow shaded. Browsers
that have the Macromedia flash plug-in version 7 and above shows an enhanced preview of the job
image inside the paper loaded in the printer.

Turn off the job queue
You can turn off the queue from the Embedded Web Server, select Setup tab > Printer settings >
Job management > Queue and select Off; or from the front panel: select the Setup menu icon
, then Job management options > Enable queue > On/Off.

Select when to print a job in the queue
NOTE: The When To Start Printing options cannot be used with PostScript jobs.
You can select at what point you want to print a file you have in the queue. From the Embedded Web
Server, select Setup tab > Printer settings > Start printing; or, from the front panel, select the
Setup menu icon

, then Job management options > When to start printing.

There are three options you can select:
●

When After Processing is selected, the printer waits until the whole page has been processed
and then it starts to print. This is the slowest setting but ensures the best print quality in large or
complex prints.

●

When Immediately is selected, the printer prints the page as it is processed. This is the quickest
setting, but the printer may stop halfway through a print to process data. This setting is not
recommended for complex images with dense color.

●

When Optimized is selected (this is the default setting), the printer calculates the best time to
begin printing the page. It is usually the best compromise between the After Processing and
Immediately settings.

Job queue

Identify a job in the queue
The best way to look at the queue is in the Embedded Web Server (Main tab > Job queue), where
you can manage the queue and get full information on every job (by clicking the name of the file).
However, you can also manage the queue from the front panel. To do so, select the Job Queue menu
icon

, then Job queue, where you can see a list of the jobs in the queue.

Each has an identifier, comprising:
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<position in queue>: <image name>
The job currently being printed has a pointing hand icon, jobs already printed have a check mark,
canceled jobs have crosses, processing jobs have a clock and jobs on hold have a warning.

Prioritize a job in the queue
To make any job in the queue the next one to be printed, select it and choose Reprint (in the
Embedded Web Server) or Move to front (in the front panel).
If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to
be printed next, and on its own on the roll, first turn nesting off and then move it to the front of the
queue as described above.

Delete a job from the queue
Under normal circumstances, there is no need to delete a job from the queue after printing it, as it is
removed from the queue as more files are sent. However, if you have sent a file in error, and want to
avoid any chance of it being reprinted, you can simply delete it, by selecting it and choosing Delete
(in the Embedded Web Server or in the front panel).
In the same way, you can delete a job that has not been printed yet.
If the job is currently being printed (Status = printing in the Embedded Web Server, or it is the first job
in the queue in the front panel), and you want both to cancel the job and to delete it, first click the
Cancel icon in the Embedded Web Server, or press the Cancel key on the front panel, and then delete
it from the queue.

Reprint or copy a job in the queue
To reprint or make extra copies of any job in the queue, select the job in the Embedded Web Server
and click the Reprint icon, then specify the number of copies you want. The job is moved to the top of
the queue. To make more than one print of a non-printed job in the queue from the front panel, select
the job and choose Copies, then specify the number of copies required and press the Select key. This
overrides any value set by your software.
NOTE: If Rotate was On when you sent the file, every copy is rotated.
You can reprint an already-printed job from the front panel. Select the Job Queue menu icon

, then

select the job from the queue, then select Reprint.

Job status messages
These are the possible job status messages, approximately in the order in which they may be seen:

Job queue
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●

Receiving: the printer is receiving the job from the computer

●

Waiting to process: the job has been received by the printer and is waiting to be rendered (for
jobs submitted through the Embedded Web Server only)

●

Processing: the printer is parsing and rendering the job

●

Rotating: the job is already rendered, but it is being rotated (autorotate is on) to save paper.

Chapter 10 Job queue management

ENWW

●

Preparing to print: the printer is performing writing system checks before printing the job

●

Waiting to print: the job is waiting for the print engine to become free to proceed with printing

●

Waiting for nest: the printer is set up with nesting on and is waiting for other jobs in order to
complete the nest and proceed with printing

●

On hold: the job was sent with the on hold for preview option and is on hold
TIP: Do not send a job for preview with more than 64 pages.
NOTE: If the printer hangs up while printing a job, and the queue facility is turned on, the
partially printed job appears in the queue as on hold when the printer is next turned on. When
you resume the job, it starts printing at the page it was interrupted.

●

On hold for paper: the job can't be printed because paper is not loaded in the printer. Load
the required paper, see Handle the paper on page 26, and click Continue to resume the job

●

On hold for accounting: the job can't be printed because the printer requires all jobs to have
an account ID: enter the account ID and then click Continue to resume the job

●

Printing

●

Drying

●

Cutting paper

●

Ejecting page

●

Canceling: the job is being canceled, but remains in the printer job queue

●

Deleting: the job is being deleted from the printer

●

Printed

●

Canceled: the job has been canceled by the printer

●

Canceled by user

●

Empty job: the job does not contain anything to print

Remove a hold

Job queue

When the printer puts a job on hold you receive an alert, see Printer alerts on page 175, which
explains why the job is on hold. Follow the instructions on the screen to remove the hold and continue
printing.
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Printer usage

11 Retrieve printer usage information
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●

Get printer accounting information

●

Check printer usage statistics

●

Check ink and paper usage for a job

Chapter 11 Retrieve printer usage information
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There are various different ways of getting accounting information from your printer.
●

View printer usage statistics for the whole lifetime of the printer, see Check printer usage statistics
on page 111.

●

View ink and paper usage for each of your recent jobs by using the HP Utility, see Check ink and
paper usage for a job on page 111. If the HP Utility is not available, see Access the HP Utility
on page 21.

●

Use a third-party application to request printer status, printer usage or job accounting data from
the printer through the Internet. The printer provides data in XML to the application whenever
requested. HP provides a Software Development Kit to facilitate the development of such
applications.

Check printer usage statistics
There are two ways to check your printer's usage statistics.
NOTE: The accuracy of the usage statistics is not guaranteed.

Printer statistics with the HP Utility
1.

Access the HP Utility, see Access the HP Utility on page 21.

2.

Under Windows, go to the Overview tab and click on the Printer usage link.
Under Mac OS, select Information > Printer Usage and click on the Lookup button.

Printer statistics with the Embedded Web Server
1.

Access the Embedded Web Server, see Access the Embedded Web Server on page 21.

2.

Go to the Main tab.

3.

Select History > Usage.

Check ink and paper usage for a job
There are two ways to check ink and paper usage for a job.
NOTE: The accuracy of the usage statistics is not guaranteed.

Ink and paper statistics with the HP Utility
1.

Access the HP Utility, see Access the HP Utility on page 21.

2.

Select Job center to view information regarding the most recent jobs.

3.

Under Windows, click on the Accounting link.
Under Mac OS, select Job Accounting and click on the Look Up button.
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Printer usage

Get printer accounting information

Printer usage

Ink and paper statistics with the Embedded Web Server
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1.

Access the Embedded Web Server, see Access the Embedded Web Server on page 21.

2.

Go to the Main tab.

3.

Select History > Accounting.
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●

Overview

●

Print a draft for revision with the correct scale

●

Print a project

●

Print a presentation

●

Print and scale from Microsoft Office

Printing examples
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Overview
The following step-by-step instructions for printing jobs that use specific software are similar to those at
the HP Knowledge Center on the Web. Consult the Knowledge Center at http://www.hp.com/go/
T7100/knowledgecenter/ or http://www.hp.com/go/T7100mono/knowledgecenter/ for the most upto-date information and for additional printing examples, including RIP scenarios.

Print a draft for revision with the correct scale
Printing examples

This section demonstrates how to print a draft for revision with the correct scale from Adobe Acrobat.

Using Adobe Acrobat
1.

In the Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to
check the size of the job.

2.

Select File > Print and ensure that Page Scaling is set to None.

NOTE: The page size will not be automatically selected according to the drawing size.
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Press the Properties button and then select the Paper/Quality tab.

4.

Choose whatever Document Size and Print Quality you want to use. If you want to define a
new custom paper size, press the Custom button.

5.

Press the Margins/Layout button and select a layout option.

If the job is 10 mm smaller in both dimensions than the page size you have chosen, select
Standard margins. See Select margins options on page 83.
If the job is the same size as the page you have chosen, but has at least 5 mm of white space
around the edges, select Clip contents by margins.
If the job is the same size as the page you have chosen, and does not have 5 mm of white space
around the edges, select Oversize. The final output will be larger than the page you selected, but
you can cut the print to the correct size without losing any of it.
ENWW

Print a draft for revision with the correct scale
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3.

Printing examples

6.

Select the Features tab, and then Autorotate.

7.

Click OK, and check that the print preview in the Print dialog box seems correct.

Print a project
This section demonstrates how to print a project from Autodesk Design Review, AutoCAD and the
printer's Embedded Web Server.

Using Autodesk Design Review
Autodesk Design Review offers the Use HP Instant Printing option. This needs to be enabled once,
after which it is taken as the default printing option until it is disabled.
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Enabling HP Instant Printing from Autodesk Design Review
Start Autodesk Design Review and select File > Print.

Printing examples

1.

Alternatively, click the Print icon on the toolbar.

ENWW

2.

In the Print dialog box, check the Use HP Instant Printing box. You can select your printer
and paper size here, or in the next window.

3.

Ensure that the printer and paper size are correct, then click OK to start printing.

Print a project
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Enabling HP Instant Printing from the Batch Print Wizard

Printing examples
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1.

Make sure you have installed the Batch Print Wizard. Start Autodesk Design Review and select
File > Batch Print Wizard.

2.

In the Welcome box, click Next.

3.

Select the DWF files to print, then click Next.
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Use the Shift key if you want to select multiple files to configure. Then click Print Setup, and the
printing configuration will be applied to all the files you have selected..

5.

In the Print dialog box, check the Use HP Instant Printing box. You can select your printer
and paper size here, or in the next window.

6.

Ensure that the printer and paper size are correct, then click OK. The paper size is automatically
preselected.

Print a project
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4.
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7.

Back in the Choose print settings box, click Next.

8.

Save or start the batch print job.

Using HP Instant Printing
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●

Make sure Use HP Instant Printing has been selected. To print, click the Print icon in the
toolbar or select File > Print. Choose your preferred printing settings and click OK.

●

Alternatively, Use HP Instant Printing can be launched directly from its own toolbar icon. In this
case, it starts immediately, using the settings you defined previously.
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Using AutoCAD
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The AutoCAD window can show a model or layout. Normally a layout is printed rather than the
model.

2.

Click the Plot icon at the top of the window.

3.

The Plot window opens.

Printing examples

1.

Print a project
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4.

You can see further options by pressing the circular button in the lower right corner of the window.

Printing examples

NOTE: The Quality option here does not refer to the final print quality but to the quality of
AutoCAD viewport objects that are sent for printing.
5.
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Press the Properties button.
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Select the Device and Document Settings tab, and press the Custom Properties button.

7.

In the Paper/Quality tab, check the Show preview before printing box, and select the
paper type that you intend to use.

Printing examples

6.

NOTE: If you select neither the paper source nor the paper type, the printer will not print on any
protected roll (see Roll protection on page 91).
8.

ENWW

Select the print quality (your own choice between speed and quality of printing).

Print a project
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9.

Press the Margins/Layout button and select a layout option.

Printing examples

If the job is 10 mm smaller in both dimensions than the page size you have chosen, select
Standard margins. See Select margins options on page 83.
If the job is the same size as the page you have chosen, but has at least 5 mm of white space
around the edges, select Clip contents by margins.
If the job is the same size as the page you have chosen, and does not have 5 mm of white space
around the edges, select Oversize. The final output will be larger than the page you selected, but
you can cut the print to the correct size without losing any of it.
10. Select the Features tab, then select the Autorotate option and the Crop lines option.
Autorotation can help to avoid wasting paper, and the crop lines will show you where to cut the
paper after printing.
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11. Press the OK button and save your configuration changes to a PC3 file.

12. When you have pressed the OK button in the Plot window, the printer will construct a print
preview.

Using the Embedded Web Server to submit files
From the HP Utility or the Embedded Web Server, select Job Center > Submit Job. With some Web
browsers, you will see the window below; with other Web browsers, the mechanism for adding files is
slightly different.
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Print a project
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Press the Add files button (or Choose File, Add another file) to choose the files from your
computer that you want to print. The files must be in one of the following formats:
●

HP-GL/2

●

RTL

●

CALS/G4

●

PDF (with the PostScript upgrade only)

●

PostScript (with the PostScript upgrade only)

●

TIFF (with the PostScript upgrade only)

●

JPEG (with the PostScript upgrade only)

NOTE: When you print to a file, the file should be in one of the above formats, but its name may
have an extension such as .plt or .prn.
If the files are not in one of these formats, they will not be printed successfully.
If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and
number of copies), you can just press the Print button and the project will be sent to the printer.
If you need to specify printing settings, go to the Job settings section and select the options you need.
Each option has explanatory text on the right, so that you can understand the behavior of each setting.
Remember that, if you leave the setting as Default, the setting saved in the job will be used. If the job
contains no setting, the setting in the printer will be used.

Using printer emulation
Printer emulation can be requested by selecting Advanced settings > Color > Color
management > Printer emulation.
You can select Off (no printer emulation) or the name of the printer model that you want to emulate.
This setting will apply to jobs that do not contain any printer emulation setting saved in the job.
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Using clip contents by margins
You can select this margins option from Advanced settings > Paper > Layout/Margins > Print
with margins > Layout > Clip contents by margins.
Use this option when the contents to be printed have white borders and a size equal to that of the
paper you have selected. The printer will use the white border for its margins and you will get a page
of size equal to that which is selected in the driver.

Printing examples

Print a presentation
This section demonstrates how to print a presentation from AutoCAD and from Photoshop.

Using AutoCAD

ENWW

1.

Open the AutoCAD file and select a layout.

2.

Click the Plot icon at the top of the window.

3.

Ensure that the correct printer is selected, then press the Properties button.

Print a presentation

127

Printing examples

4.

Select the Device and Document Settings tab, and press the Custom Properties button.

5.

In the Paper/Quality tab, check the Show preview before printing box, and select the
paper type that you intend to use.

NOTE: If you select neither the paper source nor the paper type, the printer will not print on any
protected roll (see Roll protection on page 91).
6.
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Select the print quality (your own choice between speed and quality of printing).
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Press the Margins/Layout button and select a layout option.

Printing examples

7.

If the job is 10 mm smaller in both dimensions than the page size you have chosen, select
Standard margins. See Select margins options on page 83.
If the job is the same size as the page you have chosen, but has at least 5 mm of white space
around the edges, select Clip contents by margins.
If the job is the same size as the page you have chosen, and does not have 5 mm of white space
around the edges, select Oversize. The final output will be larger than the page you selected, but
you can cut the print to the correct size without losing any of it.
8.

ENWW

Select the Features tab, then select the Autorotate option and the Crop lines option.
Autorotation can help to avoid wasting paper, and the crop lines will show you where to cut the
paper after printing.

Print a presentation
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9.

Press the OK button and save your configuration changes to a PC3 file.

Printing examples

10. When you have pressed the OK button in the Plot window, the printer will construct a print
preview.

Using Adobe Photoshop
1.
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Select File > Page Setup > Printer, select your printer and click OK.
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2.

Choose from the available paper sizes.

Printing examples

If you do not find the paper size that you intend to use, select Printer > Properties > Paper/
Quality > Custom > Paper Size. Enter the width, the length and the name of your custom
paper size. Press the Save and OK buttons.

3.

ENWW

Select File > Print with Preview.

Print a presentation
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Select Print > Properties. In the Document Properties window, select Paper Source, Paper
Type and Print Quality.

5.

In the Color tab, the default color management option is Printer Managed Colors, and this is
the correct option because you have already selected Let Printer Determine Colors in
Photoshop.

Printing examples

4.

Print and scale from Microsoft Office
This section demonstrates how to print and scale from Microsoft Office.
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1.

Select the Office Button, then Print, and select the name of your printer.

2.

Select Properties > Features > Print document on to scale the document to a particular
size.

Print and scale from Microsoft Office

Printing examples

Using PowerPoint
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3.

Select the Paper/Quality tab, then select Paper Source and Paper Type.

4.

Select Margins/Layout, then select Clip contents by margins to keep the size.

Using Project
1.
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Select File > Page Setup > Print.
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Select your printer's name, then Close.

3.

Select Page Setup, and choose the Paper Size you want.

4.

Select Options to go to the printer driver. The default options in the Paper/Quality tab are
probably suitable: Paper source: Printer auto select and Paper Type: Any.

Print and scale from Microsoft Office

Printing examples

2.
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5.

Select Features > Print document on to scale the document to a particular size. Alternatively,
you can scale the document in Project.

Printing examples

Using Excel
1.
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Select the Office Button, then Print. Select your printer's name, then click Close.
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Select the Page Layout tab, then Size, and choose the paper size you want.

3.

Select the Office Button, then Print > Properties to go to the printer driver. In the Paper/
Quality tab, select Paper source, Paper Type and Print Quality.

Printing examples

2.
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Print and scale from Microsoft Office
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4.

Select Features > Print document on to scale the document to a particular size. Alternatively,
you can scale the document in Excel.

Printing examples
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●

Clean the platen

●

Clean the paper-advance sensor window

●

Lubricate the printhead carriage

●

Maintain the ink cartridges

●

Perform preventive maintenance

●

Move or store the printer

●

Update the printer firmware

●

Secure disk erase

Maintain the printer

13 Maintain the printer

139

Clean the exterior of the printer
Use a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid soap to
clean the outside of the printer and all other parts of the printer that you regularly touch as part of
normal operation (for example, ink cartridge drawer handles).
WARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged
before you clean it. Do not let water get inside the printer.
CAUTION: Do not use abrasive cleaners on the printer.

Clean the platen
You should clean your printer's platen every few months, or when necessary.
NOTE: If you print on wide paper after having printed on narrower paper, you might find that the left
side of the platen has become dirty. If this contaminated section of the platen is not cleaned, it might
leave marks on the back of the paper.

Maintain the printer

WARNING! Be careful not to damage the paper-advance sensor when cleaning the platen. The
sensor is the very small rectangular window found near the sixth platen roller from the right. See Clean
the paper-advance sensor window on page 142.
Follow these instructions to clean the platen.
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1.

Unload all paper from the printer. See Unload a roll from the printer on page 34.

2.

Open the printer window.

3.

With a dry brush, remove ink deposits from the cutter groove.
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4.

With the same dry brush, remove ink deposits from the platen surface.

5.

Use a clean, absorbent lint-free cloth that has been slightly dampened with isopropyl alcohol to
wipe loosened ink deposits from the platen.

CAUTION: Do not use commercial cleaners or abrasive cleaners. Do not wet the platen directly,
because you will leave too much moisture behind.

ENWW

6.

Use the damp cloth to clean the cutter ramp.

7.

Use a dry cloth to clean the exposed part of the wheels. Ideally, you should clean the entire
circumference of these wheels.

Clean the platen
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NOTE: Isopropyl alcohol is not provided in the Maintenance Kit.

Clean the paper-advance sensor window
The paper advance sensor is the very small rectangular window (less than 1 cm² in size and shown in
the following graphic) near the sixth platen roller from the right.
HP recommends that you clean the paper-advance sensor window every 10 months, and whenever you
experience print-quality issues.
1.

Unload the paper using the front-panel procedure. See Unload a roll from the printer on page 34.

2.

Wipe the sensor window with cotton swabs, slightly dampened with isopropyl alcohol, to remove
ink or dust. If the sensor window is heavily coated with ink, you may need to apply some pressure
while wiping, helping the cotton to absorb the ink.
NOTE: Do not dampen the cotton swabs with water, because it does not evaporate quickly
enough, and may pass through the window to the sensor itself.

Maintain the printer

3.

Under ambient light, a clean sensor window shows a violet-colored reflection that extends
uniformly across the entire surface. To see this reflection, look closely at the sensor window and
slightly change your viewing angle.

4.

Continue cleaning with fresh swabs until the cotton stays clean and the sensor window looks
clean.

5.

Wait 3–4 minutes before reloading the paper to ensure that the alcohol has evaporated
completely.

Lubricate the printhead carriage
The printhead carriage occasionally (about once a year) needs lubrication so that it continues to slide
easily along the slider rod.
1.

To gain access to the carriage, go to the front panel and select the

icon, and then select

Replace printheads. The carriage slides to the middle section of the printer.
CAUTION: If the carriage remains in the central part of the printer for more than 7 minutes, it
attempts to return to its home position on the right.
2.
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Take the bottle of oil from the Maintenance Kit that can be ordered for your printer.
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Open the printer window and apply a few drops of the oil to the pads on either side of the
carriage.

4.

Apply a few drops of oil directly to the slider rod on either side of the carriage.

5.

Close the printer window.

Maintain the ink cartridges
During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to
maintain the best print quality, you should replace a cartridge when it has reached its expiration date,
which is the manufacturing date marked on the cartridge plus 30 months.

Perform preventive maintenance
During the life of your printer, components that are used constantly can wear out.
To avoid having these components degrade to the point that the printer breaks down, the printer keeps
track of the number of cycles that the printer carriage makes across the axis of the printer, and also
monitors the total quantity of ink used.
The printer uses these numbers to track the need for preventive maintenance, and displays one of the
following messages on the front panel:
●

Maintenance #1 required

●

Maintenance #2 required

These messages mean that some components are nearing the end of their lives. You can continue
printing for quite some time, depending on your use of the printer. However, HP strongly recommends
that you contact your customer service representative and arrange for a preventive maintenance visit.
The service engineer can then replace the worn parts onsite, which will prolong the life of the printer.
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3.

The benefits of arranging a service engineer's visit when these messages appear on the front panel are
two-fold:
●

The printer components can be replaced at a time that is convenient for you, and so will not
disturb your daily workflow.

●

When the service engineer performs a preventive maintenance visit, replaces several parts at
once. This eliminates the need for repeat visits.

Move or store the printer
If you need to move your printer or store it for an extended period of time, prepare it correctly to avoid
possible damage.

Maintain the printer

1.

Do not remove the ink cartridges, printheads, or printhead cleaners.

2.

Make sure that no paper is loaded.

3.

Make sure that the printhead carriage is located in the service station (at the right end of the
printer).

4.

Make sure that the Ready message appears on the front panel.

5.

Turn off the power by using the Power button on the front panel.

6.

Also switch off the power switch at the rear of the printer.

7.

Disconnect the power cable and any cables that connect the printer to a network, a computer, or
a scanner.

NOTE: If the printer or ink cartridges are moved from a cold location to a warm and humid location,
water from the atmosphere can condensate on the printer parts and cartridges and can result in ink
leaks and printer errors. In this case, HP recommends that you wait at least 3 hours before turning on
the printer or installing the ink cartridges, to allow the condensate to evaporate.
TIP: Because preparing and purging the printheads uses both time and ink, you are strongly
recommended to leave the printer always on or in sleep mode, whenever possible, to maintain the
health of the printheads. In both cases, the printer wakes up from time to time to maintain the
printheads. Thus you can avoid going through lengthy preparation processes before using your printer.

Update the printer firmware
The printer's various functions are controlled by software that resides in the printer, also known as
firmware.
From time to time, firmware updates from Hewlett-Packard become available. These updates increase
the printer's functionality and enhance its features.
Firmware updates can be downloaded from the Internet and installed in your printer in the following
ways. Use the method that you find most convenient.
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●

In Windows, open the HP Utility, select your printer, click the Support tab, and then select
Firmware Update.

●

In Mac OS, open the HP Utility, select Support and then select Firmware Update.

●

Through the printer's Embedded Web Server, click the Setup tab and then select Firmware
update.
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Follow the onscreen instructions to download the firmware file and store it on your hard disk. Then
select the downloaded file and click Update.
The firmware includes a set of the most commonly used paper presets. Extra paper presets can be
downloaded separately; see Download paper presets on page 37.
If you experience very slow progress while uploading the firmware file to the printer, the reason could
be that you are using a proxy server. In that case, try bypassing the proxy server and accessing the
Embedded Web Server directly.
●

In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN
Settings, and select the Bypass proxy server for local addresses check box.
Alternatively, for more precise control, click the Advanced button and add the printer's IP
address to the list of exceptions, for which the proxy server is not used.

●

In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies:
Change Settings button. Add the printer's IP address or its domain name to the list of
exceptions, for which the proxy server is not used.

The printer's hard disk is used as a temporary storage area for print jobs. The Secure Disk Erase facility
can completely erase your information from the hard disk to protect it from unauthorized access. You
can choose to erase particular files, or the whole hard disk.
Secure Disk Erase provides three different levels of security:
●

Non-Secure Fast Erase: all pointers to the information are erased. The information itself
remains on the hard disk until the disk space it occupies is needed for other purposes, and it is
then overwritten. While it remains on the disk, it is difficult for most people to access, but may be
accessed using software designed for the purpose. This is the normal method in which files are
erased on most computer systems; it is the fastest method but the least secure.

●

Secure Fast Erase: all pointers to the information are erased, and the information itself is also
overwritten with a fixed character pattern. This method is slower than Non-Secure Fast Erase, but
more secure. It may still be possible to access fragments of the erased information by using special
tools to detect residual magnetic traces.

●

Secure Sanitizing Erase: all pointers to the information are erased, and the information itself is
repetitively overwritten using an algorithm designed to eliminate any residual traces. This is the
slowest method, but the most secure. Secure Sanitizing Erase meets the US Department of Defense
5220-22.m requirements for clearing and sanitization of disk media. This is the default security
level when using Secure Disk Erase.

Secure Disk Erase is one of the facilities provided by Web JetAdmin, which is HP's free Web-based
print management software. See http://www.hp.com/go/webjetadmin/.
If you have difficulty in using Secure Disk Erase from Web JetAdmin, please contact HP Support. See
HP Customer Care on page 180.
NOTE: If you choose to erase the whole hard disk, you may be asked to restart the printer several
times during the process, which will take about 6 hours with Secure Disk Erase or 24 hours with Secure
Sanitizing Erase.
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Order accessories
The following accessories can be ordered for your printer.
Name

Product number

HP Designjet T7100 Roll Upgrade

CQ743A

HP Designjet T7100 Stacker 220 V

CQ742A

HP Designjet T7100 Stacker 110 V

CQ742B

HP Designjet HD Scanner

CQ654A

HP Designjet External Hard Disk

CN501A

HP Jetdirect 635n IPv6/IPsec Print Server

J7961A

HP Designjet PostScript/PDF Upgrade Kit

CQ745A

Serif Poster Designer for HP

CN088A

SCP Reprocontrol for HP (1 printer)

CN454A

SCP Reprocontrol for HP (2 printers)

CN455A

HP Designjet Z6100/Z6200 User Maintenance Kit

Q6715A

Accessories

The following software can be downloaded for your printer.
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Name

Download from

HP Instant Printing Pro

http://www.hp.com/go/hpinstantprintingutilitypro/

Serif PosterPro

http://www.hp.com/go/PosterDesignerPro/
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●

General advice

●

Troubleshooting tools

●

Lines are too thick, too thin or missing

●

Lines appear stepped or jagged

●

Lines print double or in the wrong colors

●

Lines are discontinuous

●

Lines are blurred

●

Line lengths are inaccurate

●

The whole image is blurry or grainy

●

The paper is not flat

●

The print is scuffed or scratched

●

Ink marks on the paper

●

Black ink comes off when you touch the print

●

Vertical lines of different colors

●

White spots on the print

●

Colors are inaccurate

●

The output is completely blank

●

The output contains only a partial print

●

The image is clipped

●

The image is in one portion of the printing area

●

The image is unexpectedly rotated

●

The print is a mirror image of the original

●

The print is distorted or unintelligible

●

One image overlays another on the same print

●

Pen settings seem to have no effect

●

The image has a wood-grain appearance (aeroworms)

Troubleshoot images
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General advice
Use the following approach when you have any print-quality problem:
●

To achieve the best performance from your printer, use only genuine HP supplies and accessories,
whose reliability and performance have been thoroughly tested to give trouble-free performance
and best-quality prints. For details of recommended papers, see Order paper on page 39.

●

Make sure that the paper type that you select on the front panel is the same as the paper type that
is loaded in the printer. Make sure that the paper type has been calibrated. Also make sure that
the paper type that you select in your software is the same as the paper type that you loaded in
the printer.
CAUTION: If you have the wrong paper type selected, you might experience poor print quality
and incorrect colors, and damage to the printheads might occur.

●

Make sure that you are using the most appropriate print-quality settings for your purposes. See
Select print quality on page 79. You are likely to see lower print quality if you have moved the
print-quality slider to the Fast end of the scale, or set the custom quality level to Fast.

●

Make sure that your environmental conditions (temperature, humidity) are in the recommended
range. See Environmental specifications on page 203.

●

Make sure that your ink cartridges and printheads have not passed their expiration dates. See
Maintain the ink cartridges on page 143.

●

Avoid touching the paper while printing is in progress.

Troubleshooting tools
To access the troubleshooting tools in the Embedded Web Server, select the Support tab. The first two
tools can also be accessed from the front panel's Image quality maintenance menu.

Troubleshoot images

Optimize print quality
This option ensures that printer and supplies are adjusted to deliver optimum print quality. Click Next
to execute all calibration and recovery routines automatically. The whole process consumes 80 cm of
paper and may take up to 20 minutes.
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NOTE: This option can also be selected from the front panel. From the main menu, select

, then

Optimize print quality.

Optimization suggested actions
This option suggests a series of recommended actions to improve print quality, based on the results of
internal checks. These actions may include reseating a printhead, changing paper to run a specific
calibration, cleaning some printer component, etc. Execute them in the proposed order.
TIP: Use this option if you want to save time by acting directly on the causes of your problem, or if
your problem persists after the automatic Optimize print quality process.
NOTE: This option can also be selected from the front panel. From the main menu, select

, then

Optimization suggested actions.

Most-common issues resolution
This option is designed to help you resolve some of the most common print-quality issues that users
encounter in large-format printing:
●

Dark or light horizontal lines across the image (banding)

●

Graininess

●

Poor line quality

●

Inaccurate colors

In the first window, select the print-quality issue that you are experiencing and click Next.
A list of suggestions for corrective action appears along with help to guide you through each action.
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1.

Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View information key .

2.

Check that you are using appropriate print-quality settings for your purposes (see Print options
on page 77). Select the custom print-quality options in the driver dialog, and try turning on the
Maximum detail option (if available). You may wish to reprint your job at this point in case the
problem has been solved.

3.

If the resolution of your image is greater than the printing resolution, you may notice a loss of line
quality. If you are using the HP-GL/2 and HP RTL driver for Windows, you can find the Max.
Application Resolution option in the driver dialog's Advanced tab, under Document

Lines are too thick, too thin or missing
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Lines are too thick, too thin or missing

Options > Printer Features. If you change this option, you may wish to reprint your job at this
point in case the problem has been solved.
4.

If lines are too thin or missing, print the Image Diagnostics Print. See The Image Diagnostics Print
on page 61.

5.

If the problem remains, go to the front panel and select the Ink menu icon

, then Printhead

information to see the printhead alignment status. If the status is PENDING, you should align the
printheads. See Align the printheads on page 59. After alignment, you may wish to reprint your
job in case the problem has been solved.
6.

Go to the front panel and press the View information key

to see the paper advance calibration

status. If the status is DEFAULT or RECOMMENDED, you should perform paper advance
calibration: see Perform paper advance calibration on page 35.
If the problem persists despite all the above actions, contact your customer service representative for
further support.

Lines appear stepped or jagged
If lines in your image appear stepped or jagged when printed:

1.

The problem may be inherent in the image. Try to improve the image with the application you are
using to edit it.

2.

Check that you are using appropriate print-quality settings. See Print options on page 77.

3.

Select the custom print-quality options in the driver dialog, and turn on the Maximum detail
option (if available).

Lines print double or in the wrong colors
This problem can have various visible symptoms:
●

Colored lines are printed double, in different colors.

Troubleshoot images
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●

The borders of colored blocks are wrongly colored.

To correct this kind of problem:
1.

Reseat the printheads by removing them and then reinserting them. See Remove a printhead
on page 51 and Insert a printhead on page 54.

2.

Align the printheads. See Align the printheads on page 59.

Lines are discontinuous
If your lines are broken in the following way:

1.

Check that you are using appropriate print-quality settings. See Print options on page 77.

2.

Reseat the printheads by removing them and then reinserting them. See Remove a printhead
on page 51 and Insert a printhead on page 54.

3.

Align the printheads. See Align the printheads on page 59.

Troubleshoot images

Lines are blurred
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Lines are discontinuous
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Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy. Try the following:
1.

Check that your environmental conditions (temperature, humidity) are suitable for high-quality
printing. See Environmental specifications on page 203.

2.

Check that the paper type selected in the front panel is the same as the paper type you are using.
To check on the front panel, use the View information key .

3.

Try changing to a heavier paper type, such as HP Heavyweight Coated Paper or HP Super
Heavyweight Plus Matte Paper.

4.

Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain
Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

5.

If you are using glossy paper, try changing to a different type of glossy paper.

6.

Align the printheads. See Align the printheads on page 59.

Line lengths are inaccurate
If you have measured your printed lines and find that the lengths are not sufficiently accurate for your
purposes, you can try to improve line length accuracy in the following ways.
1.

Print on HP Matte Film, for which your printer's line length accuracy is specified. See Functional
specifications on page 201.
Polyester film is about ten times more dimensionally stable than paper. However, using film that is
thinner or thicker than HP Matte Film will reduce line length accuracy.

2.

Set the Print Quality slider to Quality.

3.

Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).

4.

Load the roll of film and let it rest for five minutes before printing.

5.

If you are still not satisfied, try recalibrating the paper advance. See Perform paper advance
calibration on page 35.

Troubleshoot images
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The whole image is blurry or grainy

1.

Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View information key .

2.

Check that you are printing on the correct side of the paper.

3.

Check that you are using appropriate print-quality settings (see Print options on page 77). In some
cases, you can overcome a print-quality problem merely by selecting a higher print-quality level.
For instance, if you have set the Print Quality slider to Speed, try setting it to Quality. If you
change the print-quality settings, you may wish to reprint your job at this point in case the problem
has been solved.

4.

Go to the front panel and select the Ink menu icon

, then Printhead information to see the

printhead alignment status. If the status is PENDING, you should align the printheads. See Align
the printheads on page 59. After alignment, you may wish to reprint your job in case the problem
has been solved.
5.

Go to the front panel and press the View information key

to see the paper advance calibration

status. If the status is DEFAULT or RECOMMENDED, you should perform paper advance
calibration: see Perform paper advance calibration on page 35.
If the problem persists despite all the above actions, contact your customer service representative for
further support.

If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely
to see defects in the printed image, such as vertical stripes. This can happen when you use thin paper
that becomes saturated with ink.
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The whole image is blurry or grainy
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The paper is not flat

1.

Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View information key .

2.

Try changing to a thicker paper type, such as HP Heavyweight Coated Paper or HP Super
Heavyweight Plus Matte Paper.

3.

Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain
Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

The print is scuffed or scratched
The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other
object. This is particularly noticeable on coated paper.
Glossy paper may be extremely sensitive to the basket or to anything else that it contacts soon after
printing, depending on the amount of ink used and the environmental conditions at the time of printing.
To reduce the risk of scuffs and scratches:
●

Handle prints carefully.

●

Avoid stacking prints on top of each other.

●

Catch your prints as they are cut from the roll and do not let them fall into the basket. Alternatively,
leave a sheet of paper in the basket so that freshly printed sheets do not make direct contact with
the basket.

Troubleshoot images

Ink marks on the paper
If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the
printheads move over the paper, the printheads may come into contact with the paper and smear the
printed image. This problem is normally seen only on cut sheets of paper (not on roll paper).
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Whenever you notice this problem, cancel the printing job immediately. Press the Cancel key and also
cancel the job from your computer application. Soaked paper can damage the printheads.
Try the following suggestions to avoid this problem:
1.

Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View information key .

2.

Use a recommended paper type (see Order paper on page 39) and the correct print settings.

3.

Try changing to a thicker paper type, such as HP Heavyweight Coated Paper and HP Super
Heavyweight Plus Matte Paper.

4.

Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain
Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

5.

Try to increase the margins by relocating the image to the center of the page using your software
application.

Black ink comes off when you touch the print
This problem may be caused by printing with matte black ink on glossy paper. The printer will not use
matte black ink if it knows that the paper will not retain it. To be sure of avoiding matte black ink, you
can select Photo Glossy Paper as the paper type (in the Photo Paper category).

Vertical lines of different colors

ENWW

1.

Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight
Coated Paper and HP Super Heavyweight Paper. See Order paper on page 39.

2.

Try using higher print-quality settings (see Print options on page 77). For instance, if you have set
the Print Quality slider to Speed, try setting it to Quality.

Black ink comes off when you touch the print
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If your print has vertical bands of different colors along it:

White spots on the print
You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating
material. To avoid this problem:
1.

Try cleaning the paper manually with a brush before printing, to remove any loose fibers or
particles.

2.

Always keep the cover of your printer closed.

3.

Protect your paper rolls by storing them in bags or boxes.

Colors are inaccurate

If the colors of your print do not match your expectations, try the following remedies:

Troubleshoot images

1.

Check that the paper type you have loaded corresponds to the paper type that you selected on the
front panel and in your software. At the same time, check the color-calibration status. If the status
is RECOMMENDED or OBSOLETE, you should perform color calibration. See Color calibration
on page 94. If you have made any changes, reprint your job if the problem has been solved.

2.

Check that you are printing on the correct side of the paper.

3.

Make sure that you are using the appropriate print-quality settings. See Select print quality
on page 79. If you have selected the EconoMode or Speed options, you might not get accurate
colors. If you change the print-quality settings, reprint your job if the problem has been solved.

4.

If you are using Application Color Management, make sure that the color profile that you are
using corresponds to the selected paper type and print-quality settings. If you have doubts about
which color settings to use, see Color management on page 93.

5.

If the problem consists of color differences between your print and your monitor, follow the
instructions in the “How to calibrate your monitor” section of the HP Color Center. Reprint your job
if the problem has been solved.

6.

Print the Image Diagnostics Print. See The Image Diagnostics Print on page 61.

If the problem persists, contact your customer service representative for further support. See Get help
on page 177.

PANTONE* colors are inaccurate
See HP Professional PANTONE Emulation on page 99.
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Colors between different HP Designjets do not match
If you print an image on two different printer models (for instance, on an HP Designjet T7100 printer
series and an HP Designjet 4500 printer series), the colors of the two prints might not match well.
Matching two printing devices that use different ink chemistry, paper chemistry, and printheads is
unlikely to be completely successful. Use the information provided here is to attempt to make one printer
match another.

Print with PostScript drivers
The situation describes printing with the PostScript driver installed for that printer. In this example, we
are using an HP Designjet T7100 printer series and an HP Designjet 4500 printer series.
1.

Check that both printers have the most recent firmware version. See Update the printer firmware
on page 144.

2.

Check that you have the most recent printer driver for both printers. Download the latest versions
for any HP printer from http://www.hp.com/go/designjet.

3.

Make sure that Color Calibration is turned on. On the front panel of the HP Designjet T7100,
select the

icon, and then select Image quality maintenance > Enable color

calibration > On.
4.

Load the printers with the same type of paper.

5.

Check that the Paper Type setting on the front panel corresponds to the paper that you have
loaded.

6.

Use your normal settings to print your image on the HP Designjet 4500.

7.

Now prepare to print the same image on the HP Designjet T7100.

8.

In the PostScript driver for the HP Designjet T7100, go to the Color Management section and set
the CMYK input profile to the same HP Designjet 4500 color space that you selected in the
software (the emulation color space).

9.

Print the image on the HP Designjet T7100.

Print with HP-GL/2 drivers
The situation describes printing with the HP-GL/2 driver installed for that printer.
1.

Check that both printers have the most recent firmware version. See Update the printer firmware
on page 144.

2.

Check that you have the most recent printer drivers for both printers. You can download the latest
versions for any HP printer from http://www.hp.com/go/designjet.

3.

Make sure that Color Calibration is turned on. On the front panel of the HP Designjet T7100
printer series, select the

icon, then Image quality maintenance > Enable color

calibration > On.
ENWW

Colors are inaccurate
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In your software, set the color space of the image to emulate the HP Designjet 4500 and the
specific paper type that you used in that printer. The data sent to the driver must be already
converted to this emulation color space, which is a CMYK color space. See the online help for the
software program to find information about how to do this. In this way, the T7100 will emulate the
colors that the 4500 can produce when printing on that paper type.

4.

Load the printers with the same type of paper.

5.

Check that the Paper Type setting on the front panel corresponds to the paper you have loaded.

6.

In the HP-GL/2 driver for the HP Designjet T7100, click the Color tab, and select Printer
Emulation from the list of color management options. Then select the HP Designjet 4500 from
the list of emulated printers.

7.

In the HP-GL/2 driver for the HP Designjet 4500, click the Options tab, and then select Manual
Color > Color Control > Match Screen. Also click the Paper Size tab, and then select
Paper Type.

Print the same HP-GL/2 file
The situation describes how to produce an HP-GL/2 file (also known as a PLT file) with the HP-GL/2
driver installed for one printer that you intend to send to another printer.
1.

Check that both printers have the most recent firmware version. See Update the printer firmware
on page 144.

2.

Make sure that Color Calibration is turned on. At the front panel of the HP Designjet T7100, select
the

icon, then Image quality maintenance > Enable color calibration > On.

3.

Load the printers with the same type of paper.

4.

Check that the Paper Type setting on the front panel corresponds to the paper you have loaded.

5.

If you have an HP-GL/2 file for an HP Designjet 4500 and you want to print it on an HP Designjet
T7100, use the Embedded Web Server or the front panel.
●

Through the Embedded Web Server: leave the color options set to Default.

●

On the front panel: select the

icon, and then select Setup > Printing preferences >

Color options > Emulate printer > HP Designjet 4500 Series.
For other HP Designjet printers, set both printers to match the screen colors (sRGB, if that is
available), as when printing with separate HP-GL/2 drivers.

The output is completely blank
If the front-panel graphic language setting is Automatic (the default), try the other settings:
PostScript for a PostScript file, HP-GL/2 for an HP-GL/2 file, and so on. Then send the file again.
When you have finished this particular print, remember to reset the graphic language to Automatic.

Troubleshoot images

The output contains only a partial print
●

If you pressed Cancel before the printer received all the data, you ended the data transmission
and will have to print the page again.

●

The I/O timeout setting might be too short. This setting determines how long the printer waits for
the computer to send more data, before deciding that the job is finished. On the front panel,
increase the I/O timeout setting to a longer period and then send the print again by selecting
the
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●

A communications problem between your computer and the printer might exist. Check your USB or
network cable.

●

Check that your software settings are correct for your current page size (for example, long-axis
prints).

●

If you are using network software, make sure that it has not timed out.

The image is clipped
Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and
the printable area as described by your software. You can often identify this kind of problem before
printing by previewing your print. See Preview a print on page 85.
●

Check the actual printable area for the paper size that you have loaded.
printable area = paper size – margins

●

Check what your software understands to be the printable area (which it might cite as "printing
area" or "imageable area"). For example, some software programs assume standard printable
areas that are larger than those used in this printer.

●

If you have defined a custom page size that has very narrow margins, the printer might impose its
own minimal margins and clip your image slightly. You might want to use a larger paper size. See
Select margins options on page 83.

●

If your image contains its own margins, you might be able to print it successfully by using the Clip
contents by margins option. See Select margins options on page 83.

●

If you are trying to print a very long image on a roll, make sure that your software can print an
image of that size.

●

You might have asked to rotate the page to landscape orientation on a paper size that is not
sufficiently wide.

●

If necessary, reduce the size of the image or document in your software, so that it fits between the
margins

●

If you are using an HP-GL/2 driver, you can reduce the resolution so that the whole image
requires fewer than 32,768 pixels. The Windows driver includes an option called 16-bit App.
Compatibility, which reduces the resolution automatically. The option is on the Advanced tab,
under Document Options > Printer Features.

●

Save the file in another format, such as TIFF or EPS, and open it in another program.

●

Use a RIP to print the file.

The image is in one portion of the printing area
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●

In the software, have you selected a page size that is too small?

●

Does your software read the image as being in one portion of the page?

The image is clipped
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Other explanations exist for a clipped images. Some programs, such as Adobe Photoshop, Adobe
Illustrator, and CorelDRAW, use an internal 16-bit coordinate system which means that they cannot
handle an image of more than 32,768 pixels. If you try to print a larger image, the bottom of the
image will be clipped. To print the entire image, try these suggestions:

The image is unexpectedly rotated
On the front panel, select the

icon, and then select Setup > Printing preferences > Paper

options > Rotate. Check that the setting is what you wanted.
For non-PostScript files: if Nesting is On, pages are sometimes automatically rotated to save paper.
See Nest jobs to save paper on page 89.

The print is a mirror image of the original
On the front panel, select the

icon, and then select Setup > Printing preferences > Paper

options > Enable mirror image. Check that the setting is what you wanted.

The print is distorted or unintelligible
●

The interface cable that is connecting your printer to your network (or to your computer) might be
faulty. Try another cable.

●

On the front panel, select the

icon, and then select Setup > Printing preferences >

Select graphics languag. If the language setting is Automatic (the default), try the other
settings: PostScript for a PostScript file, HP-GL/2 for an HP-GL/2 file, on so on. Then send the
file again.
●

Depending on the software, drivers, and RIPs that you are using with your printer, different ways
to solve this problem exist. Refer to the vendor's user documentation for details.

One image overlays another on the same print
The I/O timeout setting might be too long. On the front panel, decrease the setting and print again.
Select the

icon, and then select Connectivity > Advanced > Select I/O timeout.

Pen settings seem to have no effect
●

You have changed the settings on the front panel by selecting the

icon followed by Setup >

Printing preferences > HP-GL/2 > Define palette, but did not select that palette in Setup
> Printing preferences > HP-GL/2 > Select palette.
●

Troubleshoot images

To enable the software-driven pen settings, go to the front panel and select the

icon followed

by Setup > Printing preferences > HP-GL/2 > Select palette > Software.
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The image has a wood-grain appearance
(aeroworms)

Aeroworms are wavy, horizontal bands produced by air-induced dot placement error (DPE). In extreme
cases, aeroworms give the image a wood-grain appearance. The problem occurs most commonly on
print jobs that are set for low-quality and high-speed. It does not occur when the custom print-quality
setting is set to “best.”

Troubleshoot images

To eliminate aeroworms, select a higher IQ print setting. See Select print quality on page 79.
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The image has a wood-grain appearance (aeroworms)
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16 Troubleshoot paper issues

The paper has jammed
If a paper jam occurs, follow the instructions on the front panel.
These are the steps to follow:
1.

Open the window.

2.

The printer may ask whether you see jammed paper. If you reply no, the printer will offer to run a
diagnostic to check whether there is a problem with the carriage.

3.

Move the carriage aside and remove jammed paper from the platen.

4.

Go to the rear of the printer and open the rear door.

5.

Cut the paper with a sharp knife along the line indicated, and remove all the paper that you can
find.

6.

Close the rear door.

7.

If printer still detects paper present, it will ask you to try again. If it still detects paper after the
retry, it will offer to run a diagnostic to check whether there is a problem with the paper sensor.

8.

Restart the printer.

9.

Reload the paper.

If you are using self-adhesive paper and performing frequent roll switches, you may start to see paper
jams in the paper input path. This problem can be caused by adhesive deposited from the edge of the
paper onto the conical surface of the paper sensor. To solve this particular problem, use a soft cotton
cloth to clean all the adhesive from the paper sensor.
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Prints do not stack correctly in the bin
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●

Paper often tends to curl near the end of a roll, which can cause stacking problems. Load a new
roll, or remove prints manually as they are completed.

●

If you are mixing prints or nesting sets of several different sizes, you might experience stacking
problems because of the different sizes of paper in the bin.

Prints do not stack correctly in the bin
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●

Cannot insert an ink cartridge

●

Cannot insert a printhead

●

Cannot insert the maintenance cartridge

●

Front panel recommends reseating or replacing a printhead
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Cannot insert an ink cartridge
1.

Check that you have the correct type of cartridge (model number).

2.

Check that the colored label on the cartridge is the same color as the label on the slot.

3.

Check that the cartridge is correctly oriented, the arrow on the front of the ink cartridge should
face upwards.

Cannot insert a printhead
1.

Check that you have the correct type of printhead (model number).

2.

Check that you have removed the protective caps and the clear protective tape from the printhead.

3.

Check that the colored label on the printhead is the same color as the label on the slot.

4.

Check that the printhead is correctly oriented (compare with the others).

5.

Check that you have closed and latched the printhead cover.

Cannot insert the maintenance cartridge
Check that the maintenance cartridge is of the correct type and correctly oriented.

Front panel recommends reseating or replacing a
printhead
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1.

Remove the printhead and check that its protective film has been removed.

2.

Clean the electrical connections between the printhead and the carriage. See Clean the electrical
connections on a printhead on page 56.

3.

Reinsert the printhead into the carriage and check the front panel message.

4.

If the problem persists, insert a new printhead.

Cannot insert an ink cartridge
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CAUTION: Never clean inside the ink cartridge slots.

18 Troubleshoot stacker issues

●

Paper scrolling

●

The trailing edge of the paper curling up

●

The paper is not completely ejected

●

The front panel displays that the stacker is disconnected

Troubleshoot stacker
166

Chapter 18 Troubleshoot stacker issues

ENWW

Paper scrolling
When printing in Fast mode with highly curled paper, the paper may scroll when ejected to the stacker
tray. To avoid this problem, you are recommended to switch to Normal mode or use a paper roll with a
76.2-mm (3-in) core.

The trailing edge of the paper curling up
Use the Optimize for images setting: see Select print quality on page 79.

The paper is not completely ejected

Troubleshoot stacker

Check for any obstruction in the paper path, such as loose objects or other pieces of paper.
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Paper scrolling
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The front panel displays that the stacker is
disconnected
If the front panel constantly or intermittently claims that the stacker is disconnected from the printer,
there may be a problem with the height of the stacker. Use the following procedure to adjust the height
of the stacker.

Troubleshoot stacker
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1.

Using an hexagonal wrench, loosen the upper hexagonal nut on both of the stacker's wheels that
are closest to the printer.

2.

Adjust the height of the stacker by rotating the lower hexagonal nut clockwise or anti-clockwise.

3.

When the correct height has been achieved, tighten the upper hexagonal nut.
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The printer is not printing

●

A job has not been printed

●

The software application slows down or stalls while generating the print job

●

The printer seems slow

●

Communication failures between computer and printer

●

Cannot access the Embedded Web Server

●

“Out-of-memory” error message

●

The platen rollers squeak

●

Cannot access the HP Utility

●

Print job canceled and purged when held for preview

●

Printer alerts

Troubleshoot other

●
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The printer is not printing
Possible reasons why a file you have sent from your computer is not printing when expected, include
the following:
●

A problem with the electrical power might exist. If the printer is not performing and the front panel
does not respond, check that the power cable is correctly connected and that the electrical socket
is functioning.

●

An unusual electromagnetic phenomena may exist, such as strong electromagnetic fields or severe
electrical disturbances. Such occurrences can cause the printer to behave strangely, or even stop
working. Turn off the printer by using the Power button on the front panel, wait until the
electromagnetic environment has returned to normal, and then turn the printer on again. If the
problems persist, contact your customer service representative.

●

The graphic language setting might be incorrectly set.

●

The correct printer driver might not have been installed in your computer.

●

One of the following paper scenarios might exist:
◦

The paper name that appears on the front panel does not reflect the paper that is loaded in
the printer.

◦

There is not a sufficient amount of paper on the loaded roll to print the entire job.

Under these conditions, one print job might be printed, while another print job is held in the print
queue. To resolve this issue, unload the roll from the printer and load a new roll, using the front
panel to guide you through the process.
●

The nesting setting might be On and the printer is waiting for the nest timeout to expire. Under this
condition, the front panel shows the remaining time.

●

You might have requested a print preview in your printer driver. Under this condition, the preview
appears in a Web browser.

Troubleshoot other

A job has not been printed
These are some possible reasons why a particular job may not be printed.
●

The job specifies a paper type that is not loaded.

●

The job specifies a paper source that has no paper loaded.

●

The job is wider than the loaded paper.

●

The stacker is installed, and the loaded paper is not compatible with it.

●

The job specifies no paper type nor paper source, and the roll is protected.

The software application slows down or stalls while
generating the print job
Large quantities of data might be necessary to generate a high-quality large-format print job. This can
cause your software program to slow down significantly or stall. Lowering the print resolution may help
to avoid this scenario, however, lowering the print resolution reduces image quality.
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In the Windows HP-GL/2 driver, click the Advanced tab, select Document options > Printer
features, and then set Max. Application resolution to 300.

The printer seems slow
Here are some possible explanations:
●

Did you set the print quality to Best? Images printed with the Best print-quality setting require
more time to print.

●

Did you specify the correct paper type when loading the paper? Check that the paper type that
appears on the front panel matches the paper that is loaded in the printer.

●

Is your printer connected to a network? Check that all components used in the network (network
interface cards, hubs, routers, switches, and cables) are capable of high-speed operation. Is there
a lot of traffic from other devices on the network?

●

Did you set the drying time to Extended? Try changing the drying time to Automatic. See
Change the drying time on page 37.

●

Are the printheads in good condition? Printing time might increase when a printhead needs
cleaning. Check the printhead status on the front panel or through the Embedded Web Server.
Clean or replace printheads if necessary.

●

Do your image contain high-density, black fills? Printing time might increase for images containing
high-density, black fills.

Communication failures between computer and
printer
●

The front-panel display does not show the Receiving message when you have sent an image to
the printer.

●

Your computer shows an error message when you try to print.

●

Your computer or printer stalls when transferring data.

●

Your printed output shows random or inexplicable errors (misplaced lines, partial graphics, and so
on).

To solve a communication problem:

ENWW

●

Make sure that you have selected the correct printer in your software program.

●

Make sure that the printer works correctly when printing from other software programs.

●

Remember that large images usually require more time to receive, process, and print.

●

If the printer is connected to your computer by a USB cable, try disconnecting and reconnecting
the cable.

●

If the printer is connected to your computer through any other intermediate devices, such as switch
boxes, buffer boxes, cable adapters, or cable converters, remove the intermediate device and try
connecting the printer directly to your computer.

The printer seems slow
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Some symptoms are:

●

Try another interface cable. See Choose which connection method to use on page 13.

●

Make sure that the graphic language setting is correctly set.

Cannot access the Embedded Web Server
If you have not done so already, please read Access the Embedded Web Server on page 21.
NOTE: If you connect your printer directly to your computer with a USB cable, use the HP Utility.
1.

Go to the front panel and select the

2.

Select Connectivity Menu > Advanced > Embedded Web Server > Allow EWS > On.

3.

If you have a TCP/IP connection to your printer, go to the front panel and select the

icon.

icon,

and then select Connectivity Menu.
4.

Select the type of connection you are using.

5.

Select View Information.

6.

The information should read: IP enabled: Yes. If it does not, you might need to use a different
connection.

If you still cannot access the Embedded Web Server, turn the printer off with the Power button on the
front panel and then turn it on again.
If you experience very slow progress while trying to access the Embedded Web Server, the problem
could be that you are using a proxy server. Try bypassing the proxy server and accessing the
Embedded Web Server directly.

Troubleshoot other

●

In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN
Settings, and select the Bypass proxy server for local addresses check box. You can
also click the Advanced button to add the printer's IP address to the list of exceptions, for which
the proxy server is not used.

●

In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies:
Change Settings button. Add the printer's IP address or its domain name to the list of
exceptions, for which the proxy server is not used.

“Out-of-memory” error message
There is no direct relationship between the size of a file in your computer and the amount of memory
needed to print the file. Because of file compression and other factors, it is difficult to estimate how
much memory is needed to print a job. It is possible that the printer will lack sufficient memory to print a
certain job, despite having printed larger jobs in the past. Adding memory to your printer is one
solution.
If you are using the Windows HP-GL/2 driver, printer memory problems can often be resolved by
clicking the Advanced tab, selecting Document options, selecting Printer features, and then
selecting Print job as raster.
NOTE: If you select this option, the time needed to process the job in your computer might be
considerably longer.
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The platen rollers squeak
It might be necessary to oil the rollers. Locate the oil bottle in the maintenance kit that can be ordered
for your printer.
Turn off the printer by using the Power button on the front panel.

2.

Open the printer window.

3.

Locate the small holes in the platen near some of the rollers.

Troubleshoot other

1.

ENWW

The platen rollers squeak
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4.

Put three drops of oil into each hole in the platen.

NOTE: Be careful not to spill oil onto the platen.

Troubleshoot other
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5.

If oil spills onto the platen, wipe the platen clean by using the cloth that was supplied with the
maintenance kit.

6.

Lower the printer window.
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Cannot access the HP Utility
If you have not done so already, please read Access the HP Utility on page 21.
1.

Go to the front panel and select the

2.

Select Connectivity Menu > Advanced > Web services > HP Utility Software >
Enable.

3.

If you have a TCP/IP connection to your printer, go to the front panel and select the

icon.

icon

again.
4.

Select the type of connection you are using.

5.

Select View Information.

If you still cannot connect, turn the printer off by using the Power button on the front panel and then turn
it on again.

Print job canceled and purged when held for
preview
The printer can store up to 64 pages for preview. If the job that you selected for preview contains more
than 64 pages, the job will be canceled and purged without notification when the printer starts to
process the sixty-fifth page. If you want to preview a job that has more than 64 pages, click the
Continue button before the printer starts to process the sixty-fifth page. Because the preview image is
ready as soon as the first page is processed, you should have enough time to check the preview image.

Printer alerts
●

Errors: Mainly alerting you to the fact that the printer is unable to print. However, in the driver,
errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer
is able to print.

●

Warnings: Alert you when the printer needs attention either for an adjustment, such as a
calibration or for a possible unprintable situation, such as a preventive maintenance or low ink.

There are four different alert communicators within your printer's system.
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●

Front-panel display: The front panel shows only the most relevant alert at a time. It generally
requires the user to press the OK key for confirmation, but in the case of a warning, it disappears
after a timeout. There are permanent alerts, such as "ink cartridge low on ink", that reappear
when the printer becomes idle and there is not another more severe alert.

●

Embedded Web Server: The upper-right corner of the Embedded Web Server window shows
the printer status. If there is an alert in the printer, the status shows the alert text.

●

Driver: The driver shows alerts. The driver warns about job configuration settings that may
produce a problem in the final output. If the printer is not ready to print, it displays a warning.

●

HP Utility: To see alerts, go to the Overview tab and review the Items needing attention
list on the right-hand side.

Cannot access the HP Utility
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Your printer can communicate two types of alerts:

By default, alerts are displayed only when you are printing and there are printing problems, for
example: cartridge low or out of ink or printer out of paper. If alerts are enabled and there is a
problem that prevents printing, you see a pop-up window, which explains why the printer is not
going to print. Follow the instructions to achieve your required result.
NOTE: There are environments that do not support bidirectional communication, for example: a
Windows computer connected to the printer with USB. In those cases, alerts do not reach the job
owner.

Troubleshoot other
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Introduction
HP Customer Care offers award-winning support to ensure that you get the most from your HP
Designjet. HP Customer Care provides comprehensive, proven support expertise and new technologies
to give you unique end-to-end support. Services include setup and installation, troubleshooting tools,
warranty upgrades, repair and exchange services, phone and Web support, software updates, and
self-maintenance services. For more information about HP Customer Care, go to: http://www.hp.com/
go/designjet/.

HP Professional Services
Knowledge Center
Enjoy a world of dedicated services and resources to ensure you always get the best performance from
your HP Designjet products and solutions.
Join the HP community at the Knowledge Center, your large-format printing community, for 24×7
access to:
●

Multimedia tutorials

●

Step-by-step how-to guides

●

Downloads: the latest product firmware, drivers, software, paper presets, etc.

●

Technical support: online troubleshooting, customer care contacts and more

●

Workflows and detailed advice for completing various printing tasks from particular software
applications

●

Forums for direct contact with the experts, both HP and your colleagues

●

Warranty tracking online, for your peace of mind

●

Latest product information: products, supplies, accessories, software, etc.

●

Supplies Center for all you need to know about ink and paper

The Knowledge Center can be found at the following locations, depending on your product:
●

http://www.hp.com/go/T7100/knowledgecenter/

●

http://www.hp.com/go/T7100mono/knowledgecenter/

By customizing your registration for the products you have purchased and your type of business, and
by setting your communication preferences, you decide the information you need.

HP Start-up Kit
Get help

The HP Start-up Kit is the DVD that comes with your product; it contains the product's software and
documentation.

HP Care Packs and Warranty Extensions
HP Care Packs and Warranty Extensions allow you to extend your product's warranty beyond the
standard period.
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They include remote support. On-site service is also provided if necessary, with two alternative
response-time options.
●

Next business day

●

Same business day, within four hours (may not be available in all countries)

For more information on HP Care Packs, please visit http://www.hp.com/go/printservices/.

HP Installation
The HP Installation service unpacks, sets up and connects the product for you.
This is one of the HP Care Pack services; for more information, please visit http://www.hp.com/go/
printservices/.

HP Instant Support
HP Instant Support Professional Edition is HP's suite of troubleshooting tools that collect diagnostic
information from your printer and match it with intelligent solutions from HP's knowledge bases,
allowing you to resolve problems as quickly as possible.
To start an HP Instant Support session, click on the link in the Support tab of your printer's Embedded
Web Server. See Access the Embedded Web Server on page 21.
To use HP Instant Support, the following conditions must be met:
●

Because HP Instant Support is accessible only through the Embedded Web Server, you must have
a TCP/IP connection to your printer.

●

Because HP Instant Support is a Web-based service, you must have access to the World Wide
Web,

HP Instant Support is currently available in English, Korean, Simplified Chinese, and Traditional
Chinese.
For more information about HP Instant Support, go to: http://www.hp.com/go/ispe/.

HP Proactive Support
HP Proactive Support is a troubleshooting support tool that identifies, diagnoses, and resolves issues
you might encounter when using your commercial imaging and printing products. HP Proactive Support
is embedded into multiple HP software programs including the HP Utility, allowing you to easily and
conveniently monitor, update and maintain all of your HP printers.
For more information about HP Proactive Support, go to: http://www.hp.com/go/proactivesupport.

Get help

Customer Self Repair
HP's Customer Self Repair program offers our customers the fastest service under either warranty or
contract. It enables HP to ship replacement parts directly to you (the end user) so that you can replace
them. Using this program, you can replace parts at your own convenience.
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Convenient, easy to use
●

An HP Support Specialist will diagnose and assess whether a replacement part is required to
address a defective hardware component.

●

Replacement parts are express-shipped; most in-stock parts are shipped the very same day you
contact HP.

●

Available for most HP products currently under warranty or contract.

●

Available in most countries.

For more information about Customer Self Repair, see http://www.hp.com/go/selfrepair/.

HP Customer Care
As your strategic support partner, we make it our business to help keep your business running smoothly.
HP Customer Care offers award-winning support to ensure that you get the most from your HP
Designjet.
HP Customer Care provides comprehensive, proven support expertise and leverages new technologies
to give customers unique end-to-end support. Services include setup and installation, troubleshooting
tools, warranty upgrades, repair and exchange services, phone and Web support, software updates,
and self-maintenance services. To find out more about HP Customer Care, go to http://www.hp.com/
go/designjet/. For the most current contact information, click on the Contact HP link or call the
appropriate telephone number below.
What to do before you call:
●

Review the troubleshooting suggestions in this guide.

●

Review the relevant driver documentation supplied with this printer (for users sending PostScript
files or those using Microsoft Windows).

●

If you have installed third-party software drivers and RIPs, refer to their documentation.

●

If the problem appears to be related to your software program, first contact your software vendor.

●

If you call one of the Hewlett-Packard offices, have the following information available to help us
answer your questions more quickly:
◦

The printer you are using (the product number and the serial number, found on the label at
the back of the printer on the front panel: select the

icon, and then View printer

information.
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◦

The printer's Service ID (also in the View printer information option.)

◦

If there is an error code on the front panel, make note of it.

◦

The brand name and model number of the computer you are using

◦

Any special equipment or software you are using (for example, spoolers, networks, switchboxes, modems, or special software drivers)

◦

The part number of the network cable you are using and the name of the store though which
it was purchased

◦

The type of interface used on your printer (USB or network)
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◦

The software name and version you are using

◦

Print out the service information prints. You may be asked to fax them to the support center
helping you.
On the front panel: select the

icon, and then select Internal prints > Service

information prints > Print all pages.
Through the Embedded Web Server: go to the Service support page in the Support tab,
and then select Printer information > Print all pages.

Telephone numbers
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●

Algeria: 213 17 63 80

●

Argentina: 0 800 777 HP INVENT, local 5411 4778 8380

●

Australia: 13 10 47

●

Austria: 0810 00 10 00

●

Bahrain: 800 171

●

Belgium: (0) 78 600 600

●

Bolivia: 0 800 1110, local 54 11 4708 1600

●

Brazil: 0800 157 751, local 55 11 3747 7799

●

Canada: 1 800 HP INVENT

●

Caribbean: 1 800 711 2884

●

Central America: 1 800 711 2884

●

Chile: 800 HP INVENT, 123 800 360 999

●

China: 800 810 59 59, 10 6564 59 59

●

Colombia: 01 8000 51 HP INVENT, local 571 606 9191

●

Czech Republic: 420 261 307 310

●

Denmark: 70 11 77 00

●

Ecuador: 999 119, 1 800 225 528

●

Egypt: 202 532 5222

●

Finland: 0203 53232

●

France: 08 26 10 49 49

●

Germany: 0180 52 58 143

●

Greece: 210 6073603, 801 11 22 55 47

●

Guadaloupe: 0800 99 00 11, 877 219 8791

Get help

For an up-to-date list of HP Support telephone numbers, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. If you do not have access to the Web, try one of the numbers below.

HP Customer Care
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●

Guatemala: 1 800 999 5105, 1 800 711 2884

●

Hong Kong: 852 3002 8555

●

Hungary: 06 1 382 1111

●

India: 1 600 112 267

●

Indonesia: 350 3408

●

Ireland: 1 890 946500

●

Israel: 09 830 4848

●

Italy: 02 3859 1212

●

Jamaica: 0 800 711 2884

●

Japan: software 0120 014121, hardware 0120 742594

●

Korea: 82 1588 3003

●

Luxembourg: 27 303 303

●

Malaysia: 1 800 80 5405

●

Martinique: 0 800 99 00, 877 219 8671

●

Mexico: 01 800 472 6684, local 5258 9922

●

Middle East: 4 366 2020

●

Morocco: 2240 4747

●

Netherlands: 0900 1170 000

●

New Zealand: 09 365 9805

●

Norway: 800 62 800

●

Paraguay: 00 811 800, 800 711 2884

●

Panama: 001 800 711 2884

●

Peru: 0 800 10111

●

Philippines: 632 888 6100

●

Poland: 22 566 6000

●

Portugal: 213 164 164

●

Puerto Rico: 1 800 652 6672

●

RSA: 27 11 258 9301, local 086 000 1030

●

Romania: 40 21 315 4442

●

Russia: 095 797 3520, 812 3467 997

●

Saudi Arabia: 6272 5300

●

Slovakia: 2 50222444
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●

South Africa: 0800 001 030

●

Spain: 902 010 333

●

Sweden: 077 130 30 00

●

Switzerland: 0848 80 20 20

●

Taiwan: 886 2 872 28000

●

Thailand: 0 2353 9000

●

Tunisia: 71 89 12 22

●

Turkey: 216 444 71 71

●

UAE: 800 4520, 04 366 2020

●

Ukraine: 44 4903520

●

United Kingdom: 0870 842 2339

●

United States: 1 800 HP INVENT

●

Uruguay: 54 11 4708 1600

●

Venezuela: 0 800 HP INVENT, local 58 212 278 8000

●

Vietnam: 84 8 823 45 30

●

West Africa (French): 351 213 17 63 80

HP Designjet Online
HP offers dedicated services and resources to ensure you always get the best performance from your
HP Designjet products and solutions.

●

Downloads of the latest printer firmware, drivers, software, paper presets, and so on

●

Technical support, including online troubleshooting, customer care contacts, and more

●

Forums for direct contact with the experts, both HP and your colleagues

●

Warranty tracking online, for your peace of mind

●

Technical documentation and training videos

●

Latest product information about printers, supplies, accessories, software, and so on

●

Supplies Center for all you need to know about ink and paper

Get help

Register at HP Designjet Online, your large-format printing community at http://www.hp.com/go/
designjet/ for unrestricted access to:

You decide the information you need by customizing your registration for the products you have
purchased and your type of business, and by setting your communication preferences.
Register at HP Designjet Online for the best performance.
HP Designjet Online is available in English, German, French, Italian, Spanish, Portuguese, Japanese,
Korean, Simplified Chinese, and Traditional Chinese.
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Other sources of information
More information is available from the following sources:
●

The Embedded Web Server provides information about your printer status, technical support,
online documentation, and so on. See Printer software on page 8.

●

See http://hplipopensource.com/hplip-web/index.html if you are using Linux.

●

The printer assembly document that came with your printer

Get help
184

Chapter 20 Get help

ENWW

Front-panel menus

A

Front-panel menus

This appendix lists the options in the front-panel menu system.
NOTE: Firmware updates may introduce changes to the menu system, in which case this appendix
will become out of date in some respects.
To print a more graphical and up-to-date diagram of the front-panel menus, go to the front panel and
select the

icon, then User information prints > Print menu map.

●

Paper menu

●

Job management menu

●

Ink menu

●

Setup menu

●

Image quality maintenance menu

●

Connectivity menu

●

Internal prints menu

●

Information menu

Key to table notations
[E] available also in the Embedded Web Server
[J] depends on the state of the job queue or of the selected job
[P] available only with the PostScript upgrade
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Front-panel menus

Paper menu
Paper load

Load roll1
Load roll2
Load roll3

Paper unload

Unload roll1
Unload roll2
Unload roll3

Select active roll

Active roll 1
Active roll 2
Active roll 3

View paper source
Change active paper type

(select paper category and type)

Paper types list

(select paper category and type)

View paper details

Move paper

Load roll displays illustrations of the loading process. These options are locked if paper is already
loaded.
Unload roll displays illustrations of the unloading process. These options are locked if no paper is
loaded.
View paper source shows information about the loaded paper. The information shown is Status,
Paper vendor, Paper type, Width, Length, Color calibration.
Change active paper type displays a list of paper types from which you can choose. This option is
locked if no paper is loaded.
Paper types list displays a list of installed paper types, grouped by category, each of which you can
view or delete. View paper details will display the Paper type, Category, Vendor, Erasable status,
Revision, Grammage, Uses Photo/Matte Black and Created from.
Move paper displays an interactive dialogue for moving the paper backwards and forwards. This
option is locked if no paper is loaded.
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Front-panel menus

Job management menu
Reprint last job
Pause (or Resume) printing
Job queue

Queue is empty [J]
(select job) [J]

View information
Continue
Move to front
Copies
Reprint
Cancel
Delete

Job queue displays the jobs in the job queue. Jobs remain in the queue after being printed.
View information displays the following information about the selected job: Name, Status, Date,
Printed copies and Pages.
Continue releases for printing a job that is on hold.
Move to front moves the selected job to the front of the queue, so that it will be printed as soon as
the current job finishes.
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Ink menu
View ink levels
View printhead status
Replace ink cartridges
Replace printheads
Replace maintenance cartridge
Ink cartridge information

View (color) ink cartridge

Printhead information

View (colors) printhead

Maintenance cartridge information
Clean encoder strip

View ink levels displays the ink levels of all cartridges in the printer. A blinking cartridge in the
display indicates warns you that the ink level is low.
View printhead status displays the warranty or health status of all printheads in the printer. If the
printhead is still under warranty, the word WARRANTY is shown, otherwise the health status is shown.
View (color) ink cartridge displays the following information about the selected ink cartridge: Color,
Product name, Product number, Serial number, Status, Ink level (ml), Capacity (ml), Expiration date,
Manufacturer and Warranty status.
View (colors) printhead displays the following information about the selected printhead: Color,
Product name, Product number, Serial number, Status, Ink fired (ml) and Warranty status.
Maintenance cartridge information displays the following information about the maintenance
cartridge: Status, Level (%) and Product number.
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Front-panel menus

Setup menu
Printing preferences

Select graphics language [E]
Print quality

Select quality level
Enable maximum detail
Enable economode

Color options

Color/Grayscale
Select RGB source profile
Emulate printer
Select CMYK source profile [P]
Select rendering intent [P]
Black point compensation [P]
HP professional PANTONE® emulation
[P]

Black options

Black/Grayscale

Paper options

Select paper size
Remove top/bottom blanks
Resize
Rotate
Enable mirror image
Enable crop lines
Roll switching
Roll matching
Enable printing paper info
Roll protection

Margins

Select margins layout [E]

HP-GL/2 options

Select palette
Define palette
Enable merge

PS options [P]

Select encoding
High-quality transparencies
Reduce line width

Select altitude
Print retrieval
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Select drying time

Setup menu
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Front-panel menus

Job management options

Enable queue [E]
When to start printing [E]
Nest options

Enable nesting [E]
Select wait time
Enable crop lines [E]
Oversize nested job margin

Autorotate
Max. number of printed jobs [E]
Select job recovery mode
Paper mismatch action
Front panel options

Select language
Select display contrast
Enable buzzer
Select units [E]
Date and time options

View current device time [E]
Set date [E]
Set time [E]
Set time zone [E]

Enable sleep mode
Sleep mode wait time
Resets

Reset encoder cleaning
Restore factory settings

External hard disk

Install (or Uninstall) external hard disk

Accessories

Stacker

Install (or Uninstall) stacker
View stacker information
Select temperature
Cleaning procedure

Other accessories

Install other accessories

Enable crop lines appears in two places in the menu: under Paper options (which applies to
individual jobs) and under Nest options (which applies to nested jobs). The default value is Off in
both cases.
Select palette allows you to choose between Software, Palette A, Palette B and Factory.
Define palette allows you to define the Palette A, Palette B and Factory palettes. To do so, select one
of the pens, between 0 and 15, after which you can change the width or color of the pen. The width
can vary from 0.13 mm (0.0051 in) to 12.0 mm (0.47 in) and the color can vary from 0 to 255.
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Enable nesting allows you to choose between Off, In order and Optimized order. In order to enable
nesting, When to start printing has to be set to After processing.
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Setup menu
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Front-panel menus

Manual drying time allows you to choose a drying time from 1 to 1800 s. The default value is 100
s.

Front-panel menus

Image quality maintenance menu
Optimize print quality
Optimization actions
Calibrate color
Align printheads
Print diagnostic image
Paper advance calibration

Calibrate paper advance
Adjust paper advance
Reset paper advance

Clean printheads

Clean all
Clean (colors)

Enable color calibration
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Front-panel menus

Connectivity menu
Gigabit Ethernet

View information
View configuration
Modify configuration
Restore factory settings

USB

View information

Jetdirect EIO

View information
View configuration
Modify configuration
Restore factory settings

Advanced

Select I/O timeout
Allow SNMP
Embedded Web Server

Allow EWS
Reset EWS access control

Web Services

Printer Utility software
Color and paper management

Restore factory settings

View information shows whether the interface is installed, whether the IP address is enabled and
whether printing is enabled through this interface. It also displays the MAC address.
View configuration shows the following information: Link state, IP address, Configuration mode,
Subnet mask, Default gateway, mDNS service name and the MAC address.
Modify configuration allows you to change the IP address, subnet mask, default gateway and idle
timeout. You can also view the host name string and choose an IP address configuration method from
BOOTP, DHCP, Auto IP and Manual.
Printer utility software allows you to enable or disable the use of the HP Utility.
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Connectivity menu
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Front-panel menus

Internal prints menu
Demo prints

Print drawing demo
Print rendering demo
Print GIS map

User information prints

Print menu map
Print configuration
Print usage report
Print HP-GL/2 palette
Print PS font list [P]

Service information prints

Print current information
Print usage information
Print event logs
Print calibration status
Print connectivity configuration
Print all pages
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Front-panel menus

Information menu
View printer information
Product certifications
Printer logs

System errors
System warnings
Printheads
Ink cartridges

View printer information displays general printer information including Product name, Product
number, Serial number, Service ID, Language, Memory, Disk capacity and Firmware version.
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Information menu
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Front-panel error messages

Error messages

Under certain circumstances, a front-panel error message appears. Follow the advice in the
Recommendation column to resolve the error.
If an error message appears on the front panel that is not included in this list, and you are in doubt
over the correct response, contact HP Support. See HP Customer Care on page 180.
Table B-1 Text messages
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Message

Recommendation

[Color] cartridge has expired

Replace the cartridge. See Remove an ink cartridge
on page 48 and Insert an ink cartridge on page 50.

[Color] cartridge is missing

Insert a cartridge of the correct color. See Insert an ink
cartridge on page 50.

[Color] cartridge is out of ink

Replace the cartridge. See Remove an ink cartridge
on page 48 and Insert an ink cartridge on page 50.

[Color] printhead #[n] error: not present

Insert the correct printhead. See Insert a printhead
on page 54.

[Color] printhead #[n] error: please remove

Remove the incorrect printhead and insert a new printhead of
the correct type (color and number). See Remove a printhead
on page 51 and Insert a printhead on page 54.

[Color] printhead #[n] error: replace

Remove the non-functional printhead and insert a new
printhead. See Remove a printhead on page 51 and Insert a
printhead on page 54.

[Color] printhead #[n] error: reseat

Remove and reinsert the same printhead, or try cleaning the
electrical connections. If necessary, insert a new printhead.
See Front panel recommends reseating or replacing a
printhead on page 165.

[Color] printhead #[n] out of warranty

The printhead's warranty has ended, because of the length of
time it has been in operation or because of the volume of ink
used. See the Legal Information.

[Color] printhead #[n] warranty warning

The printhead's warranty may be invalidated by the use of the
wrong kind of ink. See the Legal Information.

[Warning] internal failure: Unable to create print

The internal print files are not available in the printer. Load the
internal print files through the Embedded Web Server.

IO error

Restart the printer. If the problem persists, contact HP Support.
See HP Customer Care on page 180.

IO warning

Try again; if the problem persists, contact HP Support. See HP
Customer Care on page 180.

PDL Error: Ink system not ready

Clean the printheads. See Clean (recover) the printheads
on page 56.
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Message

Recommendation

PDL Error: Job clipped

The image is too large for the paper or for the printer. Load
larger paper if possible, or reduce the image size.

PDL Error: memory full

Restart the printer and try resending the job; if necessary,
reduce the complexity of the job.

PDL Error: out of paper

Load more paper.

PDL Error: parsing error

The print job is unintelligible to the printer. Try to recreate and
resend it. Check your cable connections.

PDL Error: print mode error

The paper type or print quality specified for the job are
incorrect. Change the loaded paper type or the print settings.

PDL Error: printing error

Try sending the job again.

PDL Error: virtual memory full

Restart the printer and try resending the job; if necessary,
reduce the complexity of the job.

Replace [color] ink cartridge

The cartridge is out of ink; replace it. See Remove an ink
cartridge on page 48 and Insert an ink cartridge on page 50.

Replace faulty [color] ink cartridge

The cartridge is faulty; replace it. See Remove an ink cartridge
on page 48 and Insert an ink cartridge on page 50.

Reseat [color] cartridge

Remove and reinsert the same cartridge. See Remove an ink
cartridge on page 48 and Insert an ink cartridge on page 50.

Update: failed. Invalid file

Make sure that you have selected the correct firmware update
file. Then try again to perform the update.

Under certain circumstances, a front-panel numeric error message appears. Follow the advice in the
Recommendation column to resolve the error.
If an error message appears on the front panel that is not included in this list, turn off the printer and
then turn it back on. If the problem persists, contact HP Support. See HP Customer Care on page 180.
Table B-2 Numeric error messages
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Error code

Recommendation

26.n.01 (where n = the subject ink
cartridge number)

Remove the subject ink cartridge and reinstall it in the printer. If the error persists,
replace the subject ink cartridge. If the problem persists, contact HP Support. See
HP Customer Care on page 180.

29.01

The maintenance cartridge is not inserted correctly. Open the maintenance
cartridge door on the right side of the printer, make sure that the maintenance
cartridge is correctly seated, and then close the door. If the problem persists,
replace the maintenance cartridge. If the problem persists, contact HP Support. See
HP Customer Care on page 180.
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Error messages

Table B-1 Text messages (continued)

Table B-2 Numeric error messages (continued)
Error code

Recommendation

61.01

The file format is incorrect and the printer cannot process the job. Try the following
remedies:

Error messages

●

Turn off the printer by using the Power button on the front panel and the power
switch at the back of the printer, and then disconnect the power cord—then
reconnect the power cord and turn on the printer.

●

Make sure that the graphic language setting is correct. See Change the
graphic language setting on page 24.

●

Resubmit the file to the printer.

●

Check that your printer firmware is up to date. See Update the printer
firmware on page 144.

If the problem persists, contact HP Support. See HP Customer Care on page 180.
61.04

Install the latest firmware release. See Update the printer firmware on page 144.

61.08

The paper type has changed, please resubmit the job.

61.08.1

The job cannot be printed because it is password-protected.

61.08.2

The job cannot be printed because it contains errors.

63.04

An input/output problem has occurred with the network card. Try the following
remedies:
●

Make sure that the network cable is correctly connected to the network card.

●

Check that your printer firmware is up to date. See Update the printer
firmware on page 144.

If the problem persists, contact HP Support. See HP Customer Care on page 180.
71.08

Out of memory. Data lost. In the HP-GL/2 and HP RTL driver, select the Advanced
tab, Document options, Printer features, then enable the Send job as
bitmap option before resubmitting the job.

74.01

An error occurred when uploading the firmware update file. Try the following
remedies:
●

Turn off the printer by using the Power button on the front panel and the power
switch at the back of the printer, and then disconnect the power cord—then
reconnect the power cord and turn on the printer.

●

Try again to upload the firmware update file to the printer. See Update the
printer firmware on page 144.

If the problem persists, contact HP Support. See HP Customer Care on page 180.
76.03
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The Resource Area is full. Please use the Hard Disk Recovery utility.
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Table B-2 Numeric error messages (continued)
Error code

Recommendation

77.04

An Embedded Web Server internal software error has occurred. Try the following
remedies:
Turn off the printer by using the Power button on the front panel and the power
switch at the back of the printer, and then disconnect the power cord—then
reconnect the power cord and turn on the printer.

●

Check that your printer firmware is up to date. See Update the printer
firmware on page 144.

Error messages

●

If the problem persists, contact HP Support. See HP Customer Care on page 180.
81.01, 81.03, 86.01

ENWW

Open the printer window and make sure that there are no obstacles restricting the
movement of the drive roller. If the paper has jammed and is restricting the
movement of the drive roller, lift the paper load lever and clear the obstruction. If
the problem persists, contact HP Support. See HP Customer Care on page 180.
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Functional specifications
Table C-1 HP No. 762 ink supplies
T7100

T7100 Mono

Printheads

Yellow, magenta/cyan, gray/dark gray, black/black

Black/black, dark gray

Ink cartridges

Black, yellow, magenta, cyan, gray, dark gray

Black, dark gray

Maintenance cartridge

Non-color-specific

Non-color-specific

Table C-2 Paper sizes
Minimum

Maximum

Width

280 mm (11 in)

1067 mm (42 in)

Length

420 mm (16.5 in)

91 m (300 ft)
180 mm (7.08 in)

NOTE: The printer can cope with paper rolls that vary from their nominal width by up to 3 mm in
either direction (wider or narrower).
Table C-3 Print resolution (using Windows HP-GL/2 driver)
Print quality

Maximum
resolution for
photo paper

Rendering
resolution

Printing resolution

Best

On

1200×1200

2400×1200 (HP Premium Instant-dry Photo
Gloss, HP Premium Instant-dry Photo Satin, HP
Universal Instant-dry Photo Gloss, HP Universal
Instant-dry Photo Semi-Gloss, Photo Gloss Paper,
Photo Semi-Gloss/Satin Paper, Photo Matte
Paper)
1200×1200 (other)

Best

Off

600×600

600×1200 (HP Premium Instant-dry Photo Gloss,
HP Premium Instant-dry Photo Satin, HP Universal
Instant-dry Photo Gloss, HP Universal Instant-dry
Photo Semi-Gloss, Photo Gloss Paper, Photo
Semi-Gloss/Satin Paper, Photo Matte Paper)
1200×1200 (other)
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Roll diameter

Table C-3 Print resolution (using Windows HP-GL/2 driver) (continued)
Print quality

Maximum
resolution for
photo paper

Rendering
resolution

Printing resolution

Normal

n/a

600×600

600×1200 (HP Premium Instant-dry Photo Gloss,
HP Premium Instant-dry Photo Satin, HP Universal
Instant-dry Photo Gloss, HP Universal Instant-dry
Photo Semi-Gloss, Photo Gloss Paper, Photo
Semi-Gloss/Satin Paper, Photo Matte Paper)
1200×1200 (other)

Fast

n/a

300×300

600×1200 (plain paper, bright white bond
paper, HP Premium Instant-dry Photo Gloss, HP
Premium Instant-dry Photo Satin, HP Universal
Instant-dry Photo Gloss, HP Universal Instant-dry
Photo Semi-Gloss, Photo Gloss Paper, Photo
Semi-Gloss/Satin Paper, Photo Matte Paper)
1200×1200 (other)

Printer specifications

Table C-4 Margins
Side margins

5 mm (0.197 in)

Top margin (leading edge)

5 mm (0.197 in); 11.5 mm (0.453 in) for glossy paper

Bottom margin (trailing edge)

5 mm (0.197 in)

Table C-5 Mechanical accuracy
±0.1% of the specified vector length or ±0.1 mm (whichever greater) at 23°C (73°F), 50-60% relative humidity, on A0 printing
material in Best or Normal mode with HP Matte Film.

Table C-6 Graphic languages supported
HP Designjet T7100 Printer

HP-GL/2, RTL, CALS/G4

HP Designjet T7100ps Printer

HP-GL/2, RTL, CALS/G4, Adobe PostScript level 3, Adobe PDF 1.7, TIFF, JPEG

Physical specifications
Table C-7 Printer physical specifications
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Weight (including stand)

187 kg (412 lb)

Width

1970 mm (77.5 in)

Depth

690 mm (27.2 in)

Height

1370 mm (53.9 in)
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Memory specifications
Table C-8 Memory specifications
T7100 & T7100 Mono memory (DRAM)

1024MB

T7100ps & T7100ps Mono memory (DRAM)

1536MB

Hard disk

160GB

External hard disk accessory

160GB

Power specifications
Input voltage

100–127 Vac / 220–240 Vac ±10%, autoranging

Frequency

50–60 Hz

Current

5A/3A

Power consumption

270 W maximum

Printer specifications

Table C-9 Printer power specifications

Environmental specifications
Table C-10 Printer environmental specifications
Relative humidity range for best print quality

20–80%, depending on paper type

Temperature range for best print quality

15 to 30°C (59 to 86°F), depending on paper type

Temperature range for printing

5 to 40°C (41 to 104°F)

Temperature range when not in operation

–20 to +55°C (–4 to +131°F)

Maximum altitude when printing

3000 m

NOTE: If the printer or ink cartridges are moved from a cold location to a warm and humid location,
water from the atmosphere can condensate on the printer parts and cartridges and can result in ink
leaks and printer errors. In this case, HP recommends that you wait at least 3 hours before turning on
the printer or installing the ink cartridges, to allow the condensate to evaporate.

Acoustic specifications
Table C-11 Printer acoustic specifications
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Idle sound power

≤ 5.8 B (A)

Operating sound power

≤ 7.0 B (A)

Idle sound pressure

≤ 38 dB (A)

Operating sound pressure

≤ 53 dB (A)

Memory specifications
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Bonjour
Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer
network technology that is used in Apple Mac OS X 10.2 and later. Use it to discover the services that are
available on a local area network (LAN). It was originally known as Rendezvous.
CALS/G4
CALS (Continuous Acquisition and Life-cycle Support) is an initiative of the US Department of Defense for
electronically capturing military documentation and linking related information. The initiative has developed a
number of standard specifications (protocols) for the exchange of electronic data with commercial suppliers. These
standards are often referred to as simply "CALS". CALS standards have been adopted by several other allied
nations.
Color accuracy
The ability to print colors that match the original image as closely as possible, given the fact that all devices have
a limited color gamut and might not be able to match certain colors precisely.
Color consistency
The ability to print the same colors in a particular print job, from print to print and from printer to printer.
Color model
A system of representing colors by numbers. An example of such a system is RGB or CMYK.
Color space
A color model in which each color is repesented by a specific set of numbers. Many different color spaces can
use the same color model: for instance, monitors generally use the RGB color model, but they have different color
spaces, because a particular set of RGB numbers results in different colors on different monitors.
Cutter
A printer component that slides back and forth across the platen to cut the paper.
ESD
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the
cling of clothing. Although controlled static electricity has some useful benefits, uncontrolled electrostatic
discharges are one of the main hazards to the electronics products. Therefore, to prevent damage some
precautions are needed when setting up the product, or handling ESD sensitive devices. This type of damage may
reduce the life expectan+cy of the device. One way to minimize uncontrolled ESDs, and therefore reduce this type
of damage is by touching any exposed grounded part of the product (mainly metal parts) before handling ESD
sensitive devices (such as the printheads or ink cartridges). Additionally, to reduce the generation of electrostatic
charge in your body try to avoid working in a carpeted area, and keep your body movements to a minimum
when handling ESD sensitive devices. Also, avoid working in low humidity environments.
Ethernet
A popular computer networking technology for local area networks.
Firmware
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).
Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.
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HP-GL/2
Hewlett-Packard Graphics Language 2: a language defined by HP to describe vector graphics.
I/O
Input/Output: this term describes the passing of data between one device and another.
ICC
The International Color Consortium, a group of companies that have agreed on a common standard for color
profiles.
Ink cartridge
A removable printer component that stores ink of a particular color and provides it to the printhead.
IP address
A unique identifier that identifies a particular node on a TCP/IP network. It consists of four integers separated by
dots.
Jetdirect
HP's brand name for its series of print servers that allow a printer to be connected directly to a local area network.
LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.
MAC address
Media Access Control address: a unique identifier used to identify a particular device on a network. It is a lowerlevel identifier than the IP address. Thus, a device may have both a MAC address and an IP address.
Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the paper.
Paper
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are
pulped, dried, and pressed.
Platen
The flat surface within the printer over which the paper passes while it is being printed on.
Printer driver
Software that converts a print job in a generalized format into data suitable for a particular printer.
Printhead
A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and
deposits it on the paper, through a cluster of nozzles.
Rendezvous
Apple Computer's original name for its networking software later known as Bonjour.
TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.
USB
Universal Serial Bus: a standard serial bus designed to connect devices to computers.
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16-bit color images 85
A
accessories
order 146
accounting 111
acoustic specifications 203
alerts
errors 175
warnings 175
application hangs up 170
Autodesk Design Review
print from 116
B
banding problems 35
bin
stacking problems 163
bin/basket 6
black and white 88
black point compensation 102
blank page 158
blurred lines 151
buzzer on/off 22
C
calibration
color 94
carriage lubrication 142
clean the paper advance sensor
window 142
clean the platen 140
clean the printer 140
clipped at bottom 158
clipped image 159
color
adjustment options 97
advantages 94
calibration 94
CMYK 94
emulation 100
printer emulation 97
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profile 94
RGB 94
color accuracy
between printers 157
PANTONE 156
color management
from drivers 96
from EWS 101
from front panel 103
from PS drivers 99
options 96
process 94
communication problems 171
components of Embedded Web
Server 9
components of printer 4
connect the printer
choosing a method 13
Mac OS direct 17
Mac OS network 14
Windows direct 14
Windows networking 13
contrast in front panel 22
crop lines 86
Customer Care 178, 180
Customer Self Repair 179
D
Designjet Online 179, 183
disk erase 145
distorted print 160
downloading paper presets 37
draft for revision, print 114
draft printing 80
drying time
canceling 37
changing 37
overview 28
E
economize
on ink 91
on paper 88

Embedded Web Server
access 21
cannot access 172
ink and paper usage 111
ink system status 65
job preview 106
job queue 106
language 22
main components 9
printer usage statistics 111
environmental specifications 203
F
features of printer 4
firmware update 144
front panel 7
front view 5
front-panel
contrast 22
language 21
units 23
front-panel error messages
all 196
front-panel key
form feed and cut 8
paper loading 7
pause printing 7
view information 7
front-panel option
align printheads 60
allow EWS 172
autorotate 88
black point compensation 104
calibrate color 95
CMYK source profile 104
color/grayscale 104
emulate printer 104
enable buzzer 22
enable crop lines 86
enable merge 86
form feed and cut 38
ink cartridge information 66
modify configuration 23
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PANTONE emulation 104
paper mismatch action 25
print diagnostic image 61
print quality 80
printhead
information 66, 150, 153
remove blank areas 89
rendering intent 104
reprint 108
resize 85
RGB source profile 104
roll protection 91
roll switching options 25
rotate 87
select active roll 25
select display contrast 22
select graphics language 24
select I/O timeout 158, 160
select language 21
select margins 83
select paper size 82
select units 23
sleep mode wait time 22
view configuration 13, 15
functional specifications 201
G
glossary 204
graininess 153
graphic language 24
graphic languages 202
gray shades 88
H
hard disk erase 145
hard disk specification 203
hold for preview
print job canceled and
purged 175
HP Care Packs 178
HP Customer Care 178, 180
HP Designjet Online 179, 183
HP Installation 179
HP Instant Support 179
HP Start-up Kit 178
HP Utility
access 21
cannot access 175
language 22
main features 10
I
image diagnostics print
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image problems
blank page 158
clipped at bottom 158
clipped image 159
distorted print 160
overlapping images 160
pen settings ineffective 160
small image 159
unexpected mirror image 160
unexpected rotation 160
unintelligible print 160
ink
economical use of 91
usage 111
ink cartridge
about 45
cannot insert 165
inserting 50
maintenance 143
ordering 67
refilling 45
removing 48
specification 201
status 65
ink system status 65
ink system tips 47
Instant Support 179
internal prints 10
IP address 22
J
job
create 78
stored 79
submit 78
job not printed 170
job preview
Embedded Web Server 106
job queue
Embedded Web Server 106
job status 108
K
Knowledge Center 178
L
language 21
line length accuracy 152
line thickness 149
loading roll into printer 30
lubricate the carriage 142
lubricating the platen rollers 173

M
maintenance 143
maintenance cartridge
about 47
inserting 64
removing 62
specification 201
margins
specification 202
maximum detail 81
mechanical accuracy 202
memory error 172
memory specifications 203
Microsoft Office
print from 132
mirror image unexpected 160
misaligned colors 150
models, product 2
more passes 82
move the printer 144
multiroll printing 69
N
nesting 89
network settings 23
O
on/off 11
order
accessories 146
ink cartridges 67
maintenance cartridges
paper 39
printheads 68
out-of-memory error 172
overlapping images 160
overlapping lines 86
overnight printing 91

68

P
page size 82
PANTONE emulation 99
PANTONE swatch book 103
paper
advance 35, 38
displaying information 35, 38
economical use of 88
feed and cut 38
not flat 153
overview 27
print on loaded paper 84
select type 84
size 82
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tips 27, 39
usage 111
paper advance calibration 35
paper jam 162
paper mismatch action 25
paper presets
downloading 37
paper sizes (max & min) 201
paper suitability 25
paper types
front-panel names 28
supported 28
pen settings ineffective 160
physical specifications 202
power on/off 11
power specifications 203
presentation, print 127
preventive maintenance 143
preview a print 85
print file 78
print job
create 78
ink usage 111
nesting 89
paper usage 111
stored 79
submit 78
print on loaded paper 84
print preview 85
print quality
changing 79
print resolution 201
print-quality problems
black ink comes off 155
blurred lines 151
colors inaccurate 156
discontinuous lines 151
general 148
graininess 153
inaccurate line lengths 152
ink marks 154
line thickness 149
misaligned colors 150
paper not flat 153
scratching 154
scuffing 154
stepped lines 150
troubleshooting tools 148
vertical lines of different
colors 155
white spots 156
wood-grain appearance 161
printer does not print 170
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Index

printer software
Mac OS uninstall 18
Windows direct install 14
Windows network install 13
Windows uninstall 14
printer's main components 4
printer's main features 4
printhead
about 46
aligning 59
cannot insert 165
cleaning 56
cleaning connections 56
inserting 54
ordering 68
recovery 56
removing 51
reseat, reseat 165
specification 201
status 66
printhead cleaner
cannot insert 165
printhead drop detector
clean 58
product models 2
project, print 116
protect a roll 91
Q
quality, high 81
R
rear view 6
refilling ink cartridges 45
rendering intent 102
reprint a job 108
rescale a print 84
resolution 201
roll paper
loading into the printer 30
unloading 34
roll protection 91
roll switching options 25
roller lubrication 173
rotating an image 86
rotation unexpected 160
S
safety precautions 2
scale a print 84
scratched prints 154
scuffed prints 154
secure disk erase 145
sleep mode wait time 22

slow printing 171
small image 159
software 8
specifications
acoustic 203
environmental 203
functional 201
graphic languages 202
hard disk 203
ink supplies 201
margins 202
mechanical accuracy 202
memory 203
paper size 201
physical 202
power 203
print resolution 201
squeaky rollers 173
stacker
change rolls 74
change the temperature 74
clean the exterior 74
clean the rollers 75
install 73
messages 74
move 75
paper not completely
ejected 167
paper scrolls 167
stacker disconnected 168
store 75
trailing edge curls 167
uninstall 73
using paper 73
stacking problems in bin 163
statistics
ink cartridge 65
printer usage 111
status 108
stepped lines 150
store the printer 144
stored job 79
submit job 78
support services
HP Care Packs 178
HP Customer Care 178, 180
HP Designjet Online 179, 183
HP Instant Support 179
HP Start-up Kit 178
Knowledge Center 178
product installation 179
warranty extensions 178
supported papers 28
switch on/off 11
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T
telephone numbers 181
turn on/off 11
U
unattended printing 91
unintelligible print 160
unloading roll from printer
using this guide 3
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W
warranty extensions 178
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